User’s Manual for Maestro 2.8
Notice

The information in this document is subject to change without notice and should not be construed as a commitment by Cambridge Research & Instrumentation, Inc. CRi assumes no responsibility for any errors that may appear in this document. This manual is believed to be complete and accurate at the time of publication. In no event shall CRi be liable for incidental or consequential damages in connection with or arising from the use of this manual.

This manual describes system operation using Maestro version 2.8 software.

For more information contact:
Cambridge Research & Instrumentation, Inc. (CRi)
35-B Cabot Road, Woburn, MA, 01801, USA
(Toll-Free US) 1-800-383-7924, (Phone) +1-781-935-9099, (Fax) +1-781-935-3388
Email: techsupport@cri-inc.com
Web site: http://www.cri-inc.com
US Patent 4,848,877; 5,953,087; 5,247,378; 7,321,791; and patents pending.
# Contents

Chapter 1, Introduction to Multispectral Imaging Theory and Concepts ............................................. 1
- Light .................................................................................................................................................. 1
  - Human Perception of Light Intensity and of Color ...................................................................... 2
  - A Highly Adaptive Light Detector ................................................................................................. 2
  - Response to Illumination .................................................................................................................. 3
  - Ability to Distinguish Colors .......................................................................................................... 3
- Fluorescence ..................................................................................................................................... 3
  - Stoke’s Shift .................................................................................................................................... 4
  - Autofluorescence ............................................................................................................................ 4
  - Excitation and Emission Filters ..................................................................................................... 5
- The Multispectral Solution .................................................................................................................. 6
  - Overlapping Emission Spectra ....................................................................................................... 6
  - Multispectral Analysis ..................................................................................................................... 7
  - Solution for Imaging Small Animals ............................................................................................... 7
- Narrow Bandwidth Acquisition .......................................................................................................... 8

Chapter 2, Introduction to the Maestro 2 In Vivo Imaging System ...................................................... 9
- Introduction .......................................................................................................................................... 9
- Operator and Equipment Safety ......................................................................................................... 10
  - General Cautionary Statements ..................................................................................................... 10
  - For Technical Assistance .................................................................................................................. 10
- About This Manual ............................................................................................................................. 11
  - Design Change Disclaimer .............................................................................................................. 11
  - Reproduction Disclaimer ................................................................................................................. 11
- Maestro 2 Hardware Components ....................................................................................................... 12
  - Heated Specimen Chamber and Stage ............................................................................................. 12
  - Controlling the Chamber Environment ......................................................................................... 13
  - Exhaust Evacuator and F-Air Canister ............................................................................................. 14
  - Anesthesia Supply and Exhaust Ports ............................................................................................... 15
  - Utility Ports ...................................................................................................................................... 15
  - Control Panel ................................................................................................................................... 16
  - Emission Filters ............................................................................................................................... 18
  - Lamp Hour Meter ............................................................................................................................. 18
  - Excitation Filters ............................................................................................................................. 19
  - Replacing Emission and Excitation Filters ..................................................................................... 19
  - Excitation Lamp ............................................................................................................................... 20
  - System Power ................................................................................................................................... 21
  - Workstation Computer ..................................................................................................................... 22
  - USB Multimedia Controller (Focus Knob) ....................................................................................... 22
  - Cleaning Your Maestro 2 In Vivo Imaging System .......................................................................... 22
  - Cleaning Filters and Other Optical Surfaces ..................................................................................... 22
Chapter 3, Imaging the CRI Business Card with QDot™ Spots ................................................................. 31
  First Steps .................................................................................................................................................... 32
  Acquiring an Image Cube ............................................................................................................................ 32
  Unmixing the Image Cube .......................................................................................................................... 34
    Calculating the Pure Spectra .................................................................................................................... 35
    Unmixing the Image .................................................................................................................................. 36

Chapter 4, Method Development ................................................................................................................. 39
  Methods for Building Spectral Libraries .................................................................................................... 40
    Tips for Spectral Library Development ................................................................................................ 40
    Obtaining Autofluorescence and Label Spectra from a Single Animal ................................................ 41
    Obtaining Autofluorescence and Label Spectra from Two Animals ..................................................... 42
  Saving Spectral Libraries ............................................................................................................................ 43
  Saving Protocols ......................................................................................................................................... 43
  Importing Spectra Into a Library .............................................................................................................. 44
    From an Existing Library ......................................................................................................................... 44
    From a Saved Component Image ........................................................................................................... 45
    From a Saved Composite Image .............................................................................................................. 45
  Practice Exercise ......................................................................................................................................... 46

Chapter 5, Acquiring Spectral Images ........................................................................................................... 49
  Tips for Obtaining Quantitative Results .................................................................................................... 50
  Acquiring Images Using a Saved Maestro Protocol ................................................................................ 50
  Viewing a Live Image Stream .................................................................................................................... 51
  Camera Binning, Zoom, and Region of Interest ......................................................................................... 51
Appendix A, System Specifications & Dimensions ................................................................. 129

Chapter 12, Frequently Asked Questions ............................................................................... 127

Chapter 11, Dynamic Contrast Enhancement (DyCE) ............................................................. 117

How DyCE Works .................................................................................................................. 117
Preparing for DyCE Imaging .................................................................................................... 119
System Setup .......................................................................................................................... 119
Selecting Binning and ROI ...................................................................................................... 120
Selecting a Collection Type .................................................................................................... 120
Selecting Save Options ........................................................................................................... 120
Acquiring a Monochrome DyCE Dataset ................................................................................ 121
Acquiring a Multispectral DyCE Dataset ................................................................................ 122
Recalling/Opening a Saved DyCE Cube Sequence................................................................. 123
Creating a DyCE Time Series ................................................................................................ 123
Reloading a Time Series’ Parent Cube Sequence .................................................................. 124
Displaying/Playing DyCE Datasets ......................................................................................... 124
Opening DyCE Datasets ......................................................................................................... 124
Playing DyCE Datasets .......................................................................................................... 124
Saving DyCE Datasets as AVI Movies .................................................................................... 124
Changing the Display Mapping .............................................................................................. 125
Selecting a Color Map ............................................................................................................ 125
Displaying Dimension-Reduced Data ..................................................................................... 126
Zooming and Saving Images ................................................................................................. 126

Chapter 12, Frequently Asked Questions ............................................................................... 127

Appendix A, System Specifications & Dimensions ................................................................. 129

Liquid Crystal Tunable Filter ................................................................................................. 129
CCD Camera.....................................................................................................................................................129
Specimen Chamber & Stage.............................................................................................................................130
Field of View ....................................................................................................................................................130
Imaging Module................................................................................................................................................131
Illuminator ........................................................................................................................................................131
Environmental...................................................................................................................................................132
Utilities .............................................................................................................................................................132
Computer System Requirements ......................................................................................................................132
Using Third-Party Computers with the Maestro Software .............................................................................133
Dimensions .......................................................................................................................................................134

Appendix B, Filter Selection Guide 135

Appendix C, CRi Software End-User License Agreement 137
  Notice to Purchaser...........................................................................................................................................139

Appendix D, System Setup & Installation 141

Appendix E, Windows User Management 143

Appendix F, Hardware Installation Wizard 147

Appendix G, Maestro Quick Start Guide 151

Index 157
Introduction to Multispectral Imaging Theory and Concepts

This chapter provides an introduction to the theory and concepts that enable CRi’s multispectral imaging systems to function as well as they do.

Topics in this chapter:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light</td>
<td>1</td>
</tr>
<tr>
<td>Human Perception of Light Intensity and of Color</td>
<td>2</td>
</tr>
<tr>
<td>Fluorescence</td>
<td>3</td>
</tr>
<tr>
<td>The Multispectral Solution</td>
<td>6</td>
</tr>
<tr>
<td>Narrow Bandwidth Acquisition</td>
<td>8</td>
</tr>
</tbody>
</table>

Light

Light, as used in this discussion, means the portion of the electromagnetic spectrum that is visible to the human eye. While the physical description of light can be highly complex, we will restrict this discussion to the wavelengths of light, and the interaction of that light with physical and biological materials.

The Electromagnetic Spectrum is illustrated in Figure 1 from radio to gamma ray frequencies. We are concerned with the visible wavelength range for purposes of this discussion, although the Maestro 2 in vivo imaging system can operate out to 950 nm, into the so-called near-infrared wavelength range.
Figure 1. The Electromagnetic Spectrum

Although this illustration of the electromagnetic spectrum suggests that the visible range of light covers approximately 400 nm to 800 nm, most humans realistically are limited to the range of 400 nm (deep violet) to 700 nm (deep red). Visible light makes up a very small portion of the entire electromagnetic spectrum.

Light is the transmission of energy. Visible light is associated with an energy level of about one electron volt per photon. As one moves to shorter wavelengths of light, the energy per photon increases. In the shorter ultraviolet wavelengths, which approach soft x-rays, the electron energy per photon increases to 50 to 100 electron volts. This energy content of light is useful when one wishes to induce a change of energy state in a material (i.e., cause a receptive molecule to undergo a series of energy additions and then relaxations, resulting in fluorescence).

Human Perception of Light Intensity and of Color

A Highly Adaptive Light Detector

The human eye is a highly adaptive light detector, becoming significantly more sensitive in low light, and less sensitive under bright light. This adaptive change is not instantaneous, and it takes some time for the eye to fully adjust to a new illumination level. This is the reason one needs to “dark adapt” by being in a darkened room for some time before observing weak fluorescence through a microscope.

While the eye can be very sensitive to low light levels and can also “see” in very bright conditions, it does not discriminate light levels very well. An individual has no “internal meter” that indicates the current sensitivity level setting for the eye. The eye also has a limited ability to discriminate levels of illumination ranging from the lowest level to the highest level at any given sensitivity. US Department of Defense research indicates that while some people can distinguish as many as 500 levels of gray, most humans can only

---

1. The Electromagnetic Spectrum illustration was prepared by NASA under Contract NAS5-26555 for the Education Group of the Space Telescope Science Institute’s Office of Public Outreach. It is used here under public domain in accordance with NASA’s contract.
distinguish approximately 30 to 35 levels of gray, ranging from black to white. This is relatively insensitive to the actual total illumination level, although the ability to discriminate gray levels does degrade in both very dim light and very bright light.

Response to Illumination

The eye’s response to illumination is not a linear response, but more closely approximates a logarithmic function. The result is that while the human eye interprets differences between gray levels as “even steps,” to achieve a two-fold brightening of the perceived gray level, the actual illumination level would need to increase significantly more than a simple doubling.

Contrasting the eye with a digital electronic sensor system, any sensor that has 8-bit resolution can detect 256 levels of gray. As the number of bits of resolution increase, the number of gray levels also increases. A 10-bit system gives 1024 levels and 12 bits yields 4096 levels of gray. Digital electronic sensors are linear in response to light levels.

Ability to Distinguish Colors

While the eye is relatively poor at discriminating gray levels (intensity), it is very good at distinguishing colors. Most individuals are estimated to be able to discriminate thousands of colors. The problem is, no two individuals see precisely the same color. In other words, each individual interprets colors slightly differently when viewing the same color. The basis for this is the way in which color sensors are arranged in the eye.

The eye contains three different types of color sensors, similar in response to the red, green and blue detectors in color cameras. Individual colors are composed of some combination of responses from these three different types of color sensors. While the general arrangement of these color sensors (cone cells) in the eye is reasonably standard, there are differences in the total number of each type of cone cell, and in the actual physical arrangement within the detecting cell layer (retina). These minor variations lead to the differences in perceived color between individuals, as does the actual way in which the individual’s brain learned to interpret color(s).

Fluorescence

Many biological and natural materials give off light of a particular color when exposed to light of another color. This property is a type of luminescence. If the emitted light occurs rapidly after illumination (around one-millionth of a second), the luminescence is called fluorescence. If the light emission takes longer than one-millionth of a second, the luminescence is called phosphorescence. Materials that exhibit fluorescence have proven extremely useful as labels or indicators in many biological systems.

Fluorescence light emission is different than light absorption. Each fluorescent molecule generates light. We measure the total amount of light generated, and are not dependent on the interaction of the light with another material, such as a dye. While it would seem that fluorescence is much more amenable to accurate measurement than absorbed light, there
are a number of factors that complicate such measurements. Fluorescence is emitted by a molecule in all directions, and most imaging systems are designed to capture light coming from a particular direction only. Therefore, there is no way to capture all of the light emitted by a fluorescent molecule with such a system. Additionally, fluorescence emission is influenced by the local environment, in particular by pH. The total amount of fluorescence will therefore depend on these local conditions of pH, as well as other surrounding molecules that may either enhance or quench some of the fluorescence energy. There is also the problem of obtaining identical excitation of all fluorescence molecules in a specimen, and this can be exceedingly difficult to achieve.

Fluorescence is an extremely sensitive technique, as it is much easier to visually assess or measure light emission against a dark background than it is to see a decrease in light intensity from absorption by a dye. Regardless of the sensitivity of fluorescence, the difficulty in establishing uniform excitation, and controlling for local environment effects makes quantitation of fluorescence emission difficult in biological preparations.

**Stoke’s Shift**

Materials that fluoresce always emit light at a longer wavelength than the wavelength of the exciting light. As an example, rhodamine isothiocyanate can be excited by green light, and then emits red light. This difference between the wavelength of the exciting light and the emitted light is called the *Stoke’s Shift* and is based on *Stoke’s Law*.

A range of excitation wavelengths will excite fluorescence. This range of wavelengths is known as the *absorption spectrum*. The emitted light also covers a range of wavelengths, and this is known as the *emission spectrum*. Since the Stoke’s Shift for most materials is not that great, there is generally some overlap between the excitation and the emission spectra. We will return to this point shortly as it does impact choice of emission and excitation filters in fluorescence systems.

![Figure 2. Stoke’s Shift](image)

Figure 2 contains an example excitation and emission spectra, showing Stoke’s Shift and the overlap of the spectra.

**Autofluorescence**

Many biological materials are naturally fluorescent. In particular, many vitamins, some hormones, and a variety of biological enzymes and structural proteins are naturally
fluorescent. These materials often fluoresce strongly enough to interfere with specific fluorescence labeling studies. Because of this unwanted background, or \textbf{autofluorescence}, both excitation light sources and emitted light paths are highly filtered in fluorescence systems.

On continued stimulation (illumination at the excitation wavelength), most fluorescent materials fade. While some specific preparation methods can reduce the rate of fading, and different fluorescent materials fade at different rates, all fluorescent materials eventually fade, and this effect is irreversible. For this reason, specimens should be illuminated only while aligning and focusing, and during actual image collection. At other times, the excitation light should be closed off.

\textbf{Excitation and Emission Filters}

Filters that are used for fluorescence excitation and emission are specifically constructed to have very narrow pass bands. They pass only a limited range of wavelengths of light. Restricting the excitation light wavelengths may reduce the amount of autofluorescence. Restricting the wavelength range of the emitted light helps minimize the amount of autofluorescence light that interferes with observing and measuring the desired specific fluorescence.

![Excitation Filter Types](image)

Figure 3. Excitation Filter Types

Excitation filters should be chosen to match the excitation maximum of the fluorescence label being used. The emission filter should match the emission maximum. In practical terms, the filter maxima may be slightly different from the ideal case, simply due to limitations of filter manufacturing, or to assist with autofluorescence reduction.

Specific excitation and emission filter combinations are available for most commonly used fluorescence dyes or labels. Nevertheless, regardless of how carefully one matches the excitation and emission filters to a given label, there will be some background autofluorescence, and this will reduce the perceived contrast between the “real” or actual label fluorescence and the specimen background.
The Multispectral Solution

The Maestro 2 *in vivo* imaging system offers a unique solution to the problem of autofluorescence and selection of emission filters. Multispectral analysis is based on the fact that all fluorescent materials produce a unique spectral emission. In other words, if you excite a material, and then examine the emitted fluorescence over a range of wavelengths, and record the intensity of emission at each point along the plotted curve of those wavelengths, you can generate an “emission spectrum” (like the green emission spectrum shown in Figure 2 illustrating Stoke’s Law). This spectrum is different for each specific fluorescent material.

**Overlapping Emission Spectra**

The complication is that for many fluorescent labels of biological interest, the emission spectra overlap significantly, and these emission spectra may also be obscured by autofluorescence from other constituents of the specimen. Often, autofluorescence is a strong (bright) broad signal that may obscure the specific fluorescence that the investigator wishes to see.

![Figure 4. Overlapping Excitation and Emission Spectra](image)

In this example of overlapping excitation and emission spectra, green is MitoTracker® Green Fn, Blue is Acridine Orange, and Red is Fluorescein isothiocyanate (FITC). The Cyan line at 488 represents the illumination light. Dotted lines are excitation spectra, and solid lines are emission spectra. (Illustration derived from Invitrogen™ Spectraviewer.)

There are three points to note in the graph shown in Figure 4.

- The excitation spectra overlap significantly with the emission spectra. This is why one needs to carefully select excitation filters. The goal is to prevent as much excitation light as possible from appearing in the emission spectra.
- Even with distinct emission spectra, there is significant overlap in the emission spectra of these three dyes. Visual examination of such a mixture of fluorescence spectra would be unable to distinguish these three dyes as individual “colors.” They would be seen as some combination of yellow and green by most observers.
• The graphical display of spectra is normalized, and in actual practice, some fluorescent materials are much brighter than others.

As Figure 4 illustrates, many labels of biological interest have emission spectra that are so similar that separation using narrow band filters is difficult or impossible. Multispectral analysis provides the solution to this problem and reduces the need for multiple expensive narrow-band emission filters. A single long-pass emission filter can replace a large collection of emission filters.

**Multispectral Analysis**

The Maestro 2 *in vivo* imaging system’s combination of unique hardware and sophisticated software makes powerful multispectral analysis possible. Multispectral analysis generates spectral curves for the various fluorescent dyes or materials in a specimen. In addition, it generates a spectral curve for the autofluorescence that almost always is present to some degree.

In a multispectral analysis, a series of images are captured at specific wavelengths. The range of wavelengths captured should cover the spectral emission range of the labels present in the specimen. The number of images within that range should be chosen to adequately define the emission spectral curve for each label. The result will be a series of images, called an “image cube,” taken at specific wavelengths.

The data within the image cube is used to define the individual spectra of both autofluorescence and specific labels. Using sophisticated algorithms, the contribution of autofluorescence to the image can be removed, and the individual fluorescence spectra separated. The result is a set of images representing each spectrum that contributes to the final image.

In other words, as illustrated in Figure 4, multispectral analysis yields (1) an autofluorescence image, (2) a MitoTracker Image, (3) a Acridine Orange image, and (4) a FITC image. By removing the autofluorescence contribution to the image, the actual signals from the applied labels (MitoTracker, Acridine Orange and FITC) can be readily seen. If these individual images are recombined using highly contrasting colors to represent the location of each of the labels, a composite image of high contrast and readily observable colors can be generated.

**Solution for Imaging Small Animals**

Multispectral analysis also solves an even larger impediment to the imaging of small animals. Animal skin and fur is highly autofluorescent. In addition to the natural autofluorescence of skin, there is also distinct autofluorescence from the sebaceous glands (sebum) and from a variety of commensal organisms that may be present (mites, fungi, etc.).

Small animals may also demonstrate fluorescence from ingested food, particularly if the food contained chlorophyll (whose breakdown produces fluorescence strongly in the red). Multispectral analysis is able to separate all of these autofluorescence signals away from the specific labels applied to the specimen, and provides the ability to localize each material present, and to detect weak specific labeling even in the presence of strong autofluorescence.
Narrow Bandwidth Acquisition

Maestro 2 in vivo imaging systems have the ability to narrow the bandwidth of the liquid crystal tunable filter (LCTF) by approximately half. This technology lets you use the system in broad or narrow mode, which greatly increases the system’s multiplexing capabilities and low light-level sensitivity. Figure 5 shows broad and narrow LCTF transmission at 700 nm and 800 nm.

![Figure 5. Comparison of broad and narrow LCTF transmission](image)

Use the system in narrow mode to obtain better resolution of closely spaced and overlapping emission spectra. Narrow mode can also increase the number of fluorophores to quantitate more markers. This can improve the dynamic range of your co-localized spectra. Figure 6 illustrates the higher spectral resolution obtained in narrow mode.

![Figure 6. Comparison of broad and narrow 605 nm Qdots](image)
Chapter 2

Introduction to the Maestro 2 In Vivo Imaging System

This chapter provides an introduction to the Maestro 2 in vivo imaging system. It includes a brief description of each of the system’s hardware components and software features.

Topics in this chapter:

- Operator and Equipment Safety ................................................................. 10
- About This Manual .................................................................................. 11
- Maestro 2 Hardware Components ............................................................ 12
- Launching the Maestro Software .............................................................. 23
- Understanding the Maestro 2 Work Area ............................................... 23
- Specifying Maestro 2 Hardware Settings ................................................. 27
- Using Low Screen Resolution Mode ....................................................... 30
- Reinitializing Maestro 2 Hardware ........................................................... 30

Introduction

CRi’s Maestro 2 in vivo imaging system is a high performance multispectral imaging system designed for fluorescence macro-imaging. The patented liquid crystal (LC) tuning element performs like a high-quality interference filter, which enables the transmitted light to be electronically tunable. Intuitive Maestro 2 acquisition and analysis software runs on a powerful desktop or laptop computer.
Operator and Equipment Safety

It is the responsibility of the purchaser to ensure that all persons who will operate the imaging system are aware of the following cautionary statements. As with any scientific instrument, there are important safety considerations, which are highlighted throughout this User’s Manual.

General Cautionary Statements

READ AND UNDERSTAND THIS USER’S MANUAL BEFORE ATTEMPTING TO OPERATE, TROUBLESHOOT, OR MAINTAIN THE MAESTRO 2 IN VIVO IMAGING SYSTEM. READING THIS MANUAL FIRST MAKES IT EASIER AND SAFER TO OPERATE AND MAINTAIN THE SYSTEM.

Operate the system on a flat, stable surface.

Do not drop the imaging system.

Do not expose the imaging system to prolonged heat above 40 °C.

Do not operate the system in an environment with explosive or flammable gases.

Do not subject the imaging system or its components to intense light from laser, focused arc or Hg lamp sources.

Do not operate the system in places where it may be splashed with liquid. (The unit may be cleaned with a sanitizing solution. Refer to “Cleaning Your Maestro 2 In Vivo Imaging System” on page 22 for cleaning guidelines.)

Use only a properly grounded power cable appropriate for the site where the system is installed. Some cables and adapters supplied with the system have proprietary specifications. Do not connect components supplied by CRi using unqualified cables or adapters. Doing so could result in damage, and voids the Warranty.

Use only a properly grounded power outlet when connecting the system to power.

If you are using third-party mechanical components for the imaging system, consult “Appendix A, System Specifications & Dimensions.”

Follow the recommended maintenance procedures. This will help ensure optimal performance over years of use.

Caution! Service should be performed by CRi authorized and trained personnel only. Power must be disconnected from the system before servicing.

For Technical Assistance

If you experience any difficulty setting up, operating, or maintaining your imaging system, please contact your CRi representative. Office hours are 8:00 a.m. to 6:00 p.m. (Eastern Standard/Daylight Time), Monday through Friday.

- Telephone (US Toll-Free): 1-800-383-7924
- Telephone (Worldwide): +1-781-935-9099
- Facsimile (Worldwide): +1-781-935-3388
- Email: techsupport@cri-inc.com.
About This Manual

This manual describes the use and functionality of the Maestro 2 in vivo imaging system with Maestro version 2.8 software. Operating instructions, functional descriptions, troubleshooting, illustrations, and other relevant information are contained in this manual.

Your Maestro 2 system may include support documentation from third-party vendors. Bear in mind that components of the system may have been modified or custom-designed, so treat such third-party documentation as supplemental material only. In cases where CRi and third-party documentation differ, and you have any doubt as to which applies to your system, contact an authorized CRI distributor or service representative.

Design Change Disclaimer

Due to design changes and product improvements, information in this manual is subject to change without notice. CRi reserves the right to change product design at any time without notice to anyone, which may subsequently affect the content of this manual. CRi will make every reasonable effort to ensure that this User’s Manual is up to date and corresponds with the shipped Maestro 2 in vivo imaging system.

Reproduction Disclaimer

No part of this manual may be reproduced, photocopied, or electronically transmitted, except for reference by a user of the Maestro 2 system, without the advance written permission of CRi.
Maestro 2 Hardware Components

The imaging system contains all of the imaging components in a single light-tight enclosure. These include a high-resolution, scientific-grade CCD imaging sensor, a solid-state liquid crystal (LC) wavelength tuning element, a spectrally optimized lens and internal optics, an excitation light source, and an emission filter assembly.

Connection ports located on the system’s exterior include one USB 2.0 Type B port for connecting to the workstation computer, a power plug port, and anesthesia supply and exhaust ports.

The Control Panel provides switches for the excitation lamp, the shutter, and the white interior lights. It also displays system status, interior temperatures, and the current filter wavelength. Figure 7 shows a front exterior view of the system.

Heated Specimen Chamber and Stage

The specimen chamber is a heated, light-tight enclosure specially designed for in vivo imaging. A radiant heating system maintains the internal temperature of the chamber at the temperature specified by the user.

The specimen chamber is intended to be used with CRi’s nosecone/heated stage system. This accessory is a combined controlled heated stage and non-rebreathing nosecone system, which keeps up to three rodents anesthetized and metabolically stable for in vivo imaging experiments. All components inside the chamber are non-fluorescent.
The stage system uses quick connect tubing and cabling for easy installation and removal for cleaning and sterilization. (See also “Cleaning Your Maestro 2 In Vivo Imaging System” on page 22). Figure 9 shows the required tube and cable connections.

**Controlling the Chamber Environment**

Use the Maestro 2 software to set the target temperature and min./max. range limits for the chamber and the stage.

**To set the temperature**

1. Select **Hardware > Edit Hardware Settings** from the Maestro software menu (or press Ctrl+H). Select the **Chamber Environment** tab.
2. The **Heater On** check boxes let you turn the stage and chamber heaters on or off.

3. Use the **Target** box(es) to enter the target temperature(s) in celsius for the stage and chamber. The targets must be within the specified range limits. The actual temperature is displayed next to the Target boxes. This actual temperature is also displayed on the status bar of the Maestro window.

4. The **In-Range Limits** determine the temperatures at which the High and Low temperature warning lights illuminate on the system control panel. These values are set automatically based on the target temperatures. You can change these values, but only slightly, and within the specified range limits.

**Exhaust Evacuator and F-Air Canister**

The variable speed exhaust evacuator and F-Air canister minimizes the investigator’s exposure to anesthetic gas. Make sure the evacuator is completely setup, connected to the system and turned on prior to turning on a source of anesthetic gas.

**Note:**

To start the exhaust evacuator, turn the flow speed dial to a middle-to-high flow setting. Then adjust the flow to a speed that allows the correct amount of gas to keep the animal(s) comfortably anesthetized. Decrease the air flow if the animal(s) are becoming awake (often indicated by movement or rapid breathing). Increase the air flow if the animal(s) are too heavily sedated (breathing too slowly) or if you can smell anesthetic gas.

---

*Figure 10. Exhaust Evacuator*

The evacuator connects easily to the EXHAUST port on the side of the Maestro 2 imaging system (see Figure 11) using the supplied 3/4” tubing. Inside the chamber, the corresponding EXHAUST port connects to the heated stage.
Anesthesia Supply and Exhaust Ports

The external anesthesia ports are located on the left side panel of the imaging system.

![Figure 11. Anesthesia Ports](image)

Screw the 1/4” and 3/4” barb fittings (provided) into the SUPPLY and EXHAUST ports. Then connect your 1/4” anesthesia supply tubing to the SUPPLY fitting, and the 3/4” exhaust tubing from the anesthesia exhaust evacuator to the EXHAUST port.

Utility Ports

There are three multi-purpose utility ports provided in the small black panel on the left side of the imaging system. The top port is 3/4”, the middle port is 1/2”, and the bottom port is 1”. To use any of these ports, use a sharp tool to carefully pry out the interior and exterior plugs from the appropriate port.
Control Panel

The control panel provides controls for the system lighting. It also indicates current filter and system status.

![Maestro 2 Control Panel]

**Figure 12. Maestro 2 Control Panel**

**Interior Illumination**

This button controls the interior illumination lights. When this button is illuminated, the interior white lights are on. Later, when you are ready to capture an image or image cube, remember to switch off the interior lights and open the shutter for the excitation lamp.

**Excitation Lamp**

This button controls the excitation lamp. When this button is illuminated, the lamp is on. After switching on the excitation lamp, it takes approximately fifteen to twenty minutes for the lamp output to stabilize to within 2% of its current maximum brightness. Therefore, to achieve the most accurate and repeatable results, you should consider switching on the excitation lamp when you first switch on the system. Then open the shutter when you are ready to acquire an image cube.

Remember to switch off the excitation lamp when you will not use the system for a prolonged time period. After 500 to 1000 hours of illumination, the lamp intensity will be reduced by about 50%. If lamp brightness is important to your application, you should consider replacing the lamp during this time. Use the hour meter (located behind the emission filter access panel) to track the number of hours the lamp has been illuminated. Refer to “Excitation Lamp” on page 20 for lamp replacement instructions.

**Shutter**

When you are ready to acquire an image, push the **SHUTTER** button to open the shutter and let the excitation light into the specimen chamber. (The shutter is open when this button is illuminated.)
Filter Wavelength Indicator
This indicator shows the current filter wavelength while acquiring an image. Also, these indicator lights will scroll up in a repeating pattern while the LCTF is exercising during system startup.

Status: System
Indicates the current system status. The **Power** light indicates that the system is powered on and running. The **Motion** light illuminates green when all focus motors and filter wheel motors are ready for operation. The **Camera** light illuminates green when the camera has finished initializing and is ready to acquire images.

Status: Stage Temperature
Indicates when the stage temperature is OK, or whether it is higher or lower than the current setpoint.

Status: Chamber Temperature
Indicates when the chamber temperature is OK, or whether it is higher or lower than the current setpoint.

Refer to “Controlling the Chamber Environment” on page 13 for how to change the stage and chamber temperature setpoints.
Emission Filters

Maestro 2 systems come with a compliment of seven emission filters and one clear glass filter, and all are installed at the factory. Each emission filter is labeled with a barcode that is readable by the Maestro software. For easy visual reference, the label is also stamped with the filter’s center wavelength (as shown in Figure 13).

The emission filter wheel has room for ten 38 mm diameter longpass filters, and is located behind the access door at the upper-right on the front of the imaging system (as shown in Figure 14).

Each time a filter is installed or removed from the wheel, the software scans the barcodes and records the location of each filter.

Dialog boxes in the Maestro software list the installed filters and their wavelengths/acquisition parameters. During the cube acquisition process, you will select an emission/excitation filter combination via the Maestro software. The system then automatically rotates the filter wheel to move the appropriate emission filter into the light path.

Lamp Hour Meter

The lamp hour meter is located next to the emission filter wheel. It tracks the number of hours that the excitation lamp has been turned on. Typical lamp-life is approximately 500 to 1000 hours, after which CRI recommends changing the lamp. The lamp hour meter can be reset to zero by pressing the reset button located just above the lamp. **The lamp must be turned OFF when the reset button is pressed.** (See “Excitation Lamp” on page 20 for detailed instructions)
Excitation Filters

Maestro 2 systems come with a compliment of seven excitation filters (Figure 15) and one attenuator. Just like the emission filters, each excitation filter has a barcode label that is readable by the Maestro software. The software scans the barcodes and records the location of each filter.

The excitation filter wheel holds up to ten 25 mm diameter bandpass filters, and is located behind the access panel at the lower front of the imaging system. See Figure 16. Filter wheel locations that do not have filters installed are fitted with blanks that block the light. This prevents the unfiltered light source from burning the end of the fiber-optic light guide.

When you select an emission/excitation filter combination to acquire an image cube, the system automatically rotates the filter wheel to move the appropriate excitation filter into the light path.

Replacing Emission and Excitation Filters

Before inserting or removing filters in the filter wheels, the imaging system and the Maestro software should be running. This way, you use the software to rotate the filter wheel to the location where you want to insert/replace a filter. This is better than attempting to rotate either of the wheels manually by moving them with your finger.

To replace a filter:
1. Select Hardware > Edit Hardware Settings from the Maestro software menu (or press Ctrl+H). Select the Change Filters tab.
2. Click the Change Filters button. The system will read the location of all filters in both wheels and display the results in the Change Automated Filters dialog box.
3. If replacing a filter, select from the list the filter you want to replace. If adding a new filter, select an empty filter slot in the excitation or emission wheel, as appropriate.
4. Click the Change Filter button. The software will rotate the wheel to the selected filter slot.
5. For emission filters, open the access door at the upper-right front of the system and remove the filter slot cover. For excitation filters, remove the plastic panel at the lower front of the system and then remove the black panel that covers the excitation lamp and filter wheel.
6. Remove any existing filter and insert the new one. Be careful not to touch the filter glass. Make sure the filter clicks firmly into place.
7. Replace the cover and close the access door or plastic panel. When you click OK, the system will scan the new barcode and add the filter to the list of installed filters.
Excitation Lamp

The excitation lamp uses a xenon light source and fiber-optic delivery system.

![Excitation Lamp](image)

**Figure 16. Maestro 2 Excitation Lamp & Filter Wheel Access Panel**

The light source is a Cermax®-type 300 Watt xenon lamp. It provides 5600 °K illumination with a typical lamp-life of approximately 500 to 1000 hours. After this time, the lamp intensity will be reduced by about 50%. If lamp brightness is important to your application, you should consider replacing the lamp during this time.

An hour meter located behind the emission filter access port door indicates the number of hours the lamp has been illuminated. Contact CRi if you need to purchase a replacement lamp cartridge (Part # OP10157).

**To replace the lamp cartridge:**

**Caution!** Do not remove the lamp immediately after operation. Allow the lamp to cool for at least ten minutes. To prevent overheating, replace only with the same type and rating of lamp. Read all instructions before replacing the lamp. Do not switch the excitation lamp on without the lamp cartridge in place.

1. Switch off the excitation lamp and allow it to cool for at least ten minutes.
2. Remove the lower front panel and remove the lamp access panel (see Figure 16 for location) to expose the lamp cartridge.
3. Grasp the handles of the cartridge and pull firmly to remove it.
4. Insert the new lamp cartridge, pushing it firmly into place. The cartridge can only be inserted one way.
5. Reset the lamp hour meter by pushing the **RESET** button. The **RESET** button is located just above the lamp. Press this button only when the lamp is turned OFF.
6. Replace the lamp access panel when finished, then replace the outer front panel.
System Power

On the right side of the system there is a POWER ON/OFF switch that controls the system’s main power (Figure 17). Located immediately above the power switch is the fuse holder, which holds two 250VAC 10A fuses. These fuses prevent accidental circuit overloads in the system.

To switch power ON and OFF:
Switch the imaging system on by moving the POWER switch to the ON position. The system may take one minute or more to initialize.

To replace fuses in the system:
Use 250VAC 10A slow-blow Cooper Bussman® MDL-10 fuses.

1. Disconnect the system from electrical power.
2. Locate the small black panel that covers the system fuse holder. It is located immediately above the main system power switch on the back of the system.
3. Use a small screwdriver to open the black fuse cover from the top and open it downward.
4. Use the small screwdriver to gently pry the red fuse holder out of its port.
5. Replace both fuses in the fuse holder with 250VAC 10A slow-blow Cooper Bussman® MDL-10 fuses, available from CRi and other sources.
6. Replace the fuse holder into its port and close the cover.
7. Reconnect the system to electrical power.
Workstation Computer

Maestro 2 systems require a computer with a level of performance appropriate for acquiring and analyzing digital multispectral data. Computers purchased from CRi that will be used with the system meet the performance requirements listed in “Computer System Requirements” on page 132. If you decide to supply your own computer, be sure it meets the performance requirements as well.

USB Multimedia Controller (Focus Knob)

The focus knob connects to an available USB port on the workstation computer. This knob is the primary means of focusing the live image. CRi installs the drivers needed to operate the focus knob prior to shipping the system.

When connected to a USB port on the computer, the outer rim of the focus knob should glow with blue light. If this does not occur before you open the Maestro 2 software, double-click the 3DConnexion Control Panel icon on the desktop to start the device driver. The blue glow now indicates that the device is active.

Cleaning Your Maestro 2 In Vivo Imaging System

It may be necessary to periodically clean the inside and outside of imaging system. Follow these guidelines when cleaning:

- Spray a clean cloth with a sanitizing solution such as 70% ethanol and wipe down the specimen stage and pad. Wipe all surfaces below, around, and behind the specimen stage as well.
- Be careful never to spray directly into the specimen chamber to prevent spraying the ceiling glass or any other sensitive components.
- Wipe down all external surfaces with the same solution and a clean cloth.

Cleaning Filters and Other Optical Surfaces

If you need to clean any optical surfaces, apply lens-cleaning fluid, spectroscopic-grade isopropyl alcohol, distilled water, or methanol to a lint-free lens tissue and drag-wipe the surface. Do not rub the surface because anti-reflection coatings can be scratched. If further cleaning is required, repeat with a fresh tissue and fluid after one pass, since contaminants need to be wicked away, not spread over the optical surface.
Launching the Maestro Software

If you have already purchased the Maestro 2 system, the software was installed and activated for you at the factory. Double-click the **Maestro 2** icon on the workstation computer’s desktop.

If you need to install and/or activate the software, see “Appendix D, System Setup & Installation.

**To evaluate Maestro Software:**

If you have not yet purchased a Maestro 2 system but you want to evaluate the software, select the “I want to evaluate Maestro...” option when the Activation dialog box opens. You will be allowed to use the software for 30 days before being required to purchase and activate the software to continue using it.

Understanding the Maestro 2 Work Area

The Maestro 2 work area includes a menu bar, a toolbar, control panels for acquiring and analyzing images, an image gallery, and thumbnails and data pages. Figure 19 shows a sample of the work area with a cube and a set of unmixed images.

*Figure 19. Maestro 2 Work Area*
## A. Toolbar

The toolbar makes it easy to access a variety of functions including loading and saving cubes, adjusting the image zoom level, drawing measurement regions, and adjusting the display settings. The tools that are available on the toolbar will change based on the current action.

- Click this button or select Open Cube from the File menu to open an image cube. See also “Opening an Image Cube” on page 70.
- Depending on the active window, click this button to save an image or your multispectral dataset. See also “Saving Images and Image Cubes” on page 65.
- Use this tool to zoom in on an image. See also “H. Zooming In and Out” on page 26.
- Click this button to return the current image magnification to 100%.
- Click this button to pan the zoomed image that is currently active. The pointer becomes a hand symbol. Pan the active image by clicking on the image and dragging it to the desired view within its window.
- Click this button to return the mouse pointer to its default pointer mode.
- When sampling spectral signals for your spectral library, click this button if you want to sample a rectangular region of pixels.
- When sampling spectral signals for your spectral library, click this button if you want to sample an elliptical region of pixels.
- When sampling spectral signals for your spectral library, click this button if you want to sample a line of pixels.
- When sampling spectral signals for your spectral library, click this button if you want to sample a freehand drawn region of pixels.
- Click this button to open the Co-localization tool for co-localization staining detection and analysis.
- Click this button to open the Display Control to adjust the display settings (brightness, contrast, display scaling, etc.) for the current image. See also “Chapter 8, Customizing Spectral Displays.”
- Click this button to open the DyCE Data Collection and Explorer tool. See also “Chapter 11, Dynamic Contrast Enhancement (DyCE).”
B. Control Panels

To select a control panel:
Click the control panel’s tab. The following panels are available:

- The **Acquire** panel includes all the controls needed to acquire new spectral images and image cubes. It includes sub-panels for brightfield and fluorescence acquisition.
- The **Spectra** panel is used to create spectral libraries and unmix cubes.
- The **Measure** panel is used to find, measure, and adjust measurement regions in component images.
- The **Display** panel is used to change current display settings of images.

C. Status Bar

The **Hardware Status** box displays the current status of the camera: “No Hardware” or “Ready.” The **Protocol** drop down box displays the currently loaded protocol. It also lists all protocols opened during the current session. The **Cursor X/Y** and **Average Signal** boxes display the coordinate location and signal level at the cursor’s current position over any image. You can change the measurement pixel unit (i.e., Counts, Scaled Counts/Sec, and Photons/s/cm²) by selecting **Hardware > Edit Hardware Settings > Pixel Units** from the menu.

The **Temperature** box displays the current temperature of the stage and the chamber.

Use the **Macro** drop down list and associated buttons to select and run macros. Maestro comes with pre-recorded macros for acquiring and working with images, and these are listed in the **Macros** drop down list. Any additional macros that you create and save will be added to this list as well.

D. Image Gallery

The image gallery displays the live image (when in acquisition mode) and the current opened or acquired cube. The gallery also displays unmixed composite images and their component images, as well as any other images open in the software.

E. Thumbnails and Image Data Pages

There are four pages with tabs across the bottom of the image gallery. You can change the viewable size of these pages by clicking the **Shrink** or **Grow** buttons at the far right (see Figure 19). These pages display the following types of information:

- The ** Thumbnails** page displays a thumbnail of each image in the gallery. If you have more than one cube open, you can double-click any cube thumbnail to display the cube and its components in the gallery. If you have zoomed in on an image, the zoom view rectangle within the thumbnail shows the zoomed region. (You can drag this rectangle with the mouse pointer to pan the zoomed image.)
- The **Measurements** page displays the measurement data of measurement regions drawn on component images. See also, “Chapter 7, Quantifying Results.”
- The **Log** page contains an action history of the current session. The log can be saved or cleared by clicking the buttons at the far right of the page.
The **Cursor** page provides information about the image pixel at the current pointer location. For cubes, it displays the average signal. For composites, it displays absolute and percent contribution from each component. For other image types, it displays the pixel values.

**F. Window Layout**

Each window type has a home position on the screen. The cube lives in the upper left corner, the composite image lives in the upper right corner, and the component images are positioned in a grid starting from the lower left and working up and to the right.

Pressing Ctrl+L will force the windows to their home positions. In addition, many operations will force the windows to their home positions. These include resizing the thumbnail view, unmixing a cube, or activating a window from the thumbnail view.

**G. Resizing an Image Window**

There are a few ways to change the size of an image window or windows.

**To manually resize a window:**

Click and drag its window border to the desired size. The image inside the window resizes to fill the window, while also maintaining its aspect ratio.

**To maximize the current window:**

Click the window’s maximize button. The window will fill the image gallery.

**To expand or reduce a window in steps:**

Select **Expand Window** (or press Ctrl+E) or **Reduce Window** (or press Ctrl+R) from the **Window** menu.

**H. Zooming In and Out**

You can zoom in to focus on details or zoom out to see more of an image.

**To zoom in:**

Click the **Zoom** button on the toolbar. The mouse pointer changes to a magnifying glass. Use the magnifying glass to draw a box around the area you want to zoom.

You can also click the area of the image you want to zoom. Each time you click the image with the **Zoom** tool, the zoom increases. In addition, you can scroll the mouse wheel to zoom in.

**To zoom out:**

Click the **Full Image** button on the toolbar.

You can also right-click on a zoomed image and select **Zoom To Full Image** from the pop-up menu. You can also scroll the mouse wheel to zoom out.
I. Panning a Zoomed Image

When you zoom in on a particular area of an image, you might not be able to see other areas of the image.

To pan a zoomed image:

Do one of the following:

- Right-click on the image and select Pan from the pop-up menu. The mouse pointer changes to a hand icon. Click and hold the mouse button while dragging, or panning, to view the desired area of the image.
- Drag the zoom view rectangle that appears on the corresponding thumbnail image in the Thumbnails tab.
- Scroll the mouse wheel while holding down the Shift key (to pan horizontally) or the Control key (to pan vertically).

J. Panning All Images Simultaneously

Zoom in on an image cube, then hold down the Shift or Control key and drag the zoom view rectangle on the cube’s thumbnail image. All images pan simultaneously.

![Figure 20. Simultaneous Panning](image)

Specifying Maestro 2 Hardware Settings

Camera Settings

You can specify a variety of settings and parameters for the camera in your Maestro 2 in vivo imaging system. To access the camera settings, select Hardware > Edit Hardware Settings > Camera. A brief explanation of each setting is provided below:

- **CCD Bit Depth** lets you capture either 8-bit (256-level) or 12-bit (4096-level) grayscale images per wavelength. 12-bit images take up twice the memory and disk space of 8-bit images and can only be opened using scientific imaging applications, including Maestro software. In most instances, it is best to use the default 12-bit selection. This gives higher quality images. Many Microsoft® Windows® applications cannot open
12-bit images. If you want to capture images that can be displayed using non-scientific imaging applications, select the 8-bit option.

- **F#** sets the lens f/stop position. For most applications, the f/stop should be set at 1.5. If there is a need for greater depth of focus, then set the f/stop to the smallest value that will give an acceptable depth of focus. Remember to return the f/stop to 1.5 when you are finished with an alternate setting.

- **Gain** affects image quality because it modifies the CCD readout process. For images that have low intensities, consider increasing the gain value slightly to achieve images with brighter pixel values. Increasing the gain can also reduce the exposure time. Note, however, that higher gain settings can result in increased signal noise, which reduces image quality. Gain values of 1, 2, or 3 should be suitable for most applications.

- **Check Dark Current** is used to calculate the amount of background noise present in the camera. This is calculated using a zero time exposure and no light reaching the camera.

- **Check Dark Frame** is used to calculate the amount of background noise present in the camera. This calibration is required for the software to support long exposure times (exposures greater than five seconds). This calibration is done at CRi and takes approximately 30 minutes to complete.

- **Frames to Average** is a useful feature for reducing noise in acquired images by increasing the signal-to-noise ratio. This value specifies the number of images the camera will take at each acquisition wavelength. The software then averages the values of those images to create a single image for each wavelength. The signal-to-noise ratio increases approximately by the square root of the number of images averaged. For example, averaging four images per wavelength gives a 2x signal-to-noise ratio. This should translate into approximately a 2x reduction in the limit of detection.

- **Fluorescence Autoexpose target % of dynamic range** sets the autoexposure target values, and attempts to prevent saturation of pixels by restricting the exposure time to a percentage of the dynamic range of pixel values. For example, the default value of 70% for 12-bit (4096-level) images results in a maximum intensity value of 2867.

The **Maximum Exposure** settings let you specify maximum exposure times (in seconds) for fluorescence and low light:

- **User Defined Exposure** sets the maximum value that a user can enter in the Exposure edit box on the Acquire panels.

- **Auto Exposure** sets the maximum exposure that is allowed to be returned when the user autoexposes a fluorescence or low light image.

- **Auto Exposure Live** only applies to low light imaging. This value sets the maximum exposure that is allowed to be returned when the user autoexposes the live low light image.
The **Disable Automatic Hardware Control Rules** check box lets you turn off the Maestro 2 system’s automated hardware features. If you clear this check box, the Maestro 2 system will no longer optimally control hardware for specific operations such as cube and image acquisitions.

**Selecting a Measurement Pixel Unit/Scaling**

You can select **Counts**, **Scaled Counts per Second**, or **Photons** as the measurement pixel unit. Select **Hardware > Edit Hardware Settings > Preferences**. In the **Measurement Pixel Unit** box, select one of the following options.

- **Counts**: Measurements indicate count levels as read from the camera, so the indicated value depends on the gain, binning, bit depth and exposure time used for a given measurement.

- **Scaled Counts/Second**: Measurements indicate count levels after scaling for the effects of exposure time, binning, camera gain, and bit depth, so the indicated value is essentially independent of these settings. This is represented as follows:

\[
\text{Scaled Counts/Sec} = \frac{\text{counts}}{\text{full scale}^*} \times \frac{1}{\text{exp}(s)} \times \frac{1}{\text{bin}^2} \times \frac{1}{\text{gain}}
\]

  * full scale = 4096 for 12 bit acquisitions
  256 for 8 bit acquisitions

- **Photons/s/cm²**: Measurements indicate signal flux at the object, in photons per second, per square centimeter of surface.

**Displaying Image Cubes with Enhanced Contrast**

The **Display** panel and the **Display Control** window (see “Advanced Display Controls” on page 101) both include an **Enhance Contrast** check box that lets you display images with enhanced contrast. You can control whether this box defaults to checked or unchecked each time a cube is acquired or opened in Maestro.

1. Select **Hardware > Edit Hardware Settings > Preferences**.
2. Check **Display Image Cubes with Enhanced Contrast** for either **Fluorescence Images** or **Brightfield Images**, or both.

This selects how fluorescent and brightfield image cubes are shown when first acquired, or when first loaded from disk. You can adjust the enhanced contrast setting for an image by using the check box in the **Display Control** or the **Display** panel.
Using Low Screen Resolution Mode

Maestro software only supports display resolutions of 1280x1024 or higher. However, some displays—especially some digital projector displays—do not support resolutions this high. The software has a special mode to support projectors or screens at 1024x768 resolution. Some of the functions will not be available in this mode.

Screen resolution is detected at time of startup. A dialog box warns you if you are running in low-resolution mode. If the Maestro software is started, and subsequently the screen resolution is changed, the software will not detect it.

If the software is run with a screen height of 800 pixels or less, it makes the following adjustments:

- In low-resolution mode, spectral libraries can only have five elements. This will effect the Spectra and Display panels as well as the Batch Mode, Import Spectral Library, and RCA dialog boxes.
- The toolbar is removed from under the main menu.
- The Sample ID and Notes boxes are removed from the Fluorescence panel.
- The Notes box is removed from the Spectra panel.
- Plots on the Manual Compute Spectra dialog box are 4/5 their normal size.
- The spectral graph (for cube display) is removed from the Display panel.
- The status bar at the bottom of the screen does not display.

Reinitializing Maestro 2 Hardware

When you launch the Maestro software, it automatically detects the camera/imaging system hardware if it is attached to the computer via the USB 2.0 cable. If the software loses its connection to the hardware, make sure the USB 2.0 cable is properly connected, then select Hardware > Reinitialize. The software should detect and initialize the hardware.

If the computer’s power save feature is enabled, this will cause the computer to enter sleep mode if left inactive for a length of time. Turn this feature OFF. If the computer goes to sleep while it is connected and running the software, the connection with the camera/imaging system will be lost. You will have to reboot both the imaging system and the computer to reconnect.

Avoid this problem by making sure the computer is set to never enter sleep mode. This will prevent losing the hardware connection between the computer and system.

1. Click Start > Control Panel > Power Options to display the dialog box.
2. On the Power Schemes tab, select Always On in the Power schemes drop down box.
3. You can select any time period for the Turn off monitor setting. The Turn off hard disks and System standby options must be set to Never.
4. Click Apply and then OK and close the Control Panel.
Chapter 3

Imaging the CRi Business Card with QDot™ Spots

This chapter steps you through the process of acquiring an image cube of the CRi business card with QDot spots. This business card was included with your Maestro 2 in vivo imaging system, and has three QDot spots applied to its front surface: 565 nm towards the left and 605 nm towards the right, and a mix of both 565 and 605 nm dots in the center.

We will also practice saving, unmixing, and analyzing the component and composite images. By following the instructions in this chapter, you will learn how to use the Maestro 2 in vivo imaging system, as well as verify that the system is working properly.

Topics in this chapter: Page
- First Steps ............................................................................................................. 32
- Acquiring an Image Cube .................................................................................... 32
- Unmixing the Image Cube .................................................................................... 34
First Steps

1. Before you begin, verify the following connections (reference “Appendix D, System Setup & Installation” if necessary): The system should be plugged into a surge-protected electrical outlet. The USB interface cable should be connected between the workstation computer and the system.

2. Switch on the system and the computer. Make sure the focus knob is connected, and check that its outer rim glows with blue light. This indicates it is active and ready to use. If the blue lights are not on, double-click the 3D Connexion Control Panel icon on the desktop to start the device driver. You may now launch the Maestro 2 software.

3. Open the door and place the CRi business card at the center of the specimen stage. Close the door.

4. Push the EXCITATION LAMP button to switch on the excitation lamp.

5. Push the INTERIOR ILLUMINATION button to switch on the interior white lights.

6. Note the Hardware Status bar at the bottom of the work area. “Filter Exercising” should display until “Ready” displays in the status box. If the status box displays “No Camera And Filter,” verify that the USB and power cables are properly connected and that the system is turned on.

Acquiring an Image Cube

Select the Acquire panel and click its Fluorescence tab.

1. Click the Live button if you don’t already see the Live Stream window. A live image of the business card should be visible. Maximize the Live Stream window if desired.

2. Accept the default Binning (2x2) and Region Of Interest (Full) settings for now. For Maximum Sample Size, select (3.3” x 4.4”) so that the business card image fills the Live window (see Figure 21).

3. In the Wavelength And Exposure group, set the Wavelength to 590 nm. Click the Autoexpose Mono button to improve the live image. The calculated exposure setting will display in the Exposure (ms) box.

4. Use the external focus knob, or the Focus slider or scroll box to focus the image. The scroll box shows the current focal distance in mm. In Figure 21 for example, 2 means the lens is focused at 2 mm from the stage surface.

5. If necessary, open the door and reposition the card so it is clearly visible in the Live Stream window. Close the door again when finished.

Note: When you open the door, you may notice that much of the business card image turns red. This is caused by excess light entering the chamber and saturating the image. This will correct itself when you close the door.
6. A good excitation wavelength for the Qdots used is 455 nm, so we will use the blue Maestro filter set. In the Filter/Wavelength Selection group, select the “Blue (500 : 10 : 720)” filter set from the drop down box. This automatically populates the Start, Step, and End wavelength settings.

7. Switch off the interior white lights by clearing the Turn On Illumination check box or pushing the INTERIOR ILLUMINATION button on the system control panel.

8. Check the Open Shutter check box to open the shutter and allow excitation light into the chamber. The stage should now be illuminated with blue light. (You can open the door of the system to verify this.)

9. In the Wavelength and Exposure group, click the Autoexpose Cube button to automatically calculate the exposure settings for the image cube.

10. To acquire an image cube, click the Acquire Cube button at the bottom of the Fluorescence panel.

11. When the system has finished taking the image cube, a color representation of the cube will be displayed.

12. Click the Save Cube button on the toolbar to save the new image cube. In the Save Cube dialog box, select a location and name for the image cube and click the Save button. For this exercise, name the cube: “qdotcard.”

13. You are now ready to unmix the fluorescence signals from the autofluorescence in the image cube.
**Unmixing the Image Cube**

1. Maximize the Cube window by clicking its maximize button.

2. Select the **Spectra** tab.

3. Sample the autofluorescence signal:
   
   a. Click the **Draw** button in the last row of the color palette and use the mouse pointer to sample (by clicking and drawing a line through) an area of autofluorescence on the business card (see Figure 22).
   
   b. A check mark appears in the **Select** box for row #10. In the **Name** column, change this spectrum’s name from “C10” to “Paper.”

4. Sample the 605 nm fluorescence plus the paper signal using the Blue color marker:
   
   a. Click the **Draw** button in row #3 and sample an area (by drawing a line) within the 605 nm QDot spot. This is the dot on the far-right side (see Figure 22).
   
   b. In the **Name** column of the color palette, rename this mixed spectrum from “C3” to “Q605+Paper.”

5. In row #4, use the Yellow color marker to sample the QDot spot that contains the 565 nm fluorescence plus the paper. This is the dot on the far-left side. Name this mixed spectrum “Q565+Paper.” Your work area should look similar to Figure 22.

![Figure 22. Image Cube with Sampled Spectra](image-url)
Note: Notice the overlapping spectra in the spectral graph at the top of the Spectra panel.

Calculating the Pure Spectra


2. Remove the autofluorescence from the 605 nm QDot signal:
   a. In the Known Spectrum group, click the white Paper color marker.
   b. In the Mixed Spectrum group, click the blue Q605+Paper color marker.
   c. In the Computed Spectrum group, make sure “Scale To Max” is selected in the Scaling drop down box.
   d. You will see the mixed spectrum in blue and the computed spectrum in red, which is the color selected in the drop down box at the bottom of this dialog box. The dotted “best fit” line is a scaled representation of the known (autofluorescence) signal.
   e. To obtain an accurate pure spectrum (required for an accurate unmixing), you must subtract the correct amount of autofluorescence from the mixed spectrum. To do this, it is important that the non-overlapping regions between the “pure” fluorophore and the autofluorescence line up closely. To do this:
      - First, try sliding the Error Scaler until the spectra are aligned as closely as possible. (The Scale option is discussed further in “Error Scaling When Manually Computing Spectra” on page 75.) Yours should look similar to the plot shown in Figure 23.
      - If the non-overlapping regions do not line up closely using scaling, try clearing the Scale check box and observe the results.
      - The computed spectrum should look like a simple gaussian curve, which is the shape of accurate quantum dot spectra. The “wings” on either side in the original mixed spectrum, which are due to the contribution of the paper autofluorescence, have been removed.
f. At the bottom, change the name of the computed spectrum from “C1” to “Pure Q605.”

g. Click the Transfer to Library button. You will see the new selection added to row #1 of the color palette.

3. Remove the autofluorescence from the 565 nm QDot signal:
   a. In the Known Spectrum group, the white Paper color marker should still be selected.
   b. In the Mixed Spectrum group, click the yellow Q565+Paper color marker.
   c. If necessary, adjust the Error Scaler or turn scaling off to accurately compute this spectrum.
   d. At the bottom, change the name from “C2” to “Pure Q565.”
   e. Click the Transfer to Library button.

4. Close the Manual Compute Spectra dialog box. Notice that the check boxes in the Select column for each of the mixed signals were automatically cleared when you added the pure spectra selections to the color palette.

5. Now you are ready to unmix the image and compute the pure spectra.

**Unmixing the Image**

1. Make sure only the Paper, Q605, Q565 color markers are selected in the color palette.

2. Click the Unmix button at the bottom of the Spectra panel.

3. The software calculates and displays images for the pure fluorescence (QDot) signals and the autofluorescence (paper) signal. A new set of images appears in the image gallery.
Figure 24. Grayscale and Composite Images

Figure 24 shows the grayscale images of each signal, as well as a new composite color image created using the colors you selected.

- The original image (cube) is shown at the top left.
- An RGB color-composite image of the pure signals is shown in the top right.
- Images representing each of the pure signals are shown across the bottom in grayscale. Their window borders are color-coded to correspond to the colors you selected earlier.

Tip: Check for how well you built the spectral library. Select Tools > Show Error Images. The images that display should contain mostly “background noise” with no bright signals present. This indicates that the Maestro software correctly unmixed all the cube’s spectra. See also “Checking Your Spectral Library” on page 78.

4. Save the current protocol, if desired. Select File > Save Protocol. Select a location and enter a name such as “qdotcard” for this example.

Protocols save cube acquisition settings, the current spectral library, and the current hardware settings so you don’t have to set them again each time you unmix or analyze a similar specimen.
Method development is a fundamental component of any good experiment, and building spectral libraries is a key part of method development. This chapter discusses methods for building accurate and reliable spectral libraries. We will explain how to create and save libraries using a variety of sample specimens, and we will discuss their unique characteristics. “Chapter 6, Unmixing Spectral Images” discusses how to open libraries and use them to unmix images.

If you are new to the Maestro 2 *in vivo* imaging system and have not already familiarized yourself with the rest of this manual, we suggest that you do so now. Then return to this chapter for further study.

**Topics in this chapter:**

- Methods for Building Spectral Libraries ................................................. 40
- Saving Spectral Libraries ........................................................................ 43
- Saving Protocols ................................................................................... 43
- Importing Spectra Into a Library ......................................................... 44
- Practice Exercise .................................................................................. 46
Methods for Building Spectral Libraries

You should create a spectral library for each of your experiments or series of experiments. Acquire or open the image cube you want to use to create the library. “Chapter 5, Acquiring Spectral Images” describes in detail how to acquire image cubes of your specimens.

There are a number of ways to build a spectral library. A few examples include:

- Using the **Real Component Analysis (RCA)** feature to automatically compute and unmix spectra (see “Computing and Unmixing Spectra Automatically” on page 71 for detailed instructions). This process adds spectra to the library, which you can modify as needed and then save.

- Using the **Manual Compute Spectra** feature, which lets you specifically sample spectral signatures from images and save them in a library (see “Computing and Unmixing Spectra Manually” on page 73 for detailed instructions). If you completed the exercise in Chapter 3, then you are already familiar with manually computing pure spectra.

- Adding spectra from other libraries, component images, or composite images of the same or similar specimens (see “Importing Spectra Into a Library” on page 44).

- Also, depending on the nature of your experiment and the types of dyes or fluorophores used, you may have imaged a single animal or two animals from which you will obtain the positive and negative controls. Use negative controls for the autofluorescence spectrum; use positive controls for “pure” spectrum calculations.

After building the library, save it as described in “Saving Spectral Libraries” on page 43.

**Tips for Spectral Library Development**

- There is no substitute for proper controls. Use negative controls and/or subjects that do not contain exogenous fluorophores for determining autofluorescence spectra. Use positive controls for determining the spectra of fluorophores of interest, using one or more animals for each fluorophore.

- The computed pure spectrum should be similar to, but not necessarily the same as, published spectra of that fluorophore. Variations in the label’s physical environment or depth within tissue can cause spectral shifts.

- Verify that your libraries work correctly by testing them on a few positive and negative controls. Use critical judgement during this evaluation.

- Unmix into white or pink for autofluorescence. Unmix into red, green and/or blue for fluorophores of interest. This will give you a nice outline of the mouse with colors superimposed.

- If you want to make a fluorophore or autofluorescence “disappear,” assign it to the black channel or simply turn the layer off in the **Display Control**.

- Make sure you save the library for later use.
Obtaining Autofluorescence and Label Spectra from a Single Animal

In this example (sample courtesy of Dr. Shuming Nie, Emory University), use Real Component Analysis to unmix the label spectra from the autofluorescence. In this instance, a single mouse can be used because the dye is limited to the immediate area of the tumor. (This dataset can be found in the Maestro sample data folder: C:\Maestro Data\Sample Data\qd food mous)

![Image of Maestro software interface with a mouse model and manually drawn regions]

**Figure 25. Autofluorescence and Label Spectra from a Single Sample**

**Notes:**

- In this example, the autofluorescence signal is named “autofluore” and the fluorescence signal is named “630nm dye.”

- After unmixing this cube, zoom in on the *qd rca_630nm dye* component image and use the manual Draw tool on the Measure panel to draw a measurement region around the tumor. Copy the region (right-click on the region and select Clone Region) and move the copies to other locations within the image to compare fluorescence signals.

- As you can see from the Measurements data page at the bottom of the screen, the area of the tumor (Region #1), where specific binding has occurred, fluoresces the brightest with a Total Signal of 366 counts. Region #2, which represents a dimmer region of q-dot binding in the tumor, also fluoresces, but not as brightly, with 261 counts. Region #3 (away from the tumors) shows almost no fluorescence with only 0.324 counts.
Obtaining Autofluorescence and Label Spectra from Two Animals

In this example, the upper mouse was injected with Alexa Fluor™ 680, which dispersed throughout the mouse’s body. The lower mouse is an un.injected “negative” control. Due to the presence of the dye everywhere in the mouse, the use of an un.injected mouse was necessary in order to obtain a representative autofluorescence signal.

Using Manual Compute Spectra, obtain the autofluorescence signal from the negative control mouse and a mixed Alexa Fluor 680 plus autofluorescence (yellow green, not shown) from the area of the injected mouse that fluoresces brightly. (Ensure that the signals in the selected regions are not saturated). The red AF680 spectrum was computed using the white “autofluore” spectrum and the yellow “mixed” spectrum.

Figure 26. Autofluorescence and Label Spectra from Two Animals

Notes:

- In this example, the autofluorescence signal is named “autofluore” and the fluorescence signal is named “AF680.”

- After unmixing this cube, zoom in on the alexa 680 in mouse t2 component image and use the manual Draw tool on the Measure panel to draw a measurement region around the tumor. Copy the region (right-click on the region and select Clone Region) and move the copies to other locations within the image to compare fluorescence signals.

- Observe the Measurements data page at the bottom of the screen. The area of the tumor (Region #1), where specific binding has occurred, fluoresces the brightest with a Total Signal of 641,752. (This is the region’s relative measure of fluorescence.)

- Region #2 represents an area of non-specific binding and exhibits a bright fluorescence signal as well. Region #3 represents the signal from a mouse with no added fluorophore. Notice the much lower relative measure of fluorescence.
Saving Spectral Libraries

By saving your spectral libraries, you make them available for use again later when performing analyses on similar specimens. Instead of just saving the library, you could also save the Maestro protocol, which saves all of the Maestro acquisition and analysis settings (see “Saving Protocols” for how to save protocols.)

To save the current spectral library:

2. Navigate to the folder where you want to save the spectral library and type a name in the File Name field.
3. Make sure “Spectral Libraries (*.csl)” is selected in the Save as type box and click the Save button.

If you want to save the library as a text file, then select the “Text Files (*.txt)” option instead. This format cannot save color or hardware settings, but it can be opened in other applications. For example, these text files could be opened in Microsoft® Excel® for graphing, etc.

Saving Protocols

The Maestro software saves its settings in protocols. Protocols are recipes for collecting and measuring data, and contain the following information:

- acquisition settings including region of interest and binning, wavelength settings, filter selections, exposure times, and hardware settings (bit depth, stage height, etc.)
- associated spectral library
- auto save options
- measurements options including threshold level and minimum connected pixels

Whenever you make changes to any hardware settings or acquisition settings, or edit the current spectral library, save those settings in the current protocol or create a new one. By saving your protocols, you make them available for use again later when acquiring image cubes of similar specimens.
To save a protocol:
2. In the Choose Protocol dialog box, select the name of an existing protocol if you want to overwrite it, or enter a new name in the File Name field.
3. Click Save to save the protocol.
4. Notice that the new protocol name appears in the Protocol drop down box on the status bar. If other protocols were loaded during the current session of Maestro, you can select and re-load them from the Protocol drop down box.

Note: When you exit the Maestro software, you will be prompted to save the current protocol if you have changed any hardware or software settings during the current session. Be sure to save the protocol if you want to use the new settings again.

Importing Spectra Into a Library

From an Existing Library

You can import individual spectra from other libraries.

Note: The spectral range and spectral spacing parameters of the library must be the same as current loaded spectral cube data.

1. Click the Import Spectra From Library button on the Spectra panel.
2. The Choose Spectral Library dialog box will prompt for the file name of a spectral library. Spectral libraries have a .csl file name extension. Spectral libraries from older versions of the software with *.txt file extensions may also be opened.
3. Double-click the name of the library to open it.
4. The Import Spectra From Library dialog box opens. It lists all the spectra stored in the selected library.
5. Make sure there is a check-mark in the Select column next to each spectrum you want to import. Select a Location Number and click the Transfer to Library button.
6. If you want to load spectra from another library, click the Load button and select another library to load. The Clear Current Library button removes all spectra from the current library (same as the Clear All button on the Spectra panel).
7. Click Close when finished importing spectra.
From a Saved Component Image

You can import spectra from component images.

1. Open the Result Set (.umx) file that includes the component image from which you want to import spectra.

2. Right-click on the component image and select Import Spectra from the pop-up menu.

3. The Import Spectra From Library dialog box (Figure 27) opens with the spectrum used to unmix the cube into that component.

4. Make sure there is a check-mark in the Select column next to each spectrum you want to import, then click the Transfer to Library button.

5. If you want to load spectra from another library, click the Load button and select a library to load. The Clear Current Library button removes all spectra from the current library (same as the Clear All button on the Spectra panel).

6. Click Close when finished importing spectra.

From a Saved Composite Image

You can import spectra from composite images.

1. Open the Result Set (.umx) file that includes the composite image from which you want to import spectra.

2. Right-click on the composite image and select Import Spectra from the pop-up menu.

3. The Import Spectra From Library dialog box (Figure 27) opens with all the spectra used to unmix the cube.

4. Make sure there is a check-mark in the Select column next to each spectrum you want to import, then click the Transfer to Library button.

5. If you want to load spectra from another library, click the Load button and select a library to load. The Clear Current Library button removes all spectra from the current library (same as the Clear All button on the Spectra panel).

6. Click Close when finished importing spectra.
Practice Exercise

In this exercise you will open and analyze an image cube representing a mouse with a quantum dot-labeled tumor. This exercise represents the common problem of a tumor signal that is difficult to see due to the presence of autofluorescence. We will resolve this problem using Maestro multispectral imaging. (The sample is courtesy of Dr. Shuming Nie, Emory University.)

1. To open the sample image cube of the mouse with the quantum dot-labeled tumor, click the **Load Cube** button and navigate to the Maestro sample data folder: C:\Maestro Data\Sample Data\Q dot mouse\Q dot mouse stack.

2. Select any one of the TIFF files and click the **Open** button to open the image cube.

Opening the “Q dot mouse stack” image cube reveals a mouse with a dimly labeled tumor (you may be able to see the quantum dot glow in the left animal, near its intestines) and relatively abundant autofluorescence.

**Note:** In the image, the mouse on the left was injected with an antibody labeled with a 630 nm quantum dot. The mouse on the right received no injection.

3. Use RCA to unmix the cube:
   a. Click the **Real Component Analysis (RCA)** button on the **Spectra** panel.
   b. Click the **Sample Spectrum** button and use the mouse pointer to sample the autofluorescence of the right (negative control) mouse. The **Use selected background spectrum** check box is now checked.
   c. Click the **Find Component Images** button.

![Figure 28. Unmixing with Real Component Analysis (RCA)](image)
**d.** In the **Component Images** group, click the upper left image twice to select it as the background. Use the pop-up color selector to set its pseudo color to white.

**e.** Click once on the image that shows the quantum dot-labeled tumor. Set its pseudo color to red (see Figure 28). Its name will default to “Signal_3.”

**f.** The image to the right of the red quantum dot image shows the food autofluorescence in the non-fasted control mouse. Click once on this image to obtain its spectrum. Its name will default to “Signal_4.”

**g.** Click the **Find Spectra** button. The computed spectra will display on the graph and appear in the color palette. If desired, rename “User” to “autofluorescence”. Rename “Signal_3” to something more descriptive like “q-dot signal.” Rename “Signal_4” to “food signal” or something similar. Your screen should look similar to Figure 28.

**h.** Click **Transfer to Library, Unmix and Close**.

**i.** The Maestro software unmixes the cube and displays the component and composite images in the image gallery (Figure 29).

---

**Figure 29. Images Showing Pure Unmixed Signals**

4. The spectral signals in the cube are now unmixed. Use the region drawing tools on the **Measure** panel to quantify the signal strength of the quantum dot-labeled tumor vs. areas where non-specific binding has occurred.

**a.** Switch to the **Measure** panel and click the **Draw** button.
b. Draw a region around the tumor, which represents specific binding of the label, shown here as region #1. (Refer to “Manually Drawing and Modifying Regions” on page 91 for help drawing regions.)

**Note:** In this example, the mouse on the left was injected with a quantum-dot-labeled antibody and was fasted for three days prior to imaging. By contrast, the mouse on the right was not injected with the antibody and was not fasted. The thigh of the left mouse exhibits specific binding of the antibody (region #1); the rest of the mouse’s skin exhibits non-specific quantum dot fluorescence. The right mouse exhibits no quantum dot fluorescence. Conversely, the left mouse exhibits no food-related autofluorescence signal due to having been fasted, while the right mouse exhibits food autofluorescence in the region of its stomach.

c. Right-click on the new region and select **Clone Region** from the pop-up menu. Drag the clone to another region of the same mouse to measure the strength of non-specific binding. The **Measurements** of region #2 shows that the signal strength in this region is only a fraction of that of region #1.

d. You can clone the region again and drag this clone to a region within the negative control mouse. Viewing the **Measurements** of region #3 confirms that there is no label present in the negative control mouse.

---

This chapter explains how to acquire an image cube using the cube acquisition functions on the Acquire panel. Once you have specified cube acquisition settings for a particular type of specimen, save the Maestro protocol for repeated use throughout the experiment with the same or similar specimens.

Topics in this chapter:  
- Tips for Obtaining Quantitative Results ............................................................ 50  
- Acquiring Images Using a Saved Maestro Protocol ............................................. 50  
- Viewing a Live Image Stream ........................................................................... 51  
- Camera Binning, Zoom, and Region of Interest ................................................ 51  
- Specifying the Current Wavelength and Exposure ............................................ 52  
- Making a Filter/Wavelength Selection ................................................................ 55  
- Acquisition Setup Using Multiple Filters .......................................................... 57  
- Taking a Reference Image for Flat Fielding ....................................................... 59  
- Acquiring a Mono Image (Snapshot) ................................................................. 59  
- Acquiring a Fluorescence Image Cube .............................................................. 59  
- Acquiring Low-Light Images ............................................................................ 60  
- Assigning Sample IDs and Notes ..................................................................... 64  
- Acquiring Timed Sequences of Image Cubes .................................................... 64  
- Saving Images and Image Cubes ...................................................................... 65  
- Viewing Cube Information ................................................................................ 67  
- Extracting an Image Plane from a Cube ............................................................ 67
Tips for Obtaining Quantitative Results

- Maestro protocols are recipes for collecting and measuring data. Whenever possible, you should acquire image cubes using protocols that have been saved and validated with your Maestro 2 in vivo imaging system for each of your specimens/experiments. (Protocols are discussed in detail in “Saving Protocols” on page 43.)
- Set up all hardware identically each time you acquire images during the course of an experiment. Select the same f-stop and filter set.
- Orient the mouse (or mice) similarly. Use the Live Image Overlay feature, as described in “Live Overlay” on page 99.
- Use one spectral library for unmixing all datasets.
- Make sure you’ve done control samples first!
- Save resulting images as “Unscaled Data” so they can be exported to other quantitation software, if desired.

Acquiring Images Using a Saved Maestro Protocol

Maestro protocols are recipes for collecting and measuring data. By using a saved protocol to acquire images of similar specimens throughout an experiment, you don’t have to specify acquisition settings every time. This helps ensure consistency throughout the experiment.

If a protocol has already been saved, tested, and validated for the type of specimen/cube you want to acquire, load the protocol first, then acquire the cube using the settings from the protocol.

**Note:** Be aware that using a protocol from one specimen to acquire an image of a specimen that contains different fluorophores will lead to incorrect results.

**To open a protocol:**

**Tip:** The Protocol drop down box on the status bar lists all protocols that were opened during the current Maestro session. If the desired protocol was opened earlier, select it from this list. Otherwise, use the following method.

2. Maestro may ask if you want to save the current protocol if one is open and changes have been made.
3. In the Choose Protocol dialog box, select the protocol you want to open and click Open.

**Tip:** You can also open a Maestro protocol by double-clicking the protocol (*.pro) file in a My Computer directory window. If Maestro is not already open, this action will open Maestro with the selected protocol. You can also drag a protocol file and drop it into an open Maestro window to open the protocol.
4. Maestro now contains all the settings of the selected protocol including the last saved exposure and wavelength.

**Viewing a Live Image Stream**

The frame rate of the live image varies according to the set exposure time. If you see an all black image, the exposure setting is probably too low. Also, make sure either the interior lights or the excitation light source is turned on and the shutter is open.

Saturated pixels appear red in the live image. If some or all of the image is solid red, the image is saturated. The exposure setting is probably too high. Also, make sure the door of the specimen chamber is closed tight.

**To view a live image:**
1. Switch to the Fluorescence acquire panel. The Live Stream window opens automatically. (If you closed the Live Stream window, click the Live button.)
2. Click the Autoexpose Mono button to automatically adjust the exposure time to the best setting for the current wavelength. If you still cannot see the live image, try increasing or decreasing the current Wavelength at which you are trying to view the image. Then autoexpose the live image again at the new wavelength.
3. Fine-tune the focus if necessary by using the external focus knob or the Focus slider.

**To apply a live image overlay:**
When quantitative results are needed, use the Live Image Overlay feature to help you orient the current specimen as when it was previously imaged. Open the image you want to use as an overlay. Then right-click the image and select Set As Live Image Overlay. See also “Live Overlay” on page 99.

**To freeze the live image:**
Click the Live button a second time. The image in the Live Stream window remains frozen until you click the Live button again.

**Camera Binning, Zoom, and Region of Interest**

Binning combines multiple pixels into a single pixel. Higher binning reduces exposure time and image size but results in a lower resolution image. There are three camera binning options in the Binning selector. The default setting is 2-pixel (2x2) binning.

![Binning And Region Of Interest](image)

*Figure 30. Region Of Interest And Binning Selectors*
To set camera binning:
Select one of the following:

- If you want no binning, for maximum image resolution and size, select the 1x1 binning option.
- 2x2 binning combines each 2x2 square of pixels into one pixel. This reduces the resolution in each direction by a factor of 2 and requires 1/4th the exposure time.
- 4x4 binning combines each 4x4 square of pixels into one pixel. This reduces the resolution in each direction by a factor of 4 and requires 1/16th the exposure time.

To zoom in on the image:
Select a Maximum Sample Size from the drop down box. Selecting a smaller sample area increases the zoom level.

To select a region of interest:
The ROI (Region of Interest) selector sets the imaging area, which may be set to include all or just a portion of the entire field of view. The active area is always centered, and there are five ROI options in the ROI selector. Four options are predefined, and one is user-definable. The default setting is Full-frame.

Do one of the following:

- To capture the Full-frame, 2/3-frame, 1/2-frame, or 1/3-frame, select from the predefined options.
- To select a custom region of interest, select “Custom” and use the mouse pointer to draw an ROI box within the Live Stream window. You can also create a custom region of interest by selecting Hardware > Set Custom Camera ROI.

Specifying the Current Wavelength and Exposure

The Wavelength And Exposure boxes are used to manually adjust the current Wavelength in nanometers (nm) and the Exposure in milliseconds (ms).

Adjusting the Current Wavelength

Depending on the expected wavelength of the emission light, you may need to adjust the current wavelength for the filter being used. The Wavelength (nm) box is used to set the wavelength in nanometers for manual control of the live camera view.

To manually set the current wavelength:
Do one of the following:

- Drag the slider to the desired wavelength. The slider snaps to the wavelength intervals set in the acquisition settings. As shown in Figure 31, the wavelength slider indicates the current filter range. The highlighted region on the slider represents the acquisition wavelength range. The colors on the slider approximate how we would see the wavelengths within the range.
• Type a value or use the up/down scrollers in the **Wavelength** text box. When typing a value, you can set the wavelength in 1 nm increments. The up/down scrollers snap to 10 nm intervals.

![Wavelength and Exposure](image)

*Figure 31. Wavelength and Exposure*

**Adjusting the Exposure Time (Autoexpose)**

Use the autoexposure buttons to automatically determine the correct exposure setting, or manually enter a value (in milliseconds) in the **Exposure** entry field. You can also use the **Custom Wavelengths And Exposures** option. This option is enabled only if custom collection settings have already been specified. (See “Specifying Custom Wavelength and Exposure Settings”.)

**To autoexpose at the current wavelength:**

Click the **Autoexpose Mono** button. Maestro will calculate the best exposure time for the current wavelength and display the value in the **Exposure** text box.

**To autoexpose a cube:**

1. Before you acquire an image cube, click the **Autoexpose Cube** button.
2. Maestro will calculate the exposure time(s) that should be used to acquire an image cube of the specimen. The value will display in the **Exposure** text box.

**To manually enter an exposure time:**

Type an exposure value into the **Exposure (ms)** text box or use the scrollers to increase or decrease the current value in increments of one millisecond. As you change the exposure setting, you will see the live image become brighter or darker.

**Note:** Be careful not to overexpose or underexpose your specimen. Doing so may result in loss of valuable data, which will affect spectral classification or unmixing operations later.

If you are using the multiple filter feature (see “Acquisition Setup Using Multiple Filters” on page 57), you can enter a different exposure time for each filter in the sequence. Select
the first filter letter (“A”) in the **Multi Filter Support** drop down box and enter an exposure time in the **Exposure (ms)** box. Repeat for each filter in the multi filter sequence.

**To use custom wavelengths and exposures:**

If you have specified the custom settings, select the **Custom Wavelengths And Exposures** check box. You may now acquire the cube using the custom collection settings.

### Specifying Custom Wavelength and Exposure Settings

Custom wavelength and exposure settings let you use unevenly spaced wavelength settings and varying exposure times to acquire an image cube. You can specify new settings and save them, or you can load a saved wavelength and exposure table.

**To specify custom wavelength and exposure settings:**

1. Select **Hardware > Edit Hardware Settings** (or press Ctrl+H) to reveal its dialog box.
2. Click the **Fluorescence Custom** tab.
3. The **Wavelength/Exposure** table defaults to the acquisition settings of the currently selected presets.
4. To change the defaults, specify new **Start/End Wavelengths** and **Step** interval using the drop down boxes in the **Fill Wavelengths** area below the table.
5. Specify the exposure **Time (milliseconds)** in the **Fill Exposures** box.
6. Return to the **Wavelength/Exposure** table and edit individual settings as necessary.
7. Click **Save** to save the settings and close the dialog box.
8. On the **Fluorescence** panel, select the **Use Custom Wavelengths And Exposures** option to use the custom collection settings to acquire the image cube. (All fields in the **Cube Wavelength Selection** group become disabled.)

**To save custom collection settings as a table to load again later:**

1. After specifying custom collection settings, click the **Save** button. The **Choose Custom Table** dialog box opens.
2. Specify a directory and filename and click **Save** to save the new wavelength and exposure table.

**To load a wavelength and exposure table:**

1. Click the **Load** button on the **Fluorescence Custom** tab. The **Choose Custom Table** dialog box opens.
2. Locate the table you want to load and click **Open**. The collection settings appear in the **Wavelength/Exposure** table. Click **OK** to use the custom settings.
Making a Filter/Wavelength Selection

Maestro 2 systems come with a full complement of excitation and emission filters. Filter settings define the wavelengths for which the filters are tuned when acquiring image cubes. The Filter/Wavelength Selection group (shown below) has preset acquisition settings as well as entry fields for entering acquisition settings manually.

![Filter/Wavelength Selection](image)

Figure 32. Filter/Wavelength Selection

Using Predefined Filter Settings

The drop down box with predefined filters offers fixed filter names and their corresponding acquisition wavelengths. For example, the “Blue (500 : 10 : 720)” filter’s starting wavelength is 500 nm, the ending wavelength is 720 nm, and images are acquired in steps of 10 nm.

To select a predefined filter set:

Select an option from the drop down box. The wavelength setting for the Live image autoadjusts to within the wavelength range of the current filter selection.

The table identifies the predefined filter setting names and their associated excitation/emission wavelengths and acquisition settings.

<table>
<thead>
<tr>
<th>Maestro Filter Setting Name</th>
<th>Excitation Filter (Range)</th>
<th>Emission Filter</th>
<th>Acquisition Settings*</th>
</tr>
</thead>
<tbody>
<tr>
<td>White</td>
<td>Neutral attenuator</td>
<td>Transparent glass filter</td>
<td>500 to 800 in 10 nm steps</td>
</tr>
<tr>
<td>Blue</td>
<td>455 nm (435 to 480 nm)</td>
<td>490 nm longpass</td>
<td>500 to 720 in 10 nm steps</td>
</tr>
<tr>
<td>Green</td>
<td>523 nm (503 to 548 nm)</td>
<td>560 nm longpass</td>
<td>560 to 750 in 10 nm steps</td>
</tr>
<tr>
<td>Yellow</td>
<td>595 nm (576 to 621 nm)</td>
<td>635 nm longpass</td>
<td>630 to 800 in 10 nm steps</td>
</tr>
<tr>
<td>Orange</td>
<td>605 nm (586 to 601 nm)</td>
<td>645 nm longpass</td>
<td>640 to 820 in 10 nm steps</td>
</tr>
<tr>
<td>Red</td>
<td>635 nm (616 to 661 nm)</td>
<td>675 nm longpass</td>
<td>670 to 900 in 10 nm steps</td>
</tr>
<tr>
<td>Deep Red</td>
<td>661 nm (641 to 681 nm)</td>
<td>700 nm longpass</td>
<td>700 to 950 in 10 nm steps</td>
</tr>
<tr>
<td>NIR</td>
<td>704 nm (684 to 729 nm)</td>
<td>745 nm longpass</td>
<td>740 to 950 in 10 nm steps</td>
</tr>
</tbody>
</table>

* The ending wavelength can always be made longer if there is fluorescence beyond the suggested end point.

Changing Wavelength Settings

If you don’t see the filter settings you want in the presets drop down box, you can edit the current values in the Start, Step, and End wavelength text boxes. When you edit any of these values, a new “Unnamed” filter setting is automatically created using the new manual settings.
Narrow Bandwidth Acquisition

Narrow mode can help you resolve closely spaced and overlapping emission spectra. It can increase the number of fluorophores to quantitate more markers. Narrow mode can also improve the dynamic range of co-localized spectra. (See also, “Narrow Bandwidth Acquisition” on page 8.) Select the Narrow check box in the Fluorescence panel.

Customizing the Preset Filter Settings

Select Hardware > Edit Hardware Settings (or press Ctrl+H) to reveal its dialog box. Click the Filters tab. (Filter settings that you enter and save here become available for use in your Maestro 2 acquisition protocols.)

The Excitation and Emission boxes in the lower half of the dialog box are for display only and cannot be edited. These boxes list all filters that are currently installed in your Maestro 2 system. (For instructions on adding or replacing filters, see “Replacing Emission and Excitation Filters” on page 19.) By clicking on the filter names in these boxes, you can view their midpoint- and cut on- wavelengths, bandwidth, notes, and so on.

The Filter Setting Properties box is used to edit and create combinations of excitation and emission filters for cube acquisition. Items listed here appear in the drop down list of predefined filters (Blue, Green, Yellow, etc.) on the Acquire panels.

The Restore Factory Defaults button returns all filter settings to the factory defaults. This includes restoring all deleted filter setting names. It also removes any filter setting names you have created and saved.

To edit predefined wavelength ranges:

In the Filter Setting Properties list, select the name of the setting you want to edit. Next, make any necessary changes to the wavelengths in the Cube Wavelengths box. If desired, you can add or modify the description of the setting properties. Also choose whether you want this setting to be available on the Fluorescence or Low Light acquisition tab, or both.

To delete a filter setting name:

Select the setting name that you want to delete. Click the Delete button. The deleted setting is removed and will no longer appear on the Fluorescence acquisition panel. (This action does not remove filters from the system, it only removes acquisition settings.)

To add a new setting name:

This action is usually performed after installing a new pair of excitation and emission filters (see “Replacing Emission and Excitation Filters” on page 19 for instructions).

To add a new setting name, first select a compatible pair of filters from the Excitation and Emission filter lists. Then click the Add button. Enter the new Filter Setting Name and enter a Description if desired. Designate this setting for fluorescence or low-light imaging (or both).
Acquisition Setup Using Multiple Filters

The Maestro 2 system offers a **Multi Filter Support** feature that lets you acquire a cube while employing two or more filter sets. For example, if you wanted to acquire an image cube that includes the acquisition wavelengths of the blue filter set (500 nm to 720 nm) as well as the deep red filter set (700 nm to 950 nm), then you could use this feature. The acquisition wavelengths of the different filter sets may overlap, but wavelength overlap is not required.

**Note:** There is no need to select and use the **Multi Filter Support** option when acquiring image cubes that require a single filter set.

While different exposure times can be assigned to each filter set in a multi-filter acquisition, the following parameters must be the same for all filter sets. Any changes you make to these parameters apply to all the filter sets you may have selected.

- Camera ROI
- Camera binning
- Camera bit depth
- Camera gain

**To configure multiple filter sets:**

1. Click the **Add** button in the **Multi Filter Support** group. When the **Add Filter** dialog box appears, select a filter set to add. Click **OK** to add the filter set to the list of acquisition filters.

2. If you want to use a third filter set, click the **Add** button again and select the third filter set to add to the acquisition list. Repeat this process for each filter set you want to use for the multi filter acquisition.
   - If you want to remove a filter set from the list, select it in the **Multi Acq.** drop down box and click the **Remove** button. The remaining filters will move up in the sequence.
   - If you want to autoexpose or acquire a cube using just one of the filter sets in your multi acquisition list, select the letter of the filter you want to use (“A,” “B,” etc.) and clear the **Multi Acq** check box. The selected filter will be used. (See also “Saving Many Filter Protocols in One Maestro Protocol” on page 58.)

3. Save this protocol if it will be used again later (see “Saving Protocols” on page 43).

4. When you are ready to autoexpose and/or acquire the cube using multiple filters, select the **Multi Acq** check box. Then click the **Autoexpose Cube** and/or the **Acquire Cube**.
button. During multi-filter autoexposure and acquisition, the Maestro 2 system automatically switches to the next filter set in the sequence according to the filter set line-up you created.

**Maintaining Compatible Exposure Time Ratios**

When you open a Maestro protocol that includes multiple filters and a multi-filter spectral library, the ratios of the exposure times between the filter sets used for current cube acquisition and those of the saved spectral library must remain consistent. Using a library with an incompatible ratio of exposure times to unmix a new image cube may lead to erroneous results.

When using a saved multi-filter protocol to acquire a new multi-filter cube, it is recommended not to perform any additional autoexposures of the specimen or manually change the exposure times. If changes to exposure times are required, make sure the ratios remain consistent, such as 1:1, 2:1, 3:1, etc.

If the exposure time ratios are different by 10% or more, the Maestro 2 system will warn you with an error message, similar to the one shown here.

![Figure 34. Incompatible Exposure Times](image)

**Saving Many Filter Protocols in One Maestro Protocol**

You can use the Multi Filter Support feature to save multiple filter protocols in a single Maestro protocol. This is useful when you need to take multiple cubes of a specimen using different filter sets. For example, you may want to take separate cubes of the same mouse using blue, yellow, and red filter sets. (Remember, each filter set can have a different exposure time, but all sets will have the same camera ROI, binning, bit depth, and gain.)

Follow the instructions earlier in this section to configure the filter settings (blue, yellow, and red, for example) in the multi acquisition list, and then save the protocol. When you are ready to take multiple cubes of a specimen, load the protocol that contains the
appropriate filter sets. Choose the filter set you want to use to acquire the cube, then clear the **Multi Acq** check box so only the selected filter set will be used.

**Taking a Reference Image for Flat Fielding**

Flat Fielding makes it possible for the Maestro software to create better, more evenly bright mono images and image cubes. If you acquire images or cubes without Flat Fielding, you may notice that the outer edges of acquired images are slightly darker than the rest of the image.

Flat Fielding creates more evenly bright images by taking a reference image before acquiring the image or cube. Once you have taken a reference image, it will be saved with the current Maestro protocol, if you save the protocol. However, if you change the binning or region of interest (ROI), the current reference image becomes invalid. You will have to take a new reference image before acquiring an image or cube with new binning or ROI.

1. Select the **Flat Field** check box. This activates the **Acquire Ref. Image** button and disables the **Acquire Mono** and **Acquire Cube** buttons until you acquire the reference image.

![Figure 35. Flat Fielding](image)

2. Remove the specimen from the chamber and replace it with a stack of about ten sheets of clean white paper.

3. Click the **Acquire Ref. Image** button.

4. After acquiring the reference image, the **Acquire Mono** and **Acquire Cube** buttons are available again. Replace the paper, move your specimen back into position, **Autoexpose** the live image, and then acquire your image.

**Acquiring a Mono Image (Snapshot)**

To take a snapshot of the current live image at the current wavelength and exposure, click the **Acquire Mono** button. This function acquires a single picture, not an image cube.

**Acquiring a Fluorescence Image Cube**

1. Autoexpose the cube as described in “Adjusting the Exposure Time (Autoexpose)” on page 53.

2. If you are satisfied with the wavelength and exposure settings, click the **Acquire Cube** button at the bottom of the **Fluorescence** panel to acquire the image cube.

3. When Maestro has finished taking the image cube, a color representation of the data will display in the image gallery.
Acquiring Low-Light Images

The Maestro 2 imaging system can capture and create low-light composite images that you can view and analyze in much the same way you would a fluorescent image cube. This is done by first taking an image under white lights and then taking an image in complete darkness. The system then combines these two images into a composite.

For this example of low-light acquisition, a watch with phosphorescent material on its dials and at each hour position was used to display the Maestro 2 system’s low-light capabilities.

Taking a Low-Light Image

1. Place your specimen on the stage and close the chamber door.

2. Switch to the Acquire > Low Light panel. The system automatically turns off the excitation light, closes the shutter, and switches to the Low Light filter set. (The Low Light filter set blocks the excitation light, uses a clear emission filter, and has the LCTF out of the light path.)

3. The system then autoexposes the Live image with the interior illumination (white) lights on.

4. Click the Live button if you don’t already see the Live window. Maximize this window, if desired, to make it easier to reposition the specimen. Fine-tune the focus using the external focus knob or the Focus slider.

5. Set the Binning, Max Sample Size (zoom), and ROI for this acquisition. In Figure 36, the image is zoomed to a max sample size of 1.5”x2.0”.

![Figure 36. Low Light Live Image](image-url)
6. Make sure the chamber door is closed and click the **Acquire Image** button. The system will acquire a “Posing Image” that will act as a background for the composite image. The system then acquires a “Low Light” image. Three images will display (you might need to press Ctrl+L to view all three images.)

![Low Light Composite Images](image)

- Low Light Image (lower left)
- Low Light Pose (second from left)
- Low Light Composite (upper right)

7. If the acquired images are too dark or too bright, adjust the low-light **Exposure** value accordingly, and then acquire the images again.

### Quantifying Low-Light Images

Use the measurement tools on the **Measure** panel to draw and compare measurement regions:

1. Switch to the **Measure** panel and maximize the **Low Light Image** window.

2. You can use the **Auto Calculate Threshold** feature or manually draw regions around regions of interest. For this example, **Auto Calculate Threshold** was used and then the **Threshold Level** was decreased until regions were drawn around all of the luminescent areas (see Figure 38).
By clicking the **Grow** button at the far right of the **Measurements** data tab, you can easily compare the Average Signal, Total Signal, and other measurement data for all of the regions (see Figure 39).
Enhancing Low-Light Images

Enhance the display of your low-light images by using the Display Control tool.

1. Maximize the Low Light Composite image first, then click the Display Control button on the toolbar.

2. Adjust the Contrast, Gamma, and Brightness sliders to achieve the desired display of your image. You can also use the other display control features to enhance the composite display. (See also, “Advanced Display Controls” on page 101 for more about the Display Control tool.)

Figure 40. Low Light Display Control

Saving Low-Light Images

Saving the Composite

If you want to save images in a single composite.imx file (includes the low-light pose, low-light image, and low-light composite), select the composite image and select File > Save Composite from the menu. Enter a Composite Image File name and click Save.

Saving Images as Unscaled Data

If you want to save each image as a separate file and preserve its data for later quantitative analysis, select File > Save All Images (As Unscaled Data). You will be prompted to name and save each file separately.
Assigning Sample IDs and Notes

To assign a Sample ID to an image cube

Use the Sample ID text box to assign an ID to the current cube. When you save the cube, it will be saved with its sample ID. All measurements derived from the cube’s component images will be saved with the cube’s sample ID.

Cube IDs display in the Cube ID column of the Measurements page near the bottom of the Maestro work area.

To save Notes with an Image Cube

Use the Notes text box on the Fluorescence panel to save notes with the current cube. Whenever the cube is opened, any notes previously saved with the cube will display in the Notes box.

Acquiring Timed Sequences of Image Cubes

The Maestro 2 system can acquire multiple cubes of a specimen using a timed acquisition interval that you specify. This is useful for observing changes in a specimen over a specified time span, generally no longer than thirty minutes to one hour.

1. Select Tools > Acquire Time Sequence. The Acquire Time Sequence dialog box opens (Figure 41).

2. Enter the amount of time (in seconds) that you want to elapse between the start of each cube acquisition. For example, if you enter 60 seconds and it takes 15 seconds to acquire the first cube, there will be a 45 second time lapse until the start of the next cube acquisition. Be sure to enter a time that is greater than the amount of time it will take to acquire each cube.

![Figure 41. Acquire Time Sequence](image)

3. Enter the number of cubes you want to acquire during this acquisition sequence.

4. Click the Browse button to select a destination directory where you want the Maestro software to save all the cubes acquired during the sequence.

5. Enter a base filename for all the saved cubes.
6. Click the **Acquire Cubes** button to begin the acquisition sequence. A progress indicator displays the amount of time until the next cube, the current cube number, and the total time remaining until the acquisition sequence is complete.

7. The software automatically saves each cube in the specified directory.

8. When the acquisition sequence is complete, you can locate the cubes at the destination directory and open them in Maestro 2. As seen in Figure 43, the cube filenames begin with the base name you specified and include the date and time of acquisition.

---

**Figure 42. Timed Sequence Progress**

---

**Figure 43. Cubes acquired during timed acquisition**

---

### Saving Images and Image Cubes

**Tip:** Devise a consistent naming convention for your images and image cubes. Use file and folder names that incorporate specimen names as well as dates and/or times and acquisition parameters such as filter cube, binning and exposure.

To save an image cube:

1. To save the current image(s) and associated data, click the **Save Cube** button on the toolbar, or select **File > Save Cube**. The **Choose Cube** dialog box opens.

2. Navigate to where you want to save the cube.

3. In the **Save as type** box, select a cube type option:
   - Select “Image Cubes” if you want to save the cube as a CRi image cube. A CRi cube includes hardware settings, spectral libraries, user comments, and display settings. Cubes saved in the CRi format cannot be opened in third-party tools.
   - Select “Image Cubes (with Lossless Compression)” if you want to save the cube as a compressed or “zipped” file. Lossless compression saves disk space but also takes longer to save the cube.
   - Select “TIFF Cubes” if you want to save the cube as a series of TIFF images. Maestro saves a TIFF image in the specified location for each of the wavelengths used to acquire the cube. When saving a cube that was acquired using multiple filters, filename_A_* will be used for the first filter set, filename_B_* will be
used for the second filter set, and so on. TIFF Cubes contain only images; none of the associated data or settings is saved with this format.

4. Enter a file name for the cube and click the Save button.

To save images:

1. Select File > Save Image and select a save option to save the image(s):
   - Save (As Displayed) prompts you to enter a name for the currently selected image, and saves the image as a TIFF or JPEG image.
   - Save All (As Displayed) prompts you to enter a name for each of the current images in the image gallery, and saves the images as TIFF or JPEG images.

   **Note:** When you save images “as displayed,” the Maestro software saves the images as bitmap files. You cannot subsequently perform any sophisticated image processing operations on the bitmap files, since the underlying data is no longer present. Saved (as displayed) processed images can be opened in other third-party programs for morphology operations such as determining area, shapes, or for counting objects. As an alternative, you could export data as a series of TIFF files and open them in a program that can handle wavelength sequential image files.

   - Save Image (As Unscaled Data) prompts you to enter a name for the currently selected component image, and saves unscaled image data as a TIFF component.
   - Save All Images (As Unscaled Data) prompts you to enter a name for each of the component images, and saves all unscaled image data as TIFF components.

2. When the dialog box opens, navigate to where you want to save the image(s). (The default location is in C:\Maestro Data.)

3. Enter a file name and click the Save button.

**Saving Image Cubes Automatically**

The Maestro 2 system can save your image cubes automatically.

**To specify automatic save options:**

1. Select Hardware > Edit Hardware Settings (or press Ctrl+H). Click the Autosave tab.
2. Select the Autosave Image Cubes option to enable the autosave fields.
3. To specify a default directory, click the Browse button and select from the browse dialog box.
4. Type a base name in the Base Name field, if desired.
5. In the Auto-naming Options group, specify a naming option. A sample appears in the File Name box.
6. Click the OK button to save the changes and close the dialog box.
Viewing Cube Information

Cube information includes its size in pixels, the number of planes in the cube, a timestamp, any comments associated with the cube, and the wavelengths and exposure times used to generate the cube.

**To view cube info:**

Right-click on the image in the Cube window and select **Cube Info** from the pop-up menu. The Cube Info window opens.

![Figure 44. Cube Information](image)

Extracting an Image Plane from a Cube

You can extract and view individual wavelength images from a cube.

1. Right-click on the image in the Cube window and select **Extract Channel** from the pop-up menu.

2. Select the channel you want to extract by clicking a wavelength value in the list. A monochrome image of the selected wavelength opens in a new window.

![Figure 45. Extract Channel](image)
Whenever possible, spectral processing—or unmixing—of cubes should be done using established Maestro protocols. These are protocols that you have saved and validated with your Maestro 2 in vivo imaging system for each of your specimen/experiment types. In most cases, these protocols contain spectral libraries that will be used when unmixing images (as explained in “Chapter 4, Method Development”).

This chapter explains how to create a spectral library and unmix an image cube using the spectral processing functions on the Spectra panel. Once you have created your spectral library, save the protocol and library for repeated use throughout the experiment with the same or similar specimens.

**Topics in this chapter:**

- Opening a Spectral Library ................................................................. 70
- Opening an Image Cube ........................................................................ 70
- Computing and Unmixing Spectra Automatically ............................... 71
- Computing and Unmixing Spectra Manually ......................................... 73
- Saving An Unmixed Result Set ............................................................. 75
- Working With Saved Result Sets ......................................................... 77
- Checking Your Spectral Library .......................................................... 78
- Subtracting Spectra from a Cube ......................................................... 78
- Using Line Profiles to Analyze Signals ............................................... 79
- Comparing Multiple Images ............................................................... 82
- Processing Multiple Cubes ................................................................. 85
Opening a Spectral Library

If a spectral library has already been saved and validated for the type of specimen/cube you want to unmix, use that library to unmix the cube. Or if an appropriate Maestro protocol is available, which should include the spectral library, then load the protocol instead (see “Acquiring Images Using a Saved Maestro Protocol” on page 50).

By using a saved protocol and/or spectral library on similar specimens to unmix and perform analyses throughout an experiment, you don’t have to recreate the spectral library every time. This helps ensure consistency throughout the experiment. Protocols and spectral libraries can be opened before or after loading an image cube.

**Note:** Be aware that using a spectral library from one specimen on a specimen that contains different fluorophores will lead to incorrect results.

To open a spectral library:

1. Select **File > Open Spectral Library** (or press Ctrl+L). Select the location and filename of the library and click **Open**. One of the following will occur:
   - If the current library is empty, the library you selected will open.
   - If a library is open already, the **Import Spectra From Library** dialog box opens for you to select the spectra you want to import (see “Importing Spectra Into a Library” on page 44).

2. The color palette on the **Spectra** panel will be populated with the new spectra.

**Tip:** You can also open a Maestro spectral library by double-clicking the library (*.csl) file in a My Computer directory window. If Maestro is not already open, this action will open Maestro with the selected library. Or you can drag and drop the library file into an open Maestro window to open the library.

Opening an Image Cube

1. Click the **Load Cube** button on the toolbar, or select **File > Open Cube** (or press Ctrl+O).

2. In the **Choose Cube** dialog box, browse to the location where the image cube is saved.
   - If opening a CRi format (.im3) image cube, double-click the file to open it.
   - If opening a TIFF image cube, open the folder containing the images and double-click any one of the TIFF image files to open the cube.

3. The cube will open, and a color representation of it opens in the Maestro image gallery.

**Tip:** You can also open an image cube by double-clicking the cube (*.im3) file in a My Computer directory window. If Maestro is not already open, this action will open Maestro with the selected cube. Or you can drag and drop the cube (or multiple cubes) into an open Maestro window to open the cube(s).
Computing and Unmixing Spectra Automatically

The **Real Component Analysis** feature lets you explore how many different spectral features are present, extract spectra for further analysis, and calculate “pure” spectra even if autofluorescence is present.

**To compute spectra using real component analysis:**

1. Open or acquire a cube.
2. Select the **Spectra** tab and click the **Real Component Analysis [RCA]** button.
3. The **RCA** dialog box opens.
4. If you want to select a smaller region of the image on which to perform the RCA computation, click the **Select Area** button. Then use the mouse to draw a rectangular region on the Cube image. If you don’t draw a region, the whole image will be used. Clicking the **Clear Area** button clears any user selected area from the image.
5. If you want to provide an initial guess of the background (autofluorescence) signal, click the **Sample Spectrum** button. Then use the mouse pointer to specify the background signal in the image cube.
   - This option also lets you import a known background spectrum from the current library by selecting from the drop down box in the **Starting Spectrum** group. Use this option if there is no region in the current sample that contains only autofluorescence, as is often the case when using an injected fluorophore.
   - These settings can be discarded by clearing the **Use Selected Background** box.

![Figure 46. Real Component Analysis](image.png)
6. Click the **Find Component Images** button to find the purest spectral features in the image. A set of monochrome images of spectrally distinct signals will soon appear at the right of the cube display window. The number of images reflects the spectral complexity of the sample.

7. Select component images for use in unmixing by clicking on them. Click an image once for “Signal” and twice for “Background.”
   - If autofluorescence (or other background signal) is present, designate the autofluorescence image (typically the top-left) as “Background” by clicking on it twice. Only one image can be designated as Background.
   - Look for other images that appear to contain “significant” signals (a sample-specific judgement) by comparing the RCA images to the original image. Specific images should match specific signals in the original image. Click once on images to designate them as “Signals,” and select a color to represent each signal.

8. Click the **Find Spectra** button in the **Computed Spectra** group.
   - If no Background component was selected, then the “purest” spectra present in the cube will be found.
   - If a Background component was selected, then all other signals will be used as inputs into a computation that removes the presence of the background spectrum to give the spectrally “pure” components.

9. The computed spectra should look like simple gaussian curves (as in Figure 46) for quantum dots, and should have longer tails for most fluorescent dyes. Occasionally, for weak signals, there may be too much baseline offset in the data. Try selecting the **Fit Offset** option and clicking the **Find Spectra** button again and see if the results improve.

10. You may now use the controls in the **Computed Spectra** group to change a spectrum's name, color, and where it should reside in the spectral library.

11. When finished, click the **Transfer to Library** button to add the spectra to the main spectral library. If a library is open already, you may be asked if you want to overwrite the existing spectra.

12. Click the **Close** button to close the **RCA** dialog box.

13. When you are ready to unmix the image, first verify that the spectra you want to unmix is selected in the library, then click the **Unmix** button.
   Alternately, you may press the **Transfer to Library, Unmix and Close** button to perform all these actions with a single click.

14. If the spectral library you have created will be used again for future unmixing operations, save the protocol and/or spectral library.
Computing and Unmixing Spectra Manually

Sampling Spectra from a Cube

You can compute pure spectra without using RCA by sampling the known and mixed spectra manually. Use the color palette on the Spectra panel to build your spectral library. Select colors for separating mixed signals into pure signals.

If the cube you want to unmix was acquired using multiple filters and overlapping acquisition wavelengths (see “Acquisition Setup Using Multiple Filters” on page 57), you will notice that there are two or more overlapping curves in the spectral graph for each of the spectra in cube. Although this may look unusual, the overlapping curves are used together as one spectrum for all unmixing.

There are ten rows available that you can use to build a spectral library. Be careful not to use the same color for more than one signal.

To sample spectra:

1. Open or acquire a cube and select the Spectra tab.
2. Click the Draw button within the row where you want to place the sampled spectrum.
3. Click and draw a line on the part of the cube you want to sample. (Holding down the Control or Shift key will add additional regions to the sample.) When you release the mouse button, a check-mark appears in the Select column.

Tip: The Control and Shift keys also let you sample multiple cubes: Sample the current cube, then select another cube from the thumbnails and hold down the Shift or Control key while sampling to obtain an average of the spectra from the cubes.)

4. The default line sampling tool can be changed by selecting another region of interest shape from the toolbar (see “Selecting a Region of Interest Shape” on page 74).
5. Assign a helpful name to each spectrum in the Name column.
6. To change the color assigned to a spectrum, select from its drop down color menu.

To hide a signal (e.g., background) in an unmixed image:
Unmix the signal you want to hide (such as the background) into black.

To clear the spectral library:
Click the Clear All button. This clears all spectra from the library, clears all spectral curves from the Spectral Scale, and restores the default colors.
To restore default or saved colors:
Click the Restore Defaults button. This restores the color selection for each row in the library to the default or last saved color.

To add notes to the current spectral library:
Enter notes for the current library in the Notes box. Notes will be saved with the spectral library when you save the library.

Selecting a Region of Interest Shape
1. Click the Draw button for the row where you want to place the sampled spectrum.
2. Click the ROI button on the toolbar for the shape you want to use.
3. Click and drag over the part of the cube you want to sample.

Manually Computing Spectra
1. Open or acquire a cube and select the Spectra tab.
2. After loading or building a spectral library, press the Manual Compute Spectra button to display the dialog box.
3. In the Known Spectrum group, select the known spectrum—the spectrum of the autofluorescence. Multiple known spectra may be selected by holding down the Control key while making selections.
4. In the Mixed Spectrum group select the spectrum that represents the selected known spectra plus any additional spectrum. For example, autofluorescence plus a label.
5. The Computed Spectrum will be displayed in the color specified at the bottom of the dialog box.
6. If necessary, use the Scale functions to fine-tune the fit adjustment. See “Using Fit Offset” and “Error Scaling When Manually Computing Spectra” for instructions.
7. Select the row, name, and color for this spectrum and press the Transfer To Library button.
8. Repeat this process for the other mixed spectra.

Figure 48. Manual Compute Spectra
9. When you are ready to unmix the cube, close this dialog box and click the Unmix button on the Spectra tab.

10. Save the new spectral library as described in “Saving Spectral Libraries” on page 43.

**Error Scaling When Manually Computing Spectra**

To obtain an accurate pure label spectrum (which is required for an accurate unmixing), the correct amount of autofluorescence must be subtracted from the mixed spectrum. To do this, it is important that the non-overlapping regions between the “pure” fluorophore and the autofluorescence line up closely.

The Maestro software attempts to determine the amount of autofluorescence to subtract automatically. When there is a bright fluorophore signal (relative to the autofluorescence), scaling is usually not needed. In that case, clear the Scaling check box so that Maestro will subtract the known spectra from the mixed spectra without any scaling.

When there is a weaker signal, you can scale the amount of autofluorescence that will get subtracted from it to ensure that the best “pure” spectrum is found. This is done by checking the Scale check box and sliding the Error Scaler slider.

1. In the Computed Spectrum group (see Figure 48), select “Scale To Max” in the Scaling drop down box. This provides the best visual representation of the spectra.

2. The mixed spectrum and computed spectrum are shown in their respective colors. The dotted “best fit” line is a scaled representation of the known autofluorescence signal (see Figure 48).

3. With the Scaling box checked, try sliding the Error Scaler to the right to increase the scaling (or to the left to decrease it) until the non-overlapping portions of the known and mixed spectra line up as closely as possible (as shown in Figure 48).

4. When you are satisfied with the computed spectrum, select a Spectrum Number, Name, and Color and click the Transfer to Library button.

5. When you are finished adding spectra to the library, remember to save it as described in “Saving Spectral Libraries” on page 43.

**Using Fit Offset**

Occasionally, for weak signals, there may be too much baseline offset in the data. If you did not get the desired unmixing results, select the Fit Offset option in the Manual Compute Spectra dialog box (Figure 48) and see if the unmixing results improve. The computed spectra (the plot in the Spectral Graph) should have a simple gaussian curve, which is the shape of accurate quantum dot spectra.

When you are satisfied with the computed spectrum, select a Spectrum Number, Name, and Color and click the Transfer to Library button. When you are finished adding spectra to the library, remember to save it as described in “Saving Spectral Libraries” on page 43.

This feature is also available when using Real Component Analysis, as explained in “Computing and Unmixing Spectra Automatically” on page 71.
Changing the Spectral Graph Scale

The Spectral Graph displays the spectral curves of selected pixels, as well as computed values for unmixed signals. When you move the mouse pointer over the cube, the spectra associated with each pixel appear as a white line on the Spectral Graph.

There are two places where you can select a scale for the Spectral Graph: at the top of the Spectra panel and on the Manual Compute Spectra dialog box.

To change the scale:

1. Select an option from the Scaling drop down box above the spectral graph:
   - Select the “Normalized” option to view the spectral curves as normalized. The Y-axis in the spectral graph is scaled 0 to 1. Each spectral curve is independently scaled to 1 at its maximum height.
   - Select the “Scale To Max” option to scale the Y-axis in the spectral graph from 0 to maximum height of the highest spectral curve in the image cube.
   - Select the “Un-Normalized” option to view the spectral curves as un-normalized. The Y-axis in the spectral graph is scaled 0 to 255 (8-bit) or 0 to 4095 (12-bit).

   ![Figure 49. Spectral Graph Scaling Selector](image)

2. Move the cursor over the image to see how the white curve changes shape. You are seeing the spectral curve associated with each pixel as you move the mouse pointer.

Saving An Unmixed Result Set

After unmixing an image, you can save all unmixing results without having to save each unmixed image independently. The Save Result Set feature saves the entire workspace (excluding the cube) in a single file. This file will contain the component and composite image, the file name of the cube (but not the cube itself), an RGB representation of the cube, and other data such as measurements and regions, display parameters, user notes, and the spectral library.

You can then reload the saved result set later to review the unmixed results and conduct further analysis/quantitation. You cannot do additional unmixing, however, because there is no cube associated with a saved result set, unless you import the associated cube into the result set (see “Importing a Cube Into a Result Set” on page 77).
To save the current unmixed result set:

1. With the unmixed images on your screen, select **File > Save Result Set**.

2. The **Choose Results Set** dialog box opens.

3. Enter a name for the new result set and click **Save**. Result set files are saved with a “.umx” file name extension.

**Working With Saved Result Sets**

If unmixed result sets have been saved, you can open them for further analysis and quantitation. (See “Saving An Unmixed Result Set” for instructions on saving unmixed result sets.)

**To open a result set:**

1. Select **File > Open Result Set**.

2. In the **Choose Results Set** dialog box, locate and select the “result_set.umx” file you want to open, and click **Open**.

---

**Tip:** You can also open a Maestro result set by double-clicking the result set (.umx) file in a My Computer directory window. If Maestro is not already open, this action will open Maestro with the selected result set. You can also drag and drop a result set into an open Maestro window.

3. The unmixed images will open in the image gallery. If the Maestro software can locate the cube associated with the result set (it must be a CRi format “.im3” Image Cube in its original location on the computer), the cube will open along with its unmixed images. If the Maestro software cannot find the cube or it is a TIFF Cube, an RGB representation of the cube (labeled “RGB - Cube Is Not Loaded”) will open.

4. If the cube did not load automatically, you can import the cube into the result set. See “Importing a Cube Into a Result Set” for instructions.

**Importing a Cube Into a Result Set**

When a result set is saved, the original image cube is not saved as part of the result set (.umx) file. An RGB representation of the cube is saved instead. When you open a result set, the Maestro software attempts to open the associated cube as well. If the associated cube cannot be found, the RGB proxy opens instead. You can replace the RGB proxy with the actual cube.

**To import a cube into a result set:**

1. Right-click on the RGB image and select **Import Cube** from the pop-up menu.

2. The **Choose Cube** dialog box opens.

3. Select the cube (an Image Cube or TIFF Cube) you want to import and click **Open**.
Checking Your Spectral Library

Viewing Error Images

The Maestro software unmixes a cube’s spectral signals based on the spectra in your current library. The **Error Images** utility in Maestro saves and can display any signals that are not accounted for in the component images. Those signals are thus omitted from the composite image. In other words, the Error Images contain all signals that would be left over if a cube could be recreated from the unmixed component images.

After unmixing, select **Tools > Show Error Images**. Two new images (Error Cube and Error Magnitudes) appear. The Error Cube contains the spectral variations of the error, while the Error Magnitudes image contains the error energy (not actually energy) not present in the component images. These images should contain no bright signals, but only “background noise” in the region(s) of interest. If bright signals are present, this indicates that the cube was not optimally unmixed.

Use this utility to validate your spectral library and identify spectral features that are not being accounted for in your unmixing. If you missed a spectral feature that needs to be in your library, the Error Images show you where to look for that spectral feature. Add it to your library using Compute Pure Spectra. Unmix the cube again using your improved spectral library.

Subtracting Spectra from a Cube

The Baseline Subtract utility can be used to subtract a spectrum from a cube. For example, if there is stray light (background) in a cube, which contributes to a baseline offset, use this utility to subtract the background from the cube and improve contrast. This will ensure that the background is near zero (little or no offset).

Baseline subtraction is done numerically (without scaling or other changes in value), wavelength-by-wavelength, from every pixel of the cube. This alters the spectral shape of remaining signals and their overall intensity. The magnitude of these changes depends on the intensity of the spectral signal being subtracted. Typically, when background spectra are small compared to the signals, spectral library entries derived from unsubtracted datasets can still be used, but this should be validated when quantitative results are required.
1. Select **Tools > Baseline Subtract.** The **Baseline Subtract** dialog box opens.

![Figure 50. Baseline Subtract](image)

2. This dialog box displays the spectra from the current spectral library.

3. Select spectra you want to subtract and click the **Subtract from Current Cube** button.

4. The Maestro software subtracts the selected spectrum from the cube and closes the dialog box. The cube’s filename is also appended with “_subt” to remind you that a spectrum has been subtracted from the cube.

---

**Using Line Profiles to Analyze Signals**

The Line Profiles tool can be used to analyze any single-channel (monochrome) image, including component images and live images in Maestro. (Cubes and composite images cannot be analyzed with this tool). When you draw lines on any monochrome image, the pixels sampled by the lines show up as a plot of intensity versus pixel count in the Spectral Graph of the **Line Profiles** dialog box.

**To use the Line Profiles tool:**

1. Select or open the monochrome image (or images) in the Maestro image gallery.

2. Select **Tools > Line Profiles.** The **Line Profiles** dialog box opens.
   - Ten rows in the color library allow you to draw up to ten profile lines on multiple monochrome images.
   - Each line profile appears as a plot with corresponding pen color in the Spectral Graph.
   - You can change the Spectral Graph Scale to either “Normalized” or “Scale To Max.”
   - The **Clear All** button is used to remove all profile lines from the image(s) and clear the Spectral Graph.

3. To draw a profile line, click the **Draw** button on the first row (Red) of the color library, and then use the mouse pointer to click and draw a line across the area of
interest in the image. As you draw a line within the image, the Spectral Graph displays the intensity of the selected pixels.

4. Figure 51 shows two profile lines drawn on two different component images of the same mouse, illustrating the usefulness of the line profile tool.

![Figure 51. Line Profiles drawn on component images](image)

Note the following attributes of the profile lines:

- The first profile line (Red) intersects the bright signal of abdomen of the mouse for the food fluorescence channel.
- The second line (Green) intersects the slight change of the fluorescent skin signal across the abdomen of the mouse.
- As the mouse pointer moves across the Spectral Graph in the Line Profiles dialog box, you will notice a black dot appear on each line. These dots correspond with the dots on the profile lines of the images. They can help identify specific pixel intensities on the line and in the spectral graph.

The Line Profiles tool is for data comparison purposes only. The ability to export profile data has not yet been enabled.
Working with Line Profiles

After drawing line profiles on an image, you can copy, clone, move, and delete lines by right-clicking on them.

To copy line profiles to the clipboard:
1. Right-click on the image that contains the lines you want to copy, and then select Copy Line Profiles To Clipboard from the pop-up menu. This feature copies all profile lines in the image onto the clipboard. If you want to copy a single line to another image, simply drag and drop the line onto the other image. (Be sure to deselect the Draw tool before attempting to drag and drop the line.)

Note: When dragging a copy of a line to another image, the line will not move while you drag the mouse pointer. However, the copy will appear on the new image, at the same spatial coordinates as the original copy, when you release the mouse button at the destination.

2. Right-click inside the image to which you want to paste the line profiles and select Paste Line Profiles From Clipboard.

3. All line profiles on the clipboard are pasted into the current image. Each new line profile is assigned the next row/color in the color library, and all lines are plotted in the Spectral Graph.

To clone a line profile:
1. Right-click on the line you want to clone and select Clone Line Profile from the pop-up menu. (Cloning creates an exact copy of the original that you can move to another area within the current image. You cannot move a clone to another image.)

2. The mouse pointer changes to a hand with a floating clone of the original line attached to it. Move the clone and click to release it at the desired location.

To move a line profile:
1. Right-click on the line you want to move and select Move Line Profile from the pop-up menu.

2. The mouse pointer changes to a hand with the floating line attached to it. Move the line and click to release it at the desired location.

To delete a line profile:
1. Right-click on the line you want to delete and select Delete Line Profile from the pop-up menu.

2. The line is removed from the image, the selection is removed from the color library, and the profile plot is removed from the Spectral Graph.
Comparing Multiple Images

The Compare Images tool lets you compare greyscale images collected over time, across a group of mice so that you can more easily visualize differences in intensity in the component images. Images compared with this tool do not need to have the same scaling or image display parameters. Compare Images will display images on the same scale, accounting for differences in intensity due to bit-depth, exposure time and binning.

The mouse image datasets in the following example illustrate the dynamic range variability of different images and how they can be compared using the Compare Images Tool. In this example, an experiment was conducted to observe the different concentrations (8 ng to 1000 ng) of DOX fluorophore in eight different mice (two mice per image). To visually compare the change in fluorescent signal in the different mice, we use the Compare Images tool to illustrate the four different images.

To compare multiple images:

1. Open and unmix the relevant cubes so that their component thumbnails are listed in the Thumbnails list at the bottom of the window.
2. Select Tools > Compare Images. The Compare Images dialog box opens (Figure 52).
3. From the image gallery or the Thumbnails list, drag the greyscale component images to be compared onto the display boxes in the dialog box. (You may need to scroll the Thumbnails list to locate all your greyscale images.)
4. By default, the dialog box has room for 16 images to compare. You can use the scroll boxes in the Grid Dimensions group to change the display grid.

![Figure 52. Compare Images](image)
5. All images are scaled based on the image with the brightest signal. As you can see in Figure 52, the Display Key for the lower-right image has the brightest signal with 874 counts. The red outline in each image Display Key indicates the display range of the individual image.

6. The four images in Figure 52 show the difference in the amount of DOX fluorophore present in all eight mice (two mice per image):
   - The lowest amount of fluorophore image at the upper-left has 8 and 16 ng of DOX, which appears black compared with the brightest signal (in the lower right image).
   - The next increment of fluorophore image at the upper-right is almost all black, which contains 31 and 62 ng of DOX.
   - The lower-left image has 125 and 250 ng of DOX, showing a slightly brighter signal.
   - The lower-right image has 500 and 1000 ng of DOX, illustrating the brightest intensity at 874 counts.

7. If an image you are trying to compare is either too dark or too bright to display any visible detail at the display range of the other images, use its Scale Factor multiplier to multiply its pixel intensity. In Figure 52, the upper-left image is too dark to display any detail. Increasing its Scale Factor to 10x (see Figure 53) will make the image brighter (notice also the change in its Display Key).

![Figure 53. Compare Images using different scaling factors and the “Jet” color map](image)
To modify display settings:

- The **Display Mapping** options are used to adjust the gamma, brightness, and contrast, of all the images together.

- The **Color Map** drop down box lets you map the display to a variety of pseudo colors. The example in Figure 53 is shown using the “Jet” color map.

- The **Saturation Mask** option allows you to mask saturated pixels if desired.

To zoom and pan images:

- Right-click on any of the images and select **Zoom** from the pop-up menu. The pointer changes to a magnifying glass. Use the magnifying glass to draw a box around the area you want to zoom.

- To pan zoomed images, right-click on any image and select **Pan**. You can now drag the image to the region you want to view.

- When you want to return to the full image, right-click any image and select **Zoom To Full Image**.

To save displayed images:

To save a copy of an image with its current display settings, right-click on the image and select an option from the pop-up menu:

- **Save Image As Displayed** opens a **Choose RGB File** dialog box where you can save the image (as it is displayed) in TIF or JPG format.

- **Copy Whole Image To Clipboard** copies the entire image, regardless of the current zoom level, to the clipboard. This can then be pasted into a third party software program.

- **Copy Displayed Image To Clipboard** copies the current viewable region of the image to the clipboard. This can then be pasted into a third party software program.
Processing Multiple Cubes

In some instances, you might prefer to acquire a large number of cubes before analyzing them, or you might want to re-analyze a set of images with new analysis settings. The Batch Data Processing feature is useful for unmixing and measuring multiple cubes or a large set of images all at once. It can also be used to perform co-localization staining detection on a batch of cubes.

1. Select **Tools > Batch** from the main menu. The Batch Data Processing dialog box opens.

![Figure 54. Batch Data Processing](image)

2. If the spectral library you want to use is open already, its spectra will display in the color library. You can add spectra to the library or open a new one by clicking the **Load** button.

3. Use the check box(es) in the **Select** column to select the spectra you want to use for unmixing. Use the **Measure** column to select the unmixed component images that you want to measure during batch processing.

4. The **Apply Baseline Subtraction** check box offers the same functionality as the Baseline Subtraction feature discussed on page 78. If there is stray light (which contributes to a baseline offset) it can be subtracted from the batch of cubes using this option. Select this check box, then indicate which spectrum to subtract from the cubes.

5. The **Choose Cubes** group lets you select the image cubes you want to include for batch processing.
   a. Click the **Find Candidate Cubes** button below the list.
b. Select a folder from the dialog box and click **OK**. The Nuance software will search this folder and its subfolders for cubes that are compatible with the current spectral library and display them in the **Candidate Cubes** list.

c. Select the cubes you want to process, and click the **Add** button. This will add them to the **Selected Cubes** list on the right.

6. The **Measurement Options** group lets you select the measurement parameters that will be used in the batch processing. Use the radio buttons to select one of the following options:

   - **No measurements (Unmix only)** – This option unmixes the selected cubes.
   - **Auto Threshold** – If you select this option, then specify the **Min. Connected Pixels** parameter and choose at least one component image to measure. (Select from the **Measure** column in the spectral library.) Also, browse to specify a **Global Measure File** to contain all of the exported measurement results.
   - **Manual Threshold** – If you select this option, then specify both the **Threshold** and **Min. Connected Pixels** parameters. Next, choose at least one component image to measure. Browse to specify a **Global Measure File** to contain all of the exported measurement results.
   - **Use Precalculated regions** – If you select this option, select a Regions (.roi) file and/or a Measurements (.txt) file that you want to use to measure the unmixed results.

7. If you want to run co-localization detection on a batch of cubes, check the **Measure Co-localization** check box. Notice the prompt to “**Load settings compatible to the loaded spectral library.**” The spectral library used to unmix the candidate cubes must match the library referenced in the co-localization settings file.

   a. Click **Load** to load a co-localization settings (.col) file that was created and saved earlier using one of the candidate cubes. See also “Saving and Loading Co-localization Settings” on page 101.

   b. Browse to specify a **Measure File** to contain all of the exported co-localization measurement results.

8. The parameters in the **Save Options** group control which file types are saved and how the files are named. Results are saved in the same directory as the cube.

   - The **File Suffix** parameter defines the suffix that you want added (such as the date, operator’s initials, etc.) to the file name of each saved file. The unmixed results will be named “originalcubename_filesuffix.umx”. If you do not specify a suffix, none will be added to result set file names. Measurements files are saved with a **date_timestamp_measures.txt** filename.
   - Under **Save Files**, select any or all of the following:
     - **Unmixed result sets** saves each unmixed result set as a result set (.umx) file.
     - **Component images** saves a separate data file (.tif) for each unmixed component image.
- **Co-localization images** saves a co-localization image (.jpg) for each cube.

9. Click the **Run Batch** button. This will iterate through the selected cubes, unmix them, measure any components selected for measurement, and run co-localization detection if selected. A **Batch Mode Progress** box displays the estimated time remaining until completion.

10. When the batch process is complete, you can open an explorer window of the cube directory to view the exported files. For example, the ‘Triplexed Alexafluor mouse_001’ candidate cube shown in Figure 54 resulted in the following exported files:

- The exported Co-localization image file was saved as
  Triplexed Alexafluor mouse_001_coloc_8-15-05-EJS.jpg

- the exported Co-localization measurements file was saved as
  TripAlexafluorMouseMeasurements.txt

- The exported Measurements file was saved as
  Measurements.txt

- The exported Component image (*.tif) files were saved as
  Triplexed Alexafluor mouse_001_AF680_8-15-05-EJS.tif_Data_x10
  Triplexed Alexafluor mouse_001_AF700_8-15-05-EJS.tif_Data_x10
  Triplexed Alexafluor mouse_001_AF750_8-15-05-EJS.tif_Data_x10
  Triplexed Alexafluor mouse_001_Autofluorescence_8-15-05-EJS.tif_Data_x10

- The exported Result set was saved as
  Triplexed Alexafluor mouse_001_8-15-05-EJS.umx
The Measure panel is used to draw measurement regions and set measurement parameters. The Measurements page at the bottom of the Maestro work area displays the measurements of regions drawn on component images. This chapter explains each of the tools used for measuring regions on component images.

**Topics in this chapter:**

- Measuring Regions ................................................................. 89
- Ignoring Smaller Regions ....................................................... 94
- Adjusting Region Transparency and Color .............................. 94
- Understanding Region Measurements ................................. 95

### Measuring Regions

**Finding Regions Automatically Using Threshold Segmentation**

1. Select the component (or any other single-plane) image to be measured and make sure the Measure panel is visible.

2. In the Threshold Segmentation group, click the Auto Calculate Threshold button. The Maestro software will attempt to find a threshold level that is appropriate for the image.
3. Pixels with intensity values below the specified threshold are ignored. If you are not satisfied with the auto calculated threshold level, you can enter a new value in the Threshold Level field by using the slider or manually typing in a value. You will see the region(s) change as you edit the threshold level.

4. After a threshold is set, the image will have an overlay showing the regions that were measured, as shown in Figure 55.

5. If there are too many or too few measurement regions, adjust the Threshold Level or Minimum Connected Pixels value (see “Ignoring Smaller Regions” on page 94).

6. You can adjust the region’s transparency or change its color (see “Adjusting Region Transparency and Color” on page 94).
Manually Drawing and Modifying Regions

The Maestro software provides tools for manually drawing and modifying measurement regions. These tools are located in the Manual Draw Regions group on the Measure panel:

To draw a region:
1. Click the Draw button on the Measure panel.
2. Select the draw tool shape by selecting from the toolbar or right-clicking the image and selecting from the pop-up menu (rectangle-, ellipse-, line-, or area-ROI).
3. Use the mouse pointer to draw new regions of the image to measure.
4. Each region is assigned an ROI number and is listed in the Measurements page at the bottom of the screen. Measurement regions are numbered and sorted according to their size, with the largest region first, and the smallest last.

Figure 57. Manually Drawing a Region

The dashed lines drawn on top of each region show the region's major and minor axis drawn through the center of gravity.

To erase part of a region:
1. Click the Erase button on the Measure panel.
2. Select the erase tool shape by selecting from the toolbar or right-clicking the image and selecting from the pop-up menu (rectangle-, ellipse-, line-, or area-ROI).
3. Use the mouse pointer to remove pixels from existing regions.

To clear all regions:
Click the Clear button to remove all measurement regions.

To move or delete a region:
Right-click on the region you want to move or delete and select from the pop-up menu.
Cloning Regions

The Maestro software’s ability to clone regions makes it easy to directly compare control regions and fluorophore regions of an image. Once you clone a region, you can then move the clone to another area of the image to compare the fluorescence signals.

To clone a region:
1. Right-click on the region you want to clone and select **Clone Region** from the pop-up menu. A clone of the region is created.
2. Move the clone to the desired area of the image. The clone will become the next sequentially numbered measurement region.

![Figure 58. Cloning a Region](image)

Dragging a Copy of a Region to Another Image

You can drag a copy of a region from one component image to another. When you drag a region to another image, the Maestro software automatically pastes the region at the exact same location in the new image. This feature is useful for comparing regions across two or more composite images.

To drag a region to another image:
1. Click on the region you want to copy, and while holding down the mouse button, drag it to the new image.
2. Release the mouse button anywhere in the new image. The copied region will automatically snap into position, corresponding to the position of the original.

Copying all Regions to the Clipboard

The Maestro software can copy all existing regions from an image to the clipboard. You can then paste the copied regions from the clipboard to other images. (All regions in the
image are copied with this feature. See “Dragging a Copy of a Region to Another Image” on page 92 if you want to copy a single region.)

**To copy all regions to the clipboard:**

1. Right-click on the image that contains the regions you want to copy, and then select **Copy Measurement Regions To Clipboard** from the pop-up menu.

2. Right-click inside the image to which you want to paste the regions and select **Paste Measurement Regions From Clipboard**.

3. All measurement regions on the clipboard are pasted into the current image. Each new region is assigned a ROI number, and its measurement data displays in a new row of the **Measurements** page at the bottom of the Maestro window.

**Note:** The ROI numbers can change from image to image depending on what other regions are present in each image.

**Saving and Loading Regions**

If you save your measurement regions, you can easily load them to other images. This is useful for comparing control regions and fluorophore regions across multiple images.

**To save a region:**

1. Right-click anywhere on the image (but not within a region) and select **Save Measurement Regions** from the pop-menu.

2. In the **Choose Measurement Regions** dialog box, enter a descriptive name, and click **Save** to save the measurement region(s).

**To load a region to an image:**

1. Right-click anywhere on the image (but not within a region) and select **Load Measurement Regions** from the pop-menu.

2. The region(s) will be loaded to their exact pixel location when they were saved. You can move the region(s) by right-clicking them individually and selecting **Move Region**.

**Obtaining Accurate Measurement Data**

If you open a non-.IM3 image cube (i.e., a cube of TIFF images acquired using an older Maestro system) you must specify the binning and stage height that was used to acquire the cube. (The binning value defaults to 1x1 and the stage height defaults to 1.)

The Maestro software calculates each region’s area in pixels and in mm² based on the binning and stage height selections on the **Measure** panel. These selections must be correct for the mm² measurement to be accurate.

Binning and stage height data is included in all CRi format (.IM3) image cubes, so for this type of cube, these fields are disabled.
To select the binning or stage height for a TIFF cube

For TIFF cubes only, select from the **Binning** or **Stage Height** drop down boxes. The Maestro software displays the new mm/Pixel value.

**Ignoring Smaller Regions**

The **Measure Objects** group on the **Measure** panel is used to specify a minimum region size based on its number of pixels. Only regions that are larger than the **Min. Connected Pixels** value are considered. The Maestro software ignores regions that have fewer than this number of pixels.

![Figure 59. Minimum Connected Pixels](image)

Use this control to change the size of the regions to filter out. This setting does not effect manual draw regions.

**Hiding Region Labels**

Numbered region labels correspond to the ROI Numbers on the **Measurements** page at the bottom of the Maestro work area. Sometimes a region label obscures important data or makes it difficult to see the region clearly. You can have the Maestro software draw or hide numbered labels on regions within an image.

A check-mark in the **Draw Region Labels** check box (Figure 59) will show the region labels that are normally drawn on top of the region. Clearing the check-mark hides these labels.

**Adjusting Region Transparency and Color**

1. Use the **Transparency** slider (in Figure 55) on the **Measure** panel to change how much measurement regions block the image behind it. Moving this slider all the way to the left makes the region transparent (except for its outline). Moving the slider all the way to the left fills the region with the selected color.

2. If you want to change the transparency’s color, select a color from the **Transparency Color** drop down box.
Understanding Region Measurements

Each region’s measurements are displayed as rows on the **Measurements** data page near the bottom of the Maestro work area (Figure 56). The following information is displayed:

- The **Selected** column indicates which measurement regions are displayed on the image. Clear the check box from a measurement row to remove its region from the image.

- The **ROI Number** for each measurement region corresponds to the number displayed in the center of the region drawn on the image.

- **Cube ID** is the ID entered in the **Sample ID** field on the **Fluorescence** panel when the cube was acquired.

- **Average Signal** is the average value of the pixels in the region.

- **Standard Deviation** represents the variation of the signal values.

- **Total Signal** is the sum of all the pixel values in the region.

- **Max Signal** is the maximum pixel value included in the region.

- **Area (Pixels)** is the number of pixels included in the region.

- **Area (µm²)** is the size of the region in square millimeters. Also, the accuracy of this measurement depends on setting the correct stage height and binning (see “Obtaining Accurate Measurement Data” on page 93).

- **Major Axis** is the length of the minimum area bounding box enclosing the region.

- **Minor Axis** is the width of the minimum area bounding box enclosing the region.

- **X Location** is the center of gravity's x coordinate.

- **Y Location** is the center of gravity's y coordinate.

- **Total Signal/Exp. (ms)** is the Total Signal divided by exposure time in milliseconds.

- **Spectrum ID** is the ID of the spectrum used to unmix this image (entered from the **Spectra** panel).

- **Cube Time Stamp** represents the time the cube was created.

Hiding Measurement Columns

Right-click anywhere within the measurement rows. The pop-up menu lists all columns with check marks. Click any column to clear its check mark and hide the column from the display. Repeat for all columns you want to hide. You can hide any or all columns except for the **Selected** and **ROI Number** columns.
Copying Measurement Data to the Clipboard

1. Make sure the measurement regions you want to copy are selected on the Measurements data page (check marks in the Selected column).

2. Click the Copy Measurements to Clipboard button in the Measure panel. Any columns you have hidden will be omitted from the copied measurements.

3. You can now switch to a program such as Microsoft Excel and paste the measurements into a worksheet.

Saving Measurement Data as a Text File

1. Make sure the measurement regions you want to save are selected on the Measurements data page (check marks in the Selected column).


3. Select a location and enter a name for the text file. Click the Save button to save the new text file. Any columns you have hidden will be omitted from the saved measurements.

Appending Measurement Data

You can append new measurement data to end of an existing measurement data text file.

1. Make sure the measurement regions you want to append to a saved text file are selected on the Measurements data page.


3. Select the file to which you want to append the measurement data and click the Save button.
Chapter 8

Customizing Spectral Displays

This chapter explains how to use the Display panel and the Display Control utility to adjust display parameters of a cube, component image, or composite image to obtain a clearer view of the image.

Topics in this chapter

- Adjusting Brightness and Contrast Levels ........................................................ 97
- Applying Overlays............................................................................................. 98
- Adjusting a Cube’s RGB Mapping ................................................................. 99
- Changing Components in a Composite Image ............................................... 100
- Advanced Display Controls............................................................................. 101

Adjusting Brightness and Contrast Levels

The controls in the Display Mapping group on the Display panel are used to change brightness and contrast levels within images.

![Display Mapping](image)

*Figure 60. Display Mapping*
Five sliders allow you to adjust the following:
- Brightness
- Contrast
- Brightness for the individual red, green, and blue color channels. These sliders are enabled only when a cube or composite image is selected.

The **Min. Max.** option maps the minimum value in the image to 0, the maximum value to 255, and linearly interpolates in between those values. This stretches dark signals so they become visible.

The **Clip/Stretch** option maps the lowest 0.01% of the pixels to 0, the highest 0.01% to 255, and linearly interpolates in between those values. This prevents a few bright or saturated pixels from skewing the display.

The **Histogram Eq.** option maps the pixels so the histogram of the pixels have approximately the same number of pixels in each bin. This gives the best display of the whole dynamic range of dim and bright signals.

The **Raw** option applies no scaling to the data.

The **Abundance** option is enabled only when a composite image is selected. This option scales all the pixels in a composite by the ratio of 255 and the value of the single brightest pixel among all the components. This usually results in a brighter composite image.

**Note:** In fluorescence images, the autofluorescent background signal is often the source of the brightest pixels in the dataset. If this background signal was unmixed into black to make it seem to disappear, selecting the **Abundance** option may result in an almost all black composite image. Unmix the background into white or other light color before applying **Abundance** scaling.

- The **Enhance Contrast** check box adjusts the display of the cube to compensate for the brightness and contrast of your monitor.
- The **Custom** check box lets you assign specific minimum and maximum clip values to the display of any image. This check box works with the **Min. Max.** and **Clip/Stretch** display options only. Increase the **Min Clip** value to exclude more of the lowest value pixels from the display. Decrease the **Max Clip** value to exclude more of the highest value pixels.

## Applying Overlays

### Saturation Mask

Saturated pixels in your images reduce the accuracy of your unmixing and quantitation results. The Maestro software considers a pixel in a cube “saturated” if the pixel is saturated at any of the cube’s wavelengths. Pixels in a component image remain saturated
if they were saturated in the cube used to create the component. In a composite image, a pixel will be saturated if it was saturated in the component image.

If saturation is present in your image, use the **Saturation Mask** controls on the **Display** panel to reduce or eliminate the effects of the saturated pixels.

**To apply a saturation mask:**
1. Select the image to which you want to apply the saturation mask.
2. Select the color that matches the saturated pixel color.
3. Click the **Display** check box to apply the saturation mask to the image.

**Live Overlay**

The **Live Overlay** option lets you use a saved image as an overlay on top of the live view for positioning your specimen as when it was previously imaged. Open the image you want to use as an overlay. Right-click on the image and select **Set As Live Image Overlay** from the pop-up menu. The overlay is now visible in the live view. Use the **Display** check box on the **Display** panel to view or hide the overlay. Use the **Transparency** slider to increase or decrease the transparency of the overlay image.

**Adjusting a Cube’s RGB Mapping**

Computers display color through varying intensities of red, green, and blue. To display an image cube, which has many more color planes, the Maestro software maps all colors in the cube to the red, green, and blue planes.

When an image cube is active, the **Wavelength to RGB Map** group becomes visible in the **Display** panel. Wavelength ranges in the image cube are mapped to red, green, or blue to create the display image.

![Figure 61. Wavelength to RGB Map](image)

The plot below the bars shows the current spectral library. It also shows the spectrum underneath the cursor (grey dotted line) when it is moved over the display cube. The x-axis represents the wavelength range of the cube.
The upper control has red, green, and blue bars. The wavelengths in the red bar are mapped to the red plane in the display image (green to green, and blue to blue).

You can move these bars by clicking and dragging them. This will change the wavelength range that gets mapped to that color plane. The bars can also be resized to increase or decrease its wavelength range by dragging the handles on the ends of the bars.

**To View Visual RGB**

Click the **Visual RGB** button to set the bars so they approximate the human eye.

**To View Equal RGB**

Click the **Equal RGB** button to set the bars so they divide the cube’s wavelength range equally among the red, green, and blue planes.

### Changing Components in a Composite Image

The Maestro software displays a composite image by combining the displays—not the raw data—of the component images. When a composite image is active, the **Component Selection** group becomes visible in the **Display** panel.

![Component Selector](image)

*Figure 62. Component Selector*

There is a row for each component image. Use the **Display** column to control which components are used to create the composite image. If you want to change the color used to display any of the component images, select a color from the component’s **Color** drop down box.

This feature is very useful when you want to make the fluorophore signal of interest more clearly visible in a composite image. For example, you could exclude the Background component (thereby removing the autofluorescence) from the composite image. Doing this in combination with adjusting the **Brightness** and **Contrast** of the unmixed components (using the sliders in the **Display Mapping** group), can result in a clear bright image of the tumor, fluorophore, etc.
Advanced Display Controls

In addition to the tools available on the Display panel, the Display Control utility offers more advanced functions for adjusting how cubes, composites, and components are displayed. The functions that are available with this utility will vary depending on the kind of image that is currently active.

To open the Display Control utility:
Click the Display Control button on the toolbar. The top half of this dialog box offers an enhanced version of the Display Mapping and Scaling selectors found on the Display panel (see “Adjusting Brightness and Contrast Levels” on page 97). You can adjust the brightness, contrast, and gamma of the image.

To link the Contrast and Gamma sliders:
Check the Show Crosshairs check box above the preview image. This lets you drag the intersection of these two sliders to any position on the image until the desired display is achieved.

Adjusting Composite Display Settings

Click on the composite to make it the active image. The bottom half of the Display Control utility expands with a list of the component images and other display options such as coloring style and blending style. These can be used to make the label signal of interest more clearly visible in the composite image.

For example, you could exclude the Background (thereby removing the autofluorescence) from the composite. Doing this and using the sliders to adjust the brightness, gamma, and contrast of the label signal can result in a clear bright image of the specimen.

To include or exclude layers:
Click the layer’s View button to include it, or its Hide button to exclude it from the composite.

To adjust a layer’s brightness, contrast, or gamma:
Click the layer’s Adjust button. Then use the Brightness, Gamma, and Contrast sliders to adjust the display of the layer. (You can link these sliders by checking the Show Crosshairs check box.)

To view images in fluorescence or brightfield:
Use the Composite Coloring Style options. In general, you want to select the mode under which the image cube was acquired.

To create a composite image by blending its component signals:
Select Normal (Merged) in the Layer Blending Style group. This will blend the signals from each of the components to create the composite.
To create a composite image by overlaying its component signals:

Select **Overlay (Thresholded)** in the **Layer Blending Style** group. This will overlay each component signal on top of the component signal(s) beneath it. The component at the bottom of the list is the base layer. You can change the order of any component in the list by clicking the up or down arrow next to its thumbnail.

If you want to import a new component image as the base layer, click the **Import Image** button and select the image you want to import. The imported image is added to the bottom of the components list. The Maestro software creates a new composite called a “Layered Image” and displays it in the image gallery.

![Display Control](image)

*Figure 63. Display Control*

To reset displays to the default:

When viewing/editing a single layer, clicking the **Reset Layer** button returns all display settings for the selected layer to the default state.

When viewing/editing the whole image, clicking the **Set To Default** button returns all values of all layers to their default state.
A macro is a shortcut for a sequence of actions. You assign the macro a name and save it. Later, when you run the macro, the macro plays back as if you were performing the actions yourself. A macro can be simple—for example, it could autoexpose and acquire a cube—or it can be complex. For example, it might load a spectral library, pause for you to open a cube, unmix the cube, draw regions of interest, prompt you to adjust the location of the ROIs, save the result set and export the ROI data.

**Topics in this chapter:**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of the Macros Dialog Box</td>
<td>103</td>
</tr>
<tr>
<td>Running Macros</td>
<td>105</td>
</tr>
<tr>
<td>Recording Macros</td>
<td>105</td>
</tr>
<tr>
<td>Saving Macros</td>
<td>106</td>
</tr>
</tbody>
</table>

**Overview of the Macros Dialog Box**

Choose **Macros > Define Macro** from the main menu to reveal the **Macros** dialog box (Figure 64). Each item in this dialog box is described below.

- The **Macros** drop down box lets you select a macro to run. When you select a macro, its steps display in the window. Saved macros cannot be modified. You can also select a macro to run from the **Macros** drop down box on the status bar, at the bottom-right of the screen.

- The **Run Macro** button runs the selected macro. This button is also available on the status bar at the bottom-right of the screen.
• The **Pause Recording** button places the macro recorder in pause mode. When the recorder is paused, it does not record any of your actions. To start recording again, click the **Continue Macro** button.

• The **Continue Macro** button continues running the macro after a message and/or pause in the macro that requests a user action. This button is also available on the status bar.

• The **Load** button is used to import a macro (.rcd) file that contains recorded commands.

• The **Save** button saves a new macro file of all the macros currently listed in the **Macros** drop down box. Macros that you create are automatically added to the **Macros** list; however, they are not permanently saved on the system until you click the **Save** button to save the new file. Any new macros that are not saved will be lost when you close the Maestro software.

![Figure 64. Macros Dialog Box](image)

• The **Record** button starts the macro recorder. Once you click **Record**, most keystrokes, mouse clicks, and menu selections can be recorded as commands in the new macro.

• The **Stop** button stops recording commands and ends the macro.

• The **Pause** button places a pause in the macro to allow the user to perform actions that may be required, such as creating a spectral library, acquiring a reference image, and so on. It is recommended to add a **Message** to the macro immediately before a **Pause** so that the user knows what action is required before continuing with the macro. The macro continues once the user clicks the **Continue Macro** button.

The remaining buttons insert commands into the new macro:
The **Load Files** button adds a prompt requesting that the user select a file to load that will be used in some way by subsequent macro commands. Before you click this button, use the **Type to Load** drop down box to select a file type (i.e., cube, result set, protocol, spectral library, image, or composite).

The **Save Files** button adds a prompt for the user to specify autosave options for files being generated or edited by the macro. Before clicking this button, use the **Type to Save** drop down box to select a file type (i.e., cube, result set, protocol, spectral library).

The **Loop** button adds a loop command that controls the number of times to repeat the command that follows it. First select the number of **Times to Repeat**, and then click the **Loop** button. Then add the commands you want to repeat.

The **Timer** button inserts a timed delay into the macro. First select the **Delay** time in seconds, and then click the **Timer** button.

The **Message** button inserts a command to display a message to the user while running the macro. You can enter any text message or insert an HTML formatted file. The macro will present the message and wait for the user to acknowledge it before continuing the macro.

The **End Loop** button terminates the loop cycle if you started a loop earlier in the macro.

**Running Macros**

**To run a macro:**

1. Make sure the image is focused and centered in the Live window first, before running a macro that acquires a cube.

2. Select a macro from the **Macros** drop down box on the status bar. Or choose **Macros > Define Macros** from the main menu and select the macro to run.

3. Click the **Run Macro** button. Follow the prompts—if any were created as part of the macro—to proceed through the entire macro until it is finished.

**Recording Macros**

**To record a macro:**

1. Choose **Macros > Define Macros** from the main menu to reveal the **Macros** dialog box.

2. Click the **Record** button to start recording commands. You can use the buttons in the dialog box to load files, add command loops, and so on (as described in “Overview of the Macros Dialog Box” above). The recorder also records mouse clicks, menu selections, and other actions while the recorder is running.

3. When you are finished recording, click the **Stop** button. You can then play back the new macro.
**Saving Macros**

1. Macros that you create are not saved permanently until you save them. Click the **Save** button. Select a location and enter a filename for the new macro file.
2. The system automatically adds a “.rcd” extension to the filename.
Chapter 10

Co-localization Staining Detection

The Maestro 2 system’s Co-localization tool is used to find overlapping layers in a dataset and perform multi-analyte analysis. This tool can accurately evaluate positivity for multiple antigens and can detect and quantitate co-localization of up to ten markers. It is designed for analyzing and quantitating molecular markers and can be used to determine the amounts of co-localization of multiple markers.

The Maestro 2 system resolves the pattern of co-localized probes and generates quantitative images of the individual analytes. The Maestro 2 system also separates fluorophores from each other and from ubiquitous autofluorescence background, allowing more sensitive and quantitative studies.

Topics in this chapter:

- Opening a Dataset for Co-localization Analysis ............................................. 108
- Adjusting Threshold Mask Values ................................................................. 109
- Selecting Markers for Co-localization ............................................................ 110
- Saving and Loading Co-localization Settings ................................................. 111
- Interpreting the Statistics ............................................................................. 112
- Customizing the Statistics Display ............................................................... 113
- Drawing Regions of Interest ....................................................................... 113
- Customizing the Composite Image Display .................................................. 114
- Copying Images and Data .......................................................................... 115
- Exporting Images and Data ...................................................................... 115
Opening a Dataset for Co-localization Analysis

1. Open the cube or result set you want to analyze.

2. If you opened a cube, then open a tested and reliable spectral library or protocol and unmix the cube into its component images. (The co-localization tool will only open a result set. It cannot open an image cube that has not been unmixed.)

3. Click the Co-localization button on the toolbar (or select Tools > Co-localization).

4. The result set opens in the Co-localization dialog box (Figure 65).
   a. The ‘Unmixed_Composite’ image from the result set displays at the upper-right. The image displays with the default settings, or with the display settings defined in the co-localization settings, if a settings file is loaded. (See “Saving and Loading Co-localization Settings” on page 111.)

   b. The spectral components of the result set are listed here.

   c. The thresholding values for each component can be adjusted here.

   d. The markers and counterstains for co-localization can be selected here.

   e. Co-localization percentages for the selected markers and counterstains will display here.

   f. Use these buttons to copy and export data and images.

   Figure 65. Dataset in the Co-localization Tool

b. The spectral Components of the result set are listed at the upper-left. The Spectral Names are taken directly from the library and cannot be changed here. The names in the Marker column are ‘nicknames’ for the components. Marker names derive from the spectral names and can be changed to something more descriptive. Also, if a co-localization settings file is loaded, its name displays in the Settings box.

c. The Settings tab lists thresholding values for each marker. These are calculated automatically upon loading the result set. If you loaded a co-localization settings file containing saved threshold values, the thresholds from the settings file will be
used instead. Use the Statistics tab to configure the display of the co-localization percentages, pixel counts, and component statistics. The Display tab is similar to the Display Control tool that lets you adjust image brightness, contrast, scaling, etc.

d. Use the Co-localization options at the lower-left to select which markers to use for co-localization detection and which to use for the counterstain. Visibility options let you adjust the co-localization mask.

e. As you select markers and counterstains, statistics are calculated and displayed in the Statistics area. Statistics include the percent of co-localization for the entire image as well as individual markers, the positivity of markers within other markers, and component statistics.

f. Use the Copy and/or Export buttons when you are ready to save co-localization images and statistics. Images can be exported as JPG or TIFF images, and data can be exported as TXT files. See also “Copying Images and Data” on page 115.

## Adjusting Threshold Mask Values

The Co-localization tool is pixel-based, and thresholding determines which pixels are considered positive for each component. Upon loading a result set, the tool autocalculates the optimum threshold value for each marker. However, if a co-localization settings file for the dataset is loaded, the tool will use the thresholds in the settings file.

Because thresholds must be set properly for accurate results, you should visually check the threshold of each marker, as follows:

1. Turn OFF Visibility for all but one of the components listed at the top-left. (For the example in Figure 65, the AF700 and AF750 and Autofluor components were turned OFF first.)

2. Now turn the threshold mask for the visible marker ON and OFF a few times to see the pixels that are represented by its mask.

3. Use the threshold slider or the numerical scroll box to adjust the threshold of the marker, such that all pixels of individual features are represented by the mask.

   Setting a threshold requires operator judgment, since this setting determines which intensities are included in the analysis. Each threshold mask should cover only the pixels for its component, and individual features should be identified in the mask as individual constituents. This ensures an accurate measure of the desired pixels in each channel. If threshold pixels are present between features that should be separate, this usually means the threshold is set too low.

4. Repeat this procedure for the other marker(s), paying close attention to the pixels that contain only the particular marker of interest.

5. Also, note the Minimum Pixels value. This restricts the threshold mask to groups of pixels that are larger than this value.
Selecting Markers for Co-localization

The dataset’s components are listed in two columns at the lower-left, in the Co-localization group. As you select markers and counterstains, you will see the Statistics area reflect the calculated percentages. See Figure 66.

1. In the Markers for Co-localization column on the left, select the markers for which you want to see overlap (co-localization) and their positivity percentages. (In this example, Red and DAB are selected as co-localization markers.)

2. In the Denominator(Counterstain) column, select the marker to use as the counterstain. If you want to see co-localization of markers throughout the entire dataset, and not just within a particular counterstain, then you would select All Image Pixels. (In this example, Autofluor was selected as the counterstain.)

3. The Co-loc. Label name defaults to ‘Overlap’ and can be changed if desired. This is the name given to the co-localization values when they are displayed in the component statistics and when the data is exported.

4. Clicking the Show Co-loc. button quickly turns off all threshold masks in the component image and turns on only the co-localization mask. Clicking the Show All button, quickly turns on all threshold masks that participate in the overlap as well as the co-localization mask.

5. You can select any Mask Color from the pull down color menu.

6. The Visibility eye turns the co-localization mask visibility on or off. In Figure 66, all threshold masks (except ‘Autofluor’) and co-localization masks are turned on.

Figure 66. Co-localization & positivity percentages
Saving and Loading Co-localization Settings

Saving Co-localization Settings

When you want to save the current co-localization display and configuration settings, save a Co-localization Settings file. This file will include Component settings, Thresholding settings and values, Co-localization Marker selections, and Statistics and Display options. If a settings file is loaded already, you can overwrite the existing file or save a new one. (Co-localization settings are not saved in Maestro Protocols.)

To save a co-localization settings file:

1. Leave the Co-localization window open and select File > Save Co-localization from the main menu.
2. Name the settings file and click Save. You can now open and run co-localization detection on any number of compatible result sets using this settings file.

Loading Co-localization Settings

You can load a saved settings file before or after opening a dataset in the Co-localization tool.

To load a settings file:

1. Select File > Open Co-localization from the main menu.
2. Select the settings file you want to load and click Open.
3. The selected settings file displays in the Settings box at the top of the Co-localization tool.

Co-localization settings must be compatible:

Before the Co-localization tool loads a settings file, it checks to see if the settings file is compatible with the result set (if one is loaded). Both must have the same number of spectra.

If the result set does not have the same number of spectra as the settings file, you will be notified that “The current result set is incompatible with the selected co-localization settings.” Load a matching settings file or result set, or create a new settings file for the current result set.

However, if the number of spectra in the result set matches the number of spectra in the settings file you want to load, the tool is able to load the file even if its spectra are not identical. In this case, you will have to use the spectra in the result set. This will reset the component names to the spectra names, but their nicknames will remain unchanged.
Interpreting the Statistics

Note the following in the Statistics area (Figure 67):

- The percent of AF680, AF700, and AF750 Co-localization in this dataset is 3.11%. This means that out of all the Autofluorescence signal (selected as the Denominator), 3.11% of those pixels have AF680, AF700, and AF750 co-localization. The number of pixels within the Autofluorescence that are also co-localized with the AF680, AF700, and AF750 markers is 4,638.

- The percent positivity of AF680 labeled pixels within the Autofluorescence is 9.66% (14,391 pixels).

- The percent positivity of AF700 labeled pixels within the Autofluorescence is 8.86% (13,195 pixels).

- The percent positivity of AF750 labeled pixels within the Autofluorescence is 6.85% (10,206 pixels).

- Of the 14,391 AF680 labeled pixels, 61.07% of them are also AF700 positive; 34.40% are also AF750 positive. (Likewise for the AF700 and AF750 signals.)

- The Component Statistics rows display for all components that you selected on the Statistics tab (at the left in the Co-localization dialog box).

  - Every component has an Overlap row that displays the area and signal statistics of the overlap (co-localization) for each component.

  - There is also a Full Image ROI for every component. If there are no ROIs drawn on the image, the default ROI is the full image. If you draw ROIs (see “Drawing Regions of Interest” on page 113), a new row will be added to the
Component Statistics area for each ROI. The system automatically numbers and labels ROI’s to distinguish them in the image window and in the statistics table.

**Customizing the Statistics Display**

Click the **Statistics** tab. Here you can turn on or off the **Percentage** and **Pixel Count** displays for each statistical category. You can also select to display or hide the Component Statistics. Figure 68 shows all of the statistics options turned on.

![Figure 68. Co-localization Statistics](image)

**Drawing Regions of Interest**

If you want to select a specific area of the image to process, click an **ROI** button at the left of the image and use the mouse to click-draw region(s) of interest. Note that once an ROI is added to the image, the **All Image Pixels** option in the **Denominator (Counterstain)** list becomes **All ROI Pixels**. The statistics are updated automatically as you draw and modify ROIs. Additional buttons let you erase an ROI and clear all of the ROIs. You can also zoom and pan the image.

**Cloning, Moving, Deleting ROIs**

Right-click on the region within the image and select the desired action from the drop down menu.
Applying Regions from a Saved ROI File

You can apply regions from a saved ROI file to the composite image. (Working with regions is described in more detail in “Chapter 7, Quantifying Results” on page 89.) Right-click on the image and choose Load User Regions from the drop down menu. Select an ROI file from the dialog box.

Saving Regions

To save the current regions, right-click on the composite image and choose Save User Regions. Enter an ROI file name, select a location, and click Save.

Customizing the Composite Image Display

Click the Display tab to view the display controls:

- To view images in fluorescence or brightfield, use the Composite Coloring Style options. In general, you want to select the mode under which the original image cube was acquired.
- Use the Display Adjustments and Component selectors to choose whether you want to adjust the display of the whole image or a selected layer.
- Use the Brightness and Contrast sliders to adjust the brightness and contrast of the image, or of the selected layer if Single Layer was selected.
- The Min. Max. option maps the minimum value in the image to 0, the maximum value to 255, and linearly interpolates in between those values. This stretches dark signals so they become visible.
- The Clip/Stretch option is the default display scale. It maps the lowest 0.01% of the pixels to 0, the highest 0.01% to 255, and linearly interpolates in between those values. This prevents a few bright or saturated pixels from skewing the display.
- The Histogram Eq. option maps the pixels so the histogram of the pixels have approximately the same number of pixels in each bin. This gives the best display of the whole dynamic range of dim and bright signals.
- The Raw option applies no scaling to the data.
- The Abundance option scales all pixels in the composite image by the ratio of 255 and the value of the single brightest pixel among all the components. This usually results in a brighter composite image.
- Regions are numbered according to size, from largest to smallest. Check Show Region Labels if you want region numbers to appear inside each region.
- The Show Markers and Co-localization Masks option lets you quickly turn on or off the mask settings you selected on the Settings panel.
Copying Images and Data

Copying Images

To copy the current image as displayed to the Windows clipboard, click the Copy Image button. Paste the image into any software program capable of displaying graphic images.

Copying Data

To copy all of the displayed data in tab delimited format to the Windows clipboard, click the Copy Data button. Paste the data into any spreadsheet program such as Microsoft Excel.

Exporting Images and Data

Exporting Images

To export the current image as displayed as a JPG or TIFF RGB file, click the Export Image button. In the Choose RGB File dialog box, enter a file name and location for the image and click Save.

Exporting Data

To export all displayed data in tab delimited format as a TXT file, click the Export Data button. In the Choose Measurement File dialog box, enter a file name and location for the file and click Save.
Dynamic Contrast Enhancement (DyCE) is a plugin application that can be purchased as an add-on to your Maestro system. DyCE is a simple, inexpensive and versatile new approach that can provide coregistered anatomical information by exploiting \textit{in vivo} pharmacokinetics of dyes in small animals. DyCE can be applied singly or in combination with functionalized marker probes.

**Topics in this chapter:**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How DyCE Works</td>
<td>117</td>
</tr>
<tr>
<td>Preparing for DyCE Imaging</td>
<td>119</td>
</tr>
<tr>
<td>Acquiring a Monochrome DyCE Dataset</td>
<td>121</td>
</tr>
<tr>
<td>Acquiring a Multispectral DyCE Dataset</td>
<td>122</td>
</tr>
<tr>
<td>Recalling/Opening a Saved DyCE Cube Sequence</td>
<td>123</td>
</tr>
<tr>
<td>Creating a DyCE Time Series</td>
<td>123</td>
</tr>
<tr>
<td>Displaying/Playing DyCE Datasets</td>
<td>124</td>
</tr>
</tbody>
</table>

**How DyCE Works**

DyCE imaging does not require multimodality image acquisition, but instead utilizes a time-series of optical images acquired following a small bolus injection of a near-infrared (NIR) dye or contrast agent. (Non-targeted probes can provide anatomic images for optical imaging, while targeted probes can be used for background rejection, targeted contrast enhancement, organ function imaging, and inflammation studies.) As the dye circulates through the body, each organ displays characteristic pharmacokinetics depending on whether the dye is accumulating, washing through or perhaps being metabolized.
Immediately following the bolus injection, Maestro and DyCE collect a sequence of images over time, which can be viewed as a movie in the DyCE plugin. You can then unmix the time series to create anatomical surface maps of major internal organs. These maps can be seamlessly co-registered with molecular imaging data obtained in the same animal, using the same instrument and without moving the animal.

The basic procedure for DyCE imaging is as follows:

1. Inject a bolus of NIR dye. A mixture of two or more tracer dyes could be used; however, anatomical co-registration requires only a single suitable dye. Indocyanine Green (ICG) is ideal for this application because it excites and emits in the near infrared (NIR).

2. Take a dynamic series of images. As little as twenty seconds of data is sufficient for anatomical co-registration.

3. Unmix the images using the Maestro software.

Figure 69 shows an example of an acquired time sequence and the resulting unmixed composite image.
Preparing for DyCE Imaging

System Setup

1. Make sure the Maestro system is turned on and the Hardware Status indicator in the software displays “Ready.”

2. Make sure the multiview platform (if purchased) is installed and connected to the interface and anesthesia ports inside the chamber.

3. Make sure the Live Stream window is displayed (click the Live button if it is not).

4. On the Acquire > Fluorescence tab, select camera settings, a filter set, and any other acquisition parameters. Or if a protocol has been saved for this application, then load the saved protocol.

5. Make sure the appropriate lights within the chamber are turned on and the platform is heated to the proper temperature. Ideal lighting conditions depend on the dye or agent that will be used during the current application.

6. In the Maestro software, click the Acquire DyCE button or select Tools > Acquire DyCE from the main menu. If you have not yet activated the DyCE plugin, select DyCE Limited Time Trial from the Tools menu. Enter your activation code if you purchased a license to use DyCE. If you have not yet purchased a license, you may evaluate DyCE for up to 30 days.
Selecting Binning and ROI

Select the desired **Binning** and **ROI** for this acquisition. The **Total Time** displays the current estimate of the time required to acquire the dataset using the currently selected **Time Series**.

Check the estimated data size, which is the expected size of the dataset when acquired. It is important to keep this value below 150 megabytes due to memory limitations; datasets that are larger than 150 MB may be too large to analyze. The value displays in green to indicate an acceptable file size. Red indicates that the file may be too large at the current settings. (Increasing the binning or choosing a smaller ROI will decrease the estimated size of the dataset.)

Selecting a Collection Type

The **Collection Type** determines the type of dataset that will be collected. There are three options:

- **Mono (broadband emission)** acquires a monochrome image at the selected time intervals with the tunable filter out of the light path.
- **Mono (using current Acquire wavelength)** acquires a monochrome image at the selected time intervals with the tunable filter in the light path.
- **Cube (using current Acquire settings)** collects a series of complete multispectral cubes for the duration of the selected time interval.

Selecting Save Options

Select a directory/folder where you would like to save the acquired dataset(s). Enter a base cube name in the **Cube Name** field.
Acquiring a Monochrome DyCE Dataset

1. Select **Mono (broadband emission)** or **Mono (using current Acquire wavelength)** as the collection type. Both of these options let you configure up to three collection intervals, which gives you the ability to set a different frame rate for each interval. This is important because in most cases you want to capture more frames (i.e., more data) during the first few seconds immediately following the bolus injection.

2. Configure the **Time Series**: For example, as shown in Figure 71 above, you might want to capture 5 frames per second for the first 25 seconds, with an exposure time of 221 ms per frame. The next 10 seconds will capture 2 frames per second. During the final 5 seconds, the system will capture just 1 frame per second.

3. In the **Save Options** box, click the **Browse** button to navigate to the directory where you want to save the acquired dataset. Select a location, then name the dataset in the **Cube Name** box.

4. Place the anesthetized mouse on the platform (see Figure 72). Be careful not to touch or smudge the mirrors on the platform while placing the mouse. Make sure the mouse’s nose fits snug in the anesthesia nosecone.

5. Prepare for the bolus injection: So that you do not have to open the chamber door to give the injection, use one of the utility ports on the side of the system instead. A catheter inserted through a utility port and then into the rodent’s tail will make it much easier to give the injection. Otherwise, you will have to open the door, give the injection, and immediately close the door before clicking the **Acquire** button.

6. Click **Autoexpose** to calculate optimum exposure settings.

7. When ready, give the injection and click **Acquire** to collect the series of images over the specified time intervals.

8. The acquired images are compiled into an RGB cube. If you selected the **Launch Viewer After Acquire** check box, the cube will display in the DyCE Explorer window as well as in the Maestro window.
Acquiring a Multispectral DyCE Dataset

1. Select **Cube (using current Acquire settings)** as the collection type. This option lets you acquire a time series of complete multispectral cubes following a bolus injection. Up to three intervals may be collected. These intervals let you control the sample rate (frame rate) and exposure time. The system will use the cube acquisition settings currently selected on the **Acquire** panel.

For example, for the first 20 seconds immediately following injection, you might want to collect a multispectral cube every 5 seconds. Then for the next 2 minutes, collect one cube every 30 seconds. During a third interval, you might collect one cube every minute for 5 minutes. Figure 73 demonstrates these time series settings.

![Figure 73. Example Time Series for Cube Collection Type](image)

Note that when collecting cubes, the values in the **Frame Rate** selectors are timers that control the number of seconds that are allowed to lapse between the start of each cube during that interval. Always set the **Frame Rate Unit** to “Sec./Frame” (think of it as “Seconds per Cube”) for cube collection.

2. Select an exposure setting for each time interval. This value overrides any cube autoexposures done via the **Acquire** panel.

3. In the **Save Options** box, click the **Browse** button to navigate to the directory where you want to save the acquired sequence of cubes. Select a location, then enter a base name for the cubes in the **Cube Name** box.

4. Place the mouse on the platform and acquire the DyCE cubes as described in the previous steps 4 through 7 (see page 121).

5. The system will acquire the sequence of cubes. If you selected the **Launch Viewer After Acquire** check box in the Acquire window, the first cube in the sequence will display in the DyCE Explorer window as well as in the Maestro window.

6. Notice the **Create From Cube Sequence** functions: You can create a DyCE time series from the current cube sequence (see “Creating a DyCE Time Series” on page 123), or acquire all of your cube sequences now and process them later. (All cube sequences are saved automatically and can be recalled later for processing.)
Recalling/Opening a Saved DyCE Cube Sequence

All acquired cube sequences are saved in the directory you selected while setting up the DyCE acquisition parameters. The DyCE application recognizes these cubes as members of cube sequences. This feature lets you acquire and save any number of cube sequences, and then recall them later in the DyCE application to compile your DyCE time series.

1. Open the Maestro application and click the Load Cube button on the toolbar.
2. In the Choose Cube dialog, locate the directory where your cube sequences are saved.
3. Open any of the cubes in the sequence from which you want to create the DyCE time series. The cube opens in the Maestro application.
4. Use the color palette to select the spectral component that you want to extract from each cube in the sequence to create the DyCE time series.
5. Select Tools > Explore DyCE from the main menu. The cube opens in the Dyce Explorer window.

Creating a DyCE Time Series

When you acquire or open a sequence of DyCE cubes, the Cubes drop down box (see Figure 74) lists all of the cubes in the sequence.

1. Select a cube from the Cubes drop down box. Each time you select a cube, it will open in the DyCE Explorer window and in the work area of the Maestro software. Try to find the cube that best displays the spectral component that you want to use to create the DyCE time series.
2. In Maestro, switch to the Spectra panel. Use the Library color palette to sample the spectral component you want to obtain from each cube in the dataset. The ID of the spectra will be added to the Component To Keep drop down box.
3. Select the component you want to keep from the drop down box.

![Figure 74. Create from Cube Sequence](image)

4. Click the Create DyCE Time Series From A Sequence Of Cubes button. The Maestro software will open each cube in the sequence and obtain the selected component from each of them. The software will then compile all of these signals into a new cube file.
Reloading a Time Series’ Parent Cube Sequence

Whenever a DyCE time series cube is open in the DyCE Explorer window, the Load Cube From This Sequence button lets you reload the original sequence of cubes that was used to create the time series. This is useful when you want to create a new DyCE time series from the original cube sequence.

1. With a DyCE time series cube open, click the Load Cube From This Sequence button.
2. In the Choose Cube in Sequence dialog, locate and open any cube in the sequence. The selected cube will replace the time series cube in the DyCE Explorer window. You can now create a new time series from the reloaded cube sequence.

Displaying/Playing DyCE Datasets

You can play DyCE datasets as movies in both the Acquire and Display tabs of the DyCE Explorer window. In addition to just playing the movies, the Display tab also lets you change the display mapping and color map, choose dimension reduction, and view a plot of the current cursor location in the movie. You can use the DyCE Explorer to view DyCE movies at any time, even if the Maestro system is not connected to your computer. You can even view any other image cube (*.im3 or *.tif) as a movie.

Opening DyCE Datasets

1. If the dataset is not open in Maestro already, load it now by clicking the Load Cube button.
2. Select Tools > Explore DyCE from the Maestro menu. The DyCE Explorer window opens and displays the cube.

Playing DyCE Datasets

1. Click the Play button to play. The Play bar indicates the current frame and the total number of frames. You can drag this bar or use the scroll box to freeze any individual frame. The frame number and wavelength display in the bottom-right corner.
2. The vertical blue line on the Plot graph indicates the time of the current frame. Also, you can move the mouse pointer over the displayed image to plot the spectral curve of the pixels at the cursor location (shown by the dotted grey line).

Saving DyCE Datasets as AVI Movies

When a DyCE dataset is open in the DyCE Explorer window, click the Save button located at the bottom of the window. In the AVI File dialog box, name the file and click Save. Any AVI movie player can now play your DyCE movie.
Changing the Display Mapping

Two sliders let you adjust the brightness and contrast of the display image. All display changes effect the entire dataset, not just the current frame.

The **Min. Max.** option maps the minimum value in the entire sequence to 0, the maximum value to 255, and linearly interpolates in between those values. This stretches dark signals so they become visible.

The **Clip/Stretch** option maps the lowest 0.01% of the pixels in the entire sequence to 0, the highest 0.01% to 255, and linearly interpolates in between those values. This prevents a few bright or saturated pixels from skewing the display.

The **Histogram Eq.** option maps the pixels in the entire sequence so the histogram of the pixels have approximately the same number of pixels in each bin. This gives the best display of the whole dynamic range of dim and bright signals.

You can assign specific minimum and maximum clip values to the display of the image. Increase the **Min Clip** value to exclude more of the lowest value pixels from the display. Decrease the **Max Clip** value to exclude more of the highest value pixels.

Selecting a Color Map

Depending on the brightness and contrast of the image and the type of dye or agent you are trying to visualize in the movie, different color maps will produce better images. Experiment with the options in the **Color Map** drop down box (and adjust the display mapping if necessary) until you get the desired display of the image.

![Figure 75. DyCE Explorer image using the “Hot” Color Map](image)
Displaying Dimension-Reduced Data

You don’t have to always view the individual planes in a dataset one frame at a time. The DyCE Explorer can identify the strongest signals in the sequence and combine them in a transparent “flattened” image. Check the Display Dimension-Reduced Data box to reveal a new multicolor representation of the data (Figure 76).

Initially, all of the planes in the DyCE sequence will be reduced to just three planes. These planes will be different linear combinations of all the planes in the sequence. You can increase or decrease the number of dimensions (i.e., anatomical signatures) by scrolling the Dimensions box. Use the slider to increase or decrease the transparency of the overlay over the base image. The Plot graph shows the spectral signature of each dimension.

Zooming and Saving Images

To zoom in on an area of the image, right-click over the image and select Zoom. Click-and-drag with the mouse to draw a zoom region. This zoom region will be maintained even when you play the movie. You can also pan the zoomed image or return to the full image.

If you want to save the current frame as it is currently displayed, right-click over the image and select an option from the pop-up menu. You can save the image (i.e., frame) as displayed as a TIF or JPG image, or copy the current frame to the clipboard.
Chapter 12

Frequently Asked Questions

This chapter discusses FAQs and troubleshooting issues for the Maestro 2 in vivo imaging system.

**Can I use the multispectral camera in my Maestro 2 in vivo imaging system on my microscope?**

Maestro 2 systems are designed specifically for macro-imaging. Contact CRi to find out about our Nuance™ Multispectral Imaging Systems for microscopy.

**What is the CCD sensor active area dimensions and the individual pixel size?**

The active light sensitive area of the CCD is 1392 pixels in the horizontal direction and 1040 pixels in the vertical direction. Each pixel is 6.45 µm square.

**Can I use my own lenses on a Maestro 2 in vivo imaging system?**

The lens is built into the Maestro 2 system. Other lenses cannot be used.

**Why do I need an emission filter with the Maestro 2 in vivo imaging system?**

Without an emission filter, specifically a longpass filter, excitation light will bleed through the Maestro optical system and cause artifacts. See “Chapter 1, Introduction to Multispectral Imaging Theory and Concepts.”

**My specimens are sometimes unevenly illuminated by the lighting system. What can I do about this?**

Try using Flat Fielding when acquiring cubes (see “Taking a Reference Image for Flat Fielding” on page 59).
Why are my exposure times so long?

It is possible that there is too little light, and the Maestro 2 system needs to use a longer exposure time.

Also, make sure that the excitation lamp is functioning properly. Check that the lamp cartridge has not exceeded its useful life span. The lamp should be replaced after 500 to 1000 hours of use.

Why are my exposure times so short?

The Interior Illumination lights may have been left on during autoexposure.

Switch off the interior white lights. The Excitation Lamp should be on and the Shutter should be open.

What fluorescence filters sets do I need?

Refer to “Appendix B, Filter Selection Guide,” or contact your local authorized distributor or CRi to discuss your needs. The filters used in the Maestro 2 in vivo imaging system are designed as matched sets for optimum performance.

I installed the Maestro software, but when I launch the application, it doesn’t recognize the hardware.

If the Maestro 2 system was left on and connected to the computer during installation of the software, Microsoft Windows may not have been able to install the correct drivers for the camera.

Disconnect the system from the computer. Make sure the installation CD is in the CD drive, then reconnect the system to the computer. Windows should detect the new hardware and begin the Hardware Installation Wizard. Follow the prompts to install the drivers. See “Appendix D, System Setup & Installation.”
Appendix A. System Specifications & Dimensions

Note that these specifications represent typical Maestro2 in-vivo imaging systems as of October 2008 and are subject to change.

Liquid Crystal Tunable Filter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wavelength tuning range</td>
<td>500 – 950 nm</td>
</tr>
<tr>
<td>Bandwidth, FWHM</td>
<td>~20 or ~40 nm (software selectable: standard or narrow)</td>
</tr>
<tr>
<td>Typical acquisition timea</td>
<td>15-frame image cube in 5 to 10 seconds</td>
</tr>
</tbody>
</table>

a. Acquisition time depends on a number of factors, including bandwidth of the Maestro 2 in vivo imaging system and the amount of light emitted, reflecting off, or transmitted through the specimen at each wavelength of interest. The Maestro 2 in vivo imaging system is designed to “dwell” at individual wavelengths if it determines that more light is needed to produce images with adequate spatial and spectral detail. The system is not limited by a need to acquire images using identical exposure times at every wavelength.

CCD Camera

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum exposure time</td>
<td>20 minutes</td>
</tr>
<tr>
<td>Cooling</td>
<td>TE cooled to 0 °C</td>
</tr>
<tr>
<td>Image sensor format</td>
<td>2/3” diagonal</td>
</tr>
<tr>
<td>Effective pixels</td>
<td>1392 x 1040 pixels</td>
</tr>
<tr>
<td>Image sensor pixel count</td>
<td>1.4 megapixels</td>
</tr>
<tr>
<td>System aperture</td>
<td>F/1.5 (calculated at CCD)</td>
</tr>
</tbody>
</table>
# Specimen Chamber & Stage

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chamber temperature control:</td>
<td></td>
</tr>
<tr>
<td>Range</td>
<td>27 °C to 37 °C</td>
</tr>
<tr>
<td>Control resolution</td>
<td>0.1 °C</td>
</tr>
<tr>
<td>Stability</td>
<td>+/- 0.5 °C</td>
</tr>
<tr>
<td>Accuracy</td>
<td>+/- 1 °C</td>
</tr>
<tr>
<td>Time to stability</td>
<td>10 minutes approximately</td>
</tr>
<tr>
<td>Overtemperature protection</td>
<td>38 °C</td>
</tr>
<tr>
<td>Specimen stage dimensions</td>
<td>8 1/2” wide x 7” deep (exclusive of manifold area)</td>
</tr>
<tr>
<td>Stage translation/orientation range</td>
<td>+/- 2” in both X and Y</td>
</tr>
<tr>
<td>Orientation of anesthesia manifold</td>
<td>9 o’clock (landscape orientation) or 12 o’clock (portrait orientation)</td>
</tr>
<tr>
<td>Heated stage:</td>
<td></td>
</tr>
<tr>
<td>Range</td>
<td>32 °C to 42 °C</td>
</tr>
<tr>
<td>Control resolution</td>
<td>0.1 °C</td>
</tr>
<tr>
<td>Stability</td>
<td>+/- 0.25 °C</td>
</tr>
<tr>
<td>Accuracy</td>
<td>+/- 0.5 °C</td>
</tr>
<tr>
<td>Time to stability</td>
<td>10 minutes approximately</td>
</tr>
<tr>
<td>Overtemperature protection</td>
<td>43 °C</td>
</tr>
<tr>
<td>Anesthesia system:</td>
<td></td>
</tr>
<tr>
<td>Input and exhaust manifolds</td>
<td>Built into specimen stage</td>
</tr>
<tr>
<td>Number of mice</td>
<td>Provision for up to three mice</td>
</tr>
<tr>
<td>Mouse orientation</td>
<td>Accommodates mice in prone or supine orientation</td>
</tr>
<tr>
<td>Vaporizer</td>
<td>External vaporizer (not included)</td>
</tr>
<tr>
<td>Hoses</td>
<td>Flexible hoses to specimen stage</td>
</tr>
</tbody>
</table>

# Field of View

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>At maximum zoom</td>
<td>4.40” width</td>
</tr>
<tr>
<td>At minimum zoom</td>
<td>1.54” width</td>
</tr>
<tr>
<td>Aspect ratio</td>
<td>4:3 (width : height)</td>
</tr>
<tr>
<td>Focal range</td>
<td>specimen stage to 45 mm object height</td>
</tr>
</tbody>
</table>
## Imaging Module

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>37” high x 28” wide x 18” deep</td>
</tr>
<tr>
<td>Weight(^2)</td>
<td>200 lbs. (90.7 kg)</td>
</tr>
<tr>
<td>Anesthesia supply/exhaust ports:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>supply diameter</td>
</tr>
<tr>
<td></td>
<td>exhaust diameter</td>
</tr>
<tr>
<td>Utility ports(^3)</td>
<td>1/2”</td>
</tr>
<tr>
<td></td>
<td>3/4”</td>
</tr>
<tr>
<td></td>
<td>1”</td>
</tr>
<tr>
<td>Emission filters</td>
<td>38 mm CRi filters are held in a computer-controlled 10-position filter wheel</td>
</tr>
<tr>
<td></td>
<td>(see filter selection guide)</td>
</tr>
</tbody>
</table>

\(^2\) Does not include workstation computer.

\(^3\) Unused ports may be kept covered with the supplied plugs.

## Illuminator

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light delivery system</td>
<td>Fiber optic</td>
</tr>
<tr>
<td>Light source</td>
<td>Internal 300 watt xenon lamp</td>
</tr>
<tr>
<td>Color temperature</td>
<td>5600 °K</td>
</tr>
<tr>
<td>Lamp cartridge lifetime</td>
<td>~500 hrs (lamp will then give approximately 50% of original intensity)</td>
</tr>
<tr>
<td>Uniform illumination</td>
<td>80% or better</td>
</tr>
<tr>
<td>Excitation filters:</td>
<td></td>
</tr>
<tr>
<td>Control type</td>
<td>Computer-controlled 10-position filter wheel (incl. attenuator)</td>
</tr>
<tr>
<td>Time to switch filters</td>
<td>3 seconds or less</td>
</tr>
<tr>
<td>Filter sensing</td>
<td>Automatically senses filter presence and ID (bandwidth)</td>
</tr>
<tr>
<td>Filters accepted</td>
<td>Only accepts CRi filters</td>
</tr>
<tr>
<td>Filter type</td>
<td>Hard-coated excitation filters, 25 mm diameter</td>
</tr>
<tr>
<td>Filter wheel accessibility</td>
<td>Filter wheel is accessible to user for changing filters</td>
</tr>
</tbody>
</table>
## Environmental

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating environment</td>
<td>Indoor</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>15 °C to 30 °C</td>
</tr>
<tr>
<td>Operating humidity</td>
<td>50% maximum, non-condensing</td>
</tr>
<tr>
<td>Operating altitude (maximum)</td>
<td>2000 meters</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>-10 °C to 55 °C</td>
</tr>
<tr>
<td>Storage humidity</td>
<td>85% maximum, non-condensing</td>
</tr>
<tr>
<td>Pollution degree</td>
<td>2</td>
</tr>
</tbody>
</table>

## Utilities

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical power</td>
<td>100 to 240 VAC, 800W, 50/60 Hz</td>
</tr>
<tr>
<td></td>
<td>Transformer provided for &lt; 100 VAC; mounting not provided</td>
</tr>
<tr>
<td>Anesthesia</td>
<td>Gas: ¼” barbed fitting</td>
</tr>
<tr>
<td></td>
<td>Exhaust: ¾” barbed fitting</td>
</tr>
</tbody>
</table>

## Computer System Requirements

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>Operates with Maestro software version 2.6 and later</td>
</tr>
<tr>
<td>Processor</td>
<td>3.0 GHz or higher Intel™ Pentium™ 4 class or Intel Centrino™</td>
</tr>
<tr>
<td>RAM (minimum)</td>
<td>2 GB</td>
</tr>
<tr>
<td>Hard disk drive (minimum)</td>
<td>160 GB</td>
</tr>
<tr>
<td>CD-ROM drive</td>
<td>writable CD-ROM drive</td>
</tr>
<tr>
<td>Operating system</td>
<td>Microsoft® Windows® XP Professional or Windows 2000 Professional (English Language Version)</td>
</tr>
<tr>
<td>Display (minimum)</td>
<td>24-bit color, 1280 by 1024 pixels</td>
</tr>
<tr>
<td>Computer interface</td>
<td>One available USB 2.0 interface</td>
</tr>
</tbody>
</table>
Using Third-Party Computers with the Maestro Software

If you intend to use your own computer (one not purchased from CRi) to run the Maestro 2 system or to process Maestro data offline, please consider the following parameters for optimum performance:

- The faster the computer CPU, the faster certain operations in software will be accomplished.
- More hard drive space allows more and larger datasets to be acquired and stored.
- At least 2 GB of RAM is recommended for data processing.
- A USB 2.0 port is required (if you want to connect to the Maestro 2 system).
- The US English versions of Windows® XP Professional or Windows 2000 Professional are the only supported operating systems.
Dimensions

This diagram provides external dimensions of the imaging module in inches. Dimensions are subject to change without notice.
The Maestro 2 in vivo imaging system comes with a complement of installed excitation and emission filters. Use the table below during cube acquisition (discussed in “Chapter 5, Acquiring Spectral Images”) to select a filter setting that closely matches the expected fluorophore emission. This table is current as of September 2008.

Please note that the Maestro 2 system has many applications involving a variety of materials, such as probes, cell lines, animal specimens, etc. Certain of these applications and/or materials may require licensing under patents held by third parties. See “Notice to Purchaser” on page 139 for more details.

Color denotes usable filter set, X denotes the recommended filter set.

<table>
<thead>
<tr>
<th>Fluorophore Name</th>
<th>Excitation (nm)</th>
<th>Emission (nm)</th>
<th>Blue</th>
<th>Green</th>
<th>Yellow</th>
<th>Orange</th>
<th>Red</th>
<th>Deep Red</th>
<th>NIR</th>
</tr>
</thead>
<tbody>
<tr>
<td>525 nm QDot®</td>
<td>&lt; 500</td>
<td>525</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>545 nm QDot®</td>
<td>&lt; 520</td>
<td>545</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>565 nm QDot®</td>
<td>&lt; 540</td>
<td>565</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>605 nm QDot®</td>
<td>&lt; 580</td>
<td>605</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>655 nm QDot®</td>
<td>&lt; 620</td>
<td>655</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>705 nm QDot®</td>
<td>&lt; 650</td>
<td>705</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>800 nm QDot®</td>
<td>&lt; 750</td>
<td>800</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 488</td>
<td>492</td>
<td>520</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 500</td>
<td>500</td>
<td>530</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 514</td>
<td>514</td>
<td>545</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 532</td>
<td>532</td>
<td>554</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 546</td>
<td>556</td>
<td>573</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 555</td>
<td>555</td>
<td>580</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 568</td>
<td>577</td>
<td>603</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 594</td>
<td>590</td>
<td>618</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 610</td>
<td>612</td>
<td>628</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 633</td>
<td>632</td>
<td>650</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 647</td>
<td>647</td>
<td>666</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 660</td>
<td>668</td>
<td>698</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 680</td>
<td>679</td>
<td>702</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 700</td>
<td>700</td>
<td>719</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alexa Fluor® 750</td>
<td>750</td>
<td>779</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Cy2™</td>
<td>498</td>
<td>506</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cy3™</td>
<td>554</td>
<td>568</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cy5™</td>
<td>649</td>
<td>666</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cy5.5™</td>
<td>675</td>
<td>695</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cy7™</td>
<td>743</td>
<td>805</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GFP</td>
<td>475</td>
<td>509</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FITC</td>
<td>490</td>
<td>525</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>eGFP</td>
<td>498</td>
<td>515</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>YFP</td>
<td>520</td>
<td>532</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rhodamine</td>
<td>550</td>
<td>573</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RFP (dsRed)</td>
<td>558</td>
<td>583</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ICG</td>
<td>800</td>
<td>850</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix C. CRi Software End-User License Agreement

The following is an agreement (the “Agreement”) between you and Cambridge Research & Instrumentation Inc., 35-B Cabot Road, Woburn, MA 01801 (“CRi”) for software known as Maestro and its accompanying documentation (collectively, the “Software”). By installing and/or using the Software, you agree to the following terms and conditions. If you do not agree to all of the terms and conditions in this Agreement, you may not install or use the Software.

Single Use License. The Software is licensed to you and not sold. Subject to the terms and conditions of this Agreement, CRi hereby grants to you a restricted, nonexclusive, nontransferable, nonassignable, nonsublicensable and revocable license to use, for your internal purposes only, the executable code version of the Software and the accompanying documentation in hard copy or electronic format. CRI RESERVES ALL RIGHTS NOT EXPRESSLY GRANTED BY THIS AGREEMENT.

Specific Restrictions. You may use the Software only on a single computer at a time. You may not use the Software on more than one computer or computer terminal at the same time, nor allow access to the Software from one computer to another over a network, the Internet or by any other means. You may make only one (1) copy of the Software, solely for backup purposes. You may not decompile, reverse engineer, disassemble, alter, modify, translate, adapt, decipher, or determine the source code or create derivative works of, the Software.

Ownership of Software. CRi and/or its suppliers own all right, title and interest, including all copyrights, in and to the Software. The Software contains confidential information and trade secrets of CRi. You (i) acknowledge, and agree not to contest, CRi’s rights in the Software; (ii) agree not to disclose to anyone, or allow anyone access to, the Software; and (iii) agree not to disclose any confidential information of CRi regarding the Software or that is otherwise disclosed to you in connection with this Agreement.

Transfer Restrictions. The Software is licensed only to you. The Software may not be transferred to anyone without the prior written consent of CRi. The terms and conditions of this Agreement shall bind any CRi-authorized transferee of the Software. You may not transfer, assign, rent, lease, lend, sell, grant a security interest in, sublicense or otherwise dispose of the Software, on a temporary or permanent basis, except for a CRi-authorized transfer as stated above.

Termination. The license granted in Section 1 above is effective until terminated. This Agreement is conditioned upon your continued compliance with the terms and conditions hereof and will terminate automatically without notice from CRi if you fail to comply with any term or condition of the Agreement. Furthermore, CRi may terminate this Agreement at any time upon thirty (30) days notice. Upon termination of this Agreement, you shall immediately destroy all copies of the Software (including all accompanying documentation) and any other confidential and proprietary information you have received during or in connection with this Agreement.
Limited Warranty. CRi warrants that the media on which the Software is provided will be free from defects in materials and faulty workmanship under normal use for a period of ninety (90) days from the date of delivery. Your exclusive remedy under this Section 6 shall be, at CRi's option, a refund of the price paid for the Software or replacement of the media on which the Software was provided so long as that media has been returned to CRi under a CRi-issued return authorization. CRi shall have no responsibility to replace media damaged by accident, abuse or misapplication.

No Other Warranties. EXCEPT FOR THE LIMITED WARRANTY STATED IMMEDIATELY ABOVE, THE SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, AND CRi EXPRESSLY DISCLAIMS ANY AND ALL IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF THIRD PARTY RIGHTS. CRi DOES NOT REPRESENT OR WARRANT THAT THE RESULTS OR THE USE OF THE SOFTWARE WILL BE CORRECT, ACCURATE OR RELIABLE, OR THAT THE SOFTWARE WILL OPERATE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. YOU ASSUME ALL RISK ASSOCIATED WITH THE USE, RESULTS AND PERFORMANCE OF THE SOFTWARE.

Limitation of Liability. IN NO EVENT SHALL CRi, ITS AFFILIATES OR SUPPLIERS, OR THEIR RESPECTIVE EMPLOYEES, OFFICERS OR AGENTS, BE LIABLE FOR ANY DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, INCLUDING WITHOUT LIMITATION INCIDENTAL, SPECIAL, CONSEQUENTIAL, PUNITIVE, EXEMPLARY, INDIRECT OR DIRECT DAMAGES (INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, RE-RUN TIME, INACCURATE INPUT, WORK DELAYS, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES OR LOSSES), WHETHER IN AN ACTION IN CONTRACT, TORT (INCLUDING NEGLIGENCE AND STRICT LIABILITY) OR OTHERWISE, AND EVEN IF CRi HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND REGARDLESS OF WHETHER ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE.

U.S. Government End Users. The Software qualifies as commercial computer software for purposes of the Federal Acquisition Regulations (FAR) §52.227-19 and the Department of Defense Supplement to the FAR (DFARS) §52.227.7013. If the Software is acquired by a civilian government agency, it is furnished with only the minimum Restricted Rights provided by FAR 52.227-19. If the Software is acquired by a military agency, it is furnished with only the minimum Restricted Rights provided by DFARS 52.227-7013(c)(1)(ii).

Miscellaneous. This Agreement contains the entire agreement of the parties with respect to the subject matter hereof and supersedes any proposal or prior agreement, written or oral, and any other communications between the parties relating to the subject matter hereof. No modification or waiver of any provision of this Agreement shall be effective unless in writing and signed by the parties. No delay or failure on the part of any party in exercising any right under this Agreement shall impair any such right or any remedy of such party, nor shall it be construed to be a waiver of any continuing breach or default under this Agreement. In the event any provision of this Agreement is held to be
unenforceable, the remaining provisions of this Agreement will remain in full force and effect. This Agreement shall be governed by the laws of the State of New York without regard to principles of conflicts of laws. Any disputes relating hereto shall be adjudicated only in the state or federal courts in New York County, New York State, and you hereby consent to the exclusive jurisdiction of those courts. This Agreement shall not be governed by the United Nations Convention on Contracts for the International Sale of Goods, the application of which is expressly excluded. You may not assign or otherwise transfer this Agreement or any of your rights or obligations therein without the prior written consent of CRi. You may not use the Software for any unlawful purpose nor export or re-export the Software except as authorized by law.

Should you have any question concerning this Agreement, you may contact CRi by writing to CRi, 35-B Cabot Road, Woburn, MA 01801. You may also call 1-800-383-7924 in the US or +1-781-935-9099 elsewhere.

**Notice to Purchaser**

The CRi Maestro 2 *in vivo* imaging system has many applications involving a variety of materials, such as probes, cell lines, animal specimens, etc. Certain of these applications and/or materials may require licensing under patents held by third parties. For example, while AntiCancer Incorporated and Xenogen Corporation do not have U.S. patent rights covering *in-vivo* imaging of conjugated fluorescent labels, a license from AntiCancer Incorporated, 7917 Ostrow St., San Diego, CA 92111 and/or Xenogen Corporation, 860 Atlantic Avenue, Alameda, California 94501, may be required to practice imaging, within animals, of cells genetically engineered to produce light-emitting compounds. CRi's sale or other transfer of the Maestro 2 *in vivo* imaging system does not convey any right or license under such third-party patents. It is suggested, therefore, that users of the Maestro 2 *in vivo* imaging system consult with counsel to determine whether licensing of such third-party patents is required.
Step 5: Turn off the computer’s power save feature

Most computers are configured to enter sleep (standby) mode if left inactive for a length of time. If your system goes to sleep while it is connected and running the software, the connection with the camera/imaging system will be lost. You will have to reboot both the imaging system and the computer to reconnect.

Avoid this problem by making sure the computer is set to never enter sleep mode. This will prevent losing the hardware connection between the computer and system.

1. Switch off the computer and wait for it to boot up.
2. Click Start > Control Panel > Power Options to display the dialog box.
4. You can select any time period for the Turn off monitor setting. The Turn off hard disks and System standby options must be set to Never.
5. Click Apply and then OK and close the Control Panel.

Step 6: Install Maestro software

Note: If you purchased a computer from CRi for your Maestro 2 system, the software is already installed and activated. There is no need to install or activate the software, unless you need to reinstall or want to install the software on your own computer.

1. Complete the following steps before installing:
   » If using a computer not supplied by CRi, make sure it meets CRi’s minimum requirements. (Refer to “Computer System Requirements” in the User’s Manual.) If unsure, call your local authorized distributor or CRi.
   » Make sure that the imaging system is switched off and the USB cable is disconnected from the computer.
   » Exit all other Windows programs that may be running.
2. Insert the installation CD into the CD drive. If the wizard does not start automatically, access the CD and double-click the Setup.exe icon.

Note: If installing a software update you received from CRi, cancel the wizard, but leave the CD in the drive. Windows will copy drivers from it during the update. Double-click the install file and follow the instructions.

3. When software installation is complete, plug the USB cable from the system into the computer’s USB port. Power up the imaging system by moving the power switch on the right side of the system to the ON position.
4. Windows will automatically detect the new hardware. The wizard will ask if you want Windows to connect to Windows Update.

Note: Detailed step-by-step instructions for the hardware installation are found in the User’s Manual appendix, “Hardware Installation Wizard.”

5. Select “No, not at this time” and click Next.
6. Select “Install the software automatically” and click Next.
7. A message will alert you that the “CRi unconfigured device has not passed Windows logo testing.” Ignore this message by clicking Continue Anyway.
8. The wizard will install the drivers from the installation CD. Repeat this process until all required drivers are installed.

Step 7: Activate Maestro software

Maestro software must be activated using the activation code that came with your system. This is usually done at CRi prior to shipping the computer. If you are self-installing, then you will need to activate. Connect the computer to the Internet if available. (This is the fastest activation method.)

Keep in mind that the serial number/activation code that came with your imaging system will be lost. You will have to reboot both the imaging system and the computer to reconnect.

To activate Maestro via the Internet:

1. Launch the Maestro software for the first time. The InstallShield Wizard appears.
2. Select “I have a serial number and I want to activate Maestro” and click Next.
3. Enter the serial number found on the Maestro CD case and click Next.
   Important: This is the serial number on the back of the CD case. Do not enter the serial number found on the back of the system.
4. If the computer has an Internet connection, your Maestro software will be activated within a few seconds.

To activate Maestro via Email:

If there is no Internet connection, you can activate the Maestro software by Email.

1. Select “I have a serial number and I want to activate Maestro” and click Next.
2. Enter the serial number found on the Maestro CD case and click Next.
3. You will receive an error message stating that the Activation Request Code could not be sent. Click OK.
4. When the Serial Number dialog box reappears, make sure the serial number is correct and select the “Activate by Email” option. Click Next.
5. A dialog box containing an Email link prompts you to “Email an Activation Request Code to CRi.” Use any computer with an Internet connection to email the code to the address indicated. CRi will email you an Activation Response Code. When you receive the code, enter it in the activation dialog box and click Next to activate the software.

Step 8: Create Windows accounts for users

In most instances, the computer used to run the Maestro system will be shared by multiple users. Each user will have his or her own Maestro protocols, cubes, spectral libraries, and other documents and files associated with his or her work with the Maestro system.

Each system user should be assigned a personal Windows user account on the computer. Accounts must be password protected for increased security.

Users should be instructed to save all of their work within their own My Documents directories, which are private for each user. This prevents users from accessing Maestro files or documents that belong to their peers.


Maestro 2 System Setup Guide

Welcome!

Congratulations on your purchase of a Maestro 2 in vivo imaging system.

Important: A qualified CRi technician should unpack and setup this Maestro 2 imaging system. Do NOT unpack or setup the system yourself unless specifically instructed to do so by your CRi representative.

This step-by-step guide contains all the information needed to setup and install the system. When setup is complete, please keep this guide with the rest of your Maestro 2 documentation for future reference.
**Step 1: Unpack the system**

- The Maestro 2 in vivo imaging system is transported in a wooden shipping crate that is built to protect the system during shipping.
- Additional boxes containing the heated stage, the anesthesia exhaust evacuator and F-Air canister, and the computer and monitor (if purchased) are also placed on the pallet.
- CRi recommends that you store the pallet and all parts of the crate, including the screws, in case the system ever needs to be shipped again. To protect against possible damage during transport, the system should only be shipped in its original packaging.

**Unpack the system:**

1. Remove the plastic wrapping material.
2. Remove box(es) that contain the monitor and computer (if purchased).
3. Remove the box containing chamber floor, the heated stage, and the anesthesia exhaust evacuator and F-Air canister, as well as the cables, user manual, installation software, specimen pad, and CRi business card with QDot spots.
4. Open the crate by removing the screws from the top and front panels. Take off the three sides by removing the bottom screws that hold them to the pallet.
5. Remove the bottom-front panel from the unit: Use the hand-hold in the middle of the bottom edge of the panel to carefully pull it away. This is to prevent damage to the panel and the system while removing and carrying the system from the crate.

**Caution!** The system weighs approximately 200 lbs. At least two people should assist with removing the system from the crate.

6. With the top and sides of the crate removed, the Maestro 2 system can now be safely lifted from the pallet. Lift it carefully and put it on a cart for transport.
7. Transfer the system to the table or bench where it will be installed (see the suggested arrangement in Step 2).

**Step 2: Setup the system**

1. Reattach the unit’s bottom-front panel by pushing it back into place. Its ball fasteners will click into place when securely fastened.
2. If a workstation computer was ordered and shipped with your system, unpack the computer, monitor, and components, including the USB focus knob. Place them on the table, usually to the right of the system. Setup the computer according to the manufacturer's documentation.
3. Plug the USB focus knob into a high-speed USB 2.0 port on the computer.
4. Unpack and assemble the anesthesia exhaust evacuator and F-Air canister. Connect the 3/4" exhaust tubing to the top of the canister using the supplied connector, and place it at the left of the imaging system.
5. Unpack the 1/4" and 3/4" barbed fittings for the supply and exhaust ports.
6. Remove the red plugs from the SUPPLY and EXHAUST ports on the left side of the unit. Then screw the barbed fittings into these ports. (Teflon tape should already be applied to the threads of the fittings.)
7. Connect your 1/4" anesthesia supply tubing to the SUPPLY fitting.
8. Connect the 3/4" exhaust tubing from the anesthesia exhaust evacuator to the EXHAUST port.
9. Connect the exhaust evacuator’s power supply cable to its port on the back of the evacuator, then plug the cord into an electrical outlet.
10. Use the supplied USB cable to connect the system to the workstation computer:
    - Plug the cable into any high-speed USB 2.0 port on the computer.
    - Plug the cable’s square connector into the square USB 2.0 port on the side of the system.
11. Connect the power cable to the power port. **Do not** plug the cable into an electrical outlet yet.

**Step 3: Install the heated stage**

1. Unwrap the chamber floor panel and place it in the floor of the chamber. The panel fits within the recessed area in the floor.
2. Remove the heated stage from its packaging and place it at the center of the floor panel.
3. Connect the stage interface cable to its port at the top-left of the stage and to the port marked STAGE at the front-left corner of the chamber ceiling.
4. Connect the anesthesia supply tubing to its port at the top of the stage and to the supply port located near the back-left corner of the ceiling.
5. Connect the blue anesthesia exhaust tubing to its port at the top of the stage and to the exhaust port located near the back-left corner of the ceiling.

**Step 4: Connect the system to power**

1. The imaging system, the computer, and the monitor all require connection to a surge protected electrical supply.
2. Before connecting system components to power, verify the following:
   - All power switches are OFF.
   - The electrical power supply is the correct rating: 100-240 VAC, 50-60 Hz.
3. Plug each component’s power cord into the surge protected electrical supply.
In most instances, the computer used to run the Maestro system will be shared by multiple users. Each user will have his or her own Maestro protocols, cubes, spectral libraries, and other documents and files associated with his or her work with the Maestro system.

Each system user should be assigned a personal Windows user account on the computer. There should be one Computer administrator account for, in most cases, the lab director or similar person. All other users should be given Limited accounts that should be password protected for increased security. Users should be instructed to save their work within their own My Documents directories, which are private and cannot be accessed by other Limited users. This prevents other users from accessing Maestro files or documents that belong to their peers (i.e., other Limited users).

The following table contains the required steps for password protecting the Computer administrator account and setting up Limited accounts and passwords for other users.

**Note:** If you switch to the Control Panel’s Classic View, the screens will not appear quite as depicted below, but the functionality/process will be the same.

<table>
<thead>
<tr>
<th>Action</th>
<th>User Accounts Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer is set up at CRi with one Computer administrator account named “Maestro.” This default account is not password protected. This lets you start up and use the computer without having to log on or enter a password.</td>
<td></td>
</tr>
</tbody>
</table>

Create a password for the Maestro user account. Then, created Limited user accounts with passwords for each of your users.

**Password protect the Maestro administrator account:**

1. Click the Start button, then select Control Panel > User Accounts.

2. Under pick an account to change, click on

![Computer administrator](image1)

![User Accounts](image2)
3. Select **Create a password**.

4. Type and retype the password as instructed.

5. You may also enter a password hint to use in case you need help later remembering the password.

6. Click **Create Password**.

7. Next, confirm that you want to make this account private by clicking **Yes, Make Private**.

8. A password is now required to log on to the computer as the Maestro administrator.

**Create Limited user accounts:**

1. Return to the top level **Control Panel > User Accounts** dialog box and select **Create a new account**.

2. Name the new account: You may enter a full name (e.g., John Smith) or an abbreviation (e.g., jsmith).

3. Click **Next**.
4. Pick an account type: Select **Limited** for all non-administrator level users.

**Note:** If you are working in Windows Classic mode, select the **Restricted user** option so that the user can only operate the system and save documents.

5. Click **Create Account**.

6. You will notice the new user added to the list of accounts.

7. Click on the icon for the new user’s account to select it.

8. Create an initial password by clicking **Create a password**.
<table>
<thead>
<tr>
<th>Action</th>
<th>User Accounts Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>9. Type and retype a very generic password for the user, such as “password.”</td>
<td><img src="image1.png" alt="User Accounts Dialog Box" /></td>
</tr>
<tr>
<td>10. Click <strong>Create Password.</strong></td>
<td><img src="image2.png" alt="User Accounts Dialog Box" /></td>
</tr>
<tr>
<td>11. The user’s <em>Limited</em> account is now password protected:</td>
<td><img src="image3.png" alt="User Accounts Dialog Box" /></td>
</tr>
<tr>
<td>12. Only this user will have access to documents and files saved in his or her My Documents directory. Similarly, this user has no access to the My Documents directories of other users.</td>
<td></td>
</tr>
<tr>
<td>13. Repeat this procedure for each user account you need to create.</td>
<td><img src="image4.png" alt="User Accounts Dialog Box" /></td>
</tr>
<tr>
<td>14. Each account will be listed, as shown here.</td>
<td><img src="image5.png" alt="User Accounts Dialog Box" /></td>
</tr>
<tr>
<td>15. Exit the User Accounts Control Panel when finished.</td>
<td><img src="image6.png" alt="User Accounts Dialog Box" /></td>
</tr>
<tr>
<td>16. When you log off, or the next time the computer is turned on, the login screen appears.</td>
<td><img src="image7.png" alt="User Accounts Dialog Box" /></td>
</tr>
<tr>
<td>17. Users should be instructed to select their own name and enter their initial password to log on.</td>
<td></td>
</tr>
<tr>
<td>18. After logging in, users should access the <strong>User Accounts Control Panel</strong> (as described above) and select a more personal and secure password.</td>
<td><img src="image8.png" alt="User Accounts Dialog Box" /></td>
</tr>
</tbody>
</table>
Appendix F. **Hardware Installation Wizard**

When the Maestro imaging system is connected to power and connected to the computer via the USB 2.0 cable, the computer detects the new hardware and presents the **Found New Hardware Wizard**. It is best to leave the Maestro software installation CD in the CD drive so that the wizard can find the required hardware drivers automatically. The following is a step-by-step explanation of the installation process.

**Note:** The hardware driver installation process only applies to the USB port to which the Maestro system is currently connected. If you later connect the system to a different USB port on the computer, you will have to repeat the following procedure.

<table>
<thead>
<tr>
<th>Action</th>
<th>Wizard Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Wizard starts when the Maestro system is connected to the computer’s USB 2.0 port.</td>
<td><img src="image1.png" alt="Wizard Dialog Box 1" /></td>
</tr>
<tr>
<td>1. Select “No, not this time” at the prompt to connect to Windows Update.</td>
<td><img src="image2.png" alt="Wizard Dialog Box 2" /></td>
</tr>
<tr>
<td>2. Click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Install “CRI Unconfigured Device”:</strong></td>
<td></td>
</tr>
<tr>
<td>3. First, the Wizard installs the <em>CRI Unconfigured Device</em>.</td>
<td><img src="image3.png" alt="Wizard Dialog Box 3" /></td>
</tr>
<tr>
<td>4. Select “Install the software automatically” and click <strong>Next</strong>.</td>
<td><img src="image4.png" alt="Wizard Dialog Box 4" /></td>
</tr>
<tr>
<td>Action</td>
<td>Wizard Dialog Box</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>5. Click <strong>Continue Anyway</strong> if the “Windows Logo testing” warning appears.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>6. The drivers for the CRI Unconfigured Device will be installed.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>7. Click <strong>Finish</strong> when installation of this device is finished.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
</tbody>
</table>

**Install “USB Serial Converter”:**

<table>
<thead>
<tr>
<th>Action</th>
<th>Wizard Dialog Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>8. Next, the Wizard installs the <strong>USB Serial Converter</strong>.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>9. Again, select “No, not this time” when asked if you want to connect to Windows Update and click <strong>Next</strong>.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>10. Select “Install the software automatically” and click <strong>Next</strong>.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>11. Click <strong>Continue Anyway</strong> if the “Windows Logo testing” warning appears.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>12. The drivers for the USB Serial Converter will be installed.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>13. If the installation CD is not loaded or available, the Wizard may ask you for the location of certain files.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>14. Click the <strong>Browse</strong> button and navigate to C:\Program Files\CRi\Maestro n.n*\Drivers\Installed. (*n.n is your current installed version of Maestro.)</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>15. Select the requested file and click <strong>Open</strong> then <strong>OK</strong> to continue.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>16. Click <strong>Finish</strong> when installation of this device is finished.</td>
<td><img src="image" alt="Hardware Installation" /></td>
</tr>
<tr>
<td>Action</td>
<td>Wizard Dialog Box</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td><strong>Install “USB 2.0 Cooled Camera”:</strong></td>
<td></td>
</tr>
<tr>
<td>17. Next, the Wizard installs the <strong>CRI USB 2.0 Cooled Camera</strong>.</td>
<td></td>
</tr>
<tr>
<td>18. Again, select “No, not this time” when asked to connect to Windows Update and click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td>19. Select “Install the software automatically” and click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td>20. Click <strong>Continue Anyway</strong> if the “Windows Logo testing” warning appears.</td>
<td></td>
</tr>
<tr>
<td>21. The drivers for the CRI USB 2.0 Cooled Camera will be installed.</td>
<td></td>
</tr>
<tr>
<td>22. Click <strong>Finish</strong> when installation of this device is finished.</td>
<td></td>
</tr>
<tr>
<td><strong>Install “USB Serial Port”:</strong></td>
<td></td>
</tr>
<tr>
<td>23. Next, the Wizard installs the <strong>USB Serial Port</strong>.</td>
<td></td>
</tr>
<tr>
<td>24. Again, select “No, not this time” when asked to connect to Windows Update, and click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td>25. Select “Install the software automatically” and click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td>26. Click <strong>Continue Anyway</strong> if the “Windows Logo testing” warning appears.</td>
<td></td>
</tr>
<tr>
<td>27. The drivers for the USB Serial Port will be installed.</td>
<td></td>
</tr>
<tr>
<td>28. If the installation CD is not loaded or available, the Wizard may ask you for the location of certain files.</td>
<td></td>
</tr>
<tr>
<td>29. Click the <strong>Browse</strong> button.</td>
<td></td>
</tr>
<tr>
<td>30. Navigate to C:\Program Files\CRi\Maestro n.n\Drivers\Installed. (*n.n is your current installed version of Maestro.)</td>
<td></td>
</tr>
<tr>
<td>31. Select the requested file and click <strong>Open</strong>.</td>
<td></td>
</tr>
</tbody>
</table>
32. Installation of this device is finished.

33. Click **Finish**.

**Install “BEI Lens Controller”:**

34. Next, the Wizard installs the *BEI Lens Controller*.

35. Again, select “No, not this time” when asked to connect to Windows Update, and click **Next**.

36. Select “Install the software automatically” and click **Next**.

37. Click **Continue Anyway** if the “Windows Logo testing” warning appears.

38. The drivers for the BEI Lens Controller will be installed.

39. Click **Finish**.

40. Installation of the hardware drivers is complete. If prompted to do so, restart your computer for the changes to take effect.
Acquire Fluorescence Images

This guide presumes that the Maestro 2 In-Vivo Imaging System is properly installed and configured.

1. Switch ON the system and the computer. Make sure the focus knob is connected, and check that its outer rim glows with blue light. This indicates it is active and ready to use. If the blue lights are not on, double-click the 3D Connexion Control Panel icon on the desktop to start the device driver. You may now launch the Maestro 2 software.

2. Push and hold the EXCITATION LAMP button for three seconds to switch on the excitation lamp. Push the INTERIOR ILLUMINATION button to switch on the interior white lights. (These buttons illuminate green to indicate the lights are on.)

3. Open the specimen chamber door and place your prepared specimen at the center of the stage.

4. In the Maestro application, select the Acquire > Fluorescence tab.

5. If you don't see the Live Stream window, click the Live button to see live streaming video of the image.

6. In the Filter/Wavelength Selection group, select a filter set that has a wavelength range corresponding to the fluorophore being used in your specimen. If you don’t find a preset that works for your fluorophore/specimen, you can edit the Start, Step, and End settings manually. Refer to the “Maestro User’s Manual” for instructions.

7. If you want to use the filter set’s narrower band width, select the Narrow check box. Again, refer to the “Maestro User’s Manual” for instructions.

8. In the Wavelength And Exposure group, click the Autoexpose Mono button or enter the wavelength at which you expect to see an image of your specimen. This should be within the range of the current filter/wavelength selection. (Use 500 nm or above for focusing).

9. Use the Focus knob or slider to get a sharp image of your specimen. If necessary, open the door and adjust the position of the specimen. Close the door.

10. Select Binning, Sample Size (Zoom), and ROI (Region of Interest) options according to the desired image quality. The default is full-field and 2x2 binning. Selecting a smaller sample area increases the zoom. Image files will be smaller with smaller ROI and increased binning. Binning increases sensitivity to light but reduces image resolution.

11. Click the Autoexpose Mono button again, and adjust the focus, if needed to improve the live image.

12. Switch OFF all interior lights. (Clearing the Turn On Illumination check box will turn off the lights.) OPEN the excitation light shutter to illuminate the specimen with the excitation light.

13. Click the Autoexpose Cube button to automatically calculate the exposure settings for the image cube. You can also adjust the exposure time manually:
   a. If the image is too dark, increase the exposure time in the Exposure (ms) box.
   b. If the image is too bright or saturated (indicated by solid red pixels), reduce the exposure time.

14. Click the Acquire Cube button to acquire a cube using the selected wavelength range. (If you prefer to take a grayscale snapshot of the image at the current wavelength, click the Acquire Mono button instead.)

15. When cube acquisition is complete, a color representation of the cube displays in the image viewing area.

16. Click the Save Cube toolbar icon to save the cube. Select a location and enter a file name. (File name format suggestion: project_sample_operator_datetime).

17. Select a cube type option:
   a. Image Cubes saves the cube in CRI format, which includes hardware and display settings for the cube.
   b. TIFF Cubes saves the cube as a series of TIFF images with the assigned file name plus an appended number indicating the wavelength for each image in the cube.

18. Unmix the cube as explained on the next page.
Unmix Images

1. Select the **Spectra** tab.

2. If a cube is already open, it displays in the image viewing area. To open a cube, click the **Load Cube** toolbar icon. Cube format types include CRi format (*.im3) cubes and TIFF (*.tif) cubes.

3. The sample used in this tutorial is included with the Maestro software and is located in the following sample data folder: C:\Maestro Data\Images\Sample Data\Q dot mouse stack.

4. If a **Live Stream** window is still open, you may close it by clicking its **Close** box.

5. If desired, select a spectral display option from the **Scaling** drop down box.

6. Click the **Real Component Analysis (RCA)** button near the bottom of the **Spectral Processing** panel. The RCA function automatically detects and separates each of the component signals in the cube.

7. In the **RCA** dialog box, you have the option of manually sampling the autofluorescence. Click the **Sample Spectrum** button and use the mouse pointer to draw a sampling line on an area of the specimen that contains only autofluorescence (the mouse on the right). Hold down the left mouse button and drag the pointer to draw.

8. Click the **Find Component Images** button. Maestro identifies and displays the autofluorescence and fluorescence signals.

9. Select the signals you want to unmix:
   a. The autofluorescence is displayed in the upper left image. Click two times anywhere in the image to select it as the autofluorescence. Set its pseudo color to white.
   b. Single-click on the other component image(s) you want to unmix, and select a pseudo color for each.

10. Extract the pure fluorescence signal(s) from the autofluorescence by clicking the **Find Spectra** button. The component signals display in the spectral graph.

11. Use the controls in the **Computed Spectra** group to specify each spectrum's name, pseudo color, and location within the Spectral Library.

12. When finished, click the **Transfer to Library, Unmix and Close** button. This adds the spectra to the Spectral Library and unmixes the spectra in the cube. (If a library is open already, you may be asked if you want to overwrite the existing spectra.)

13. New images will display in the image viewing area:
   a. There is a small component image for each selected spectrum, each with a colored border that corresponds to the pseudo color of that spectrum.
   b. There is also a larger pseudo-colored composite image displayed to the right of the original RGB image of the cube. The colors used to create this image are the pseudo colors selected in the library. The result should be a clear display of the specific fluorescence signal, with obvious differentiation from the autofluorescence.

14. Save the resulting images:
   a. You can save all images as displayed by selecting **File > Save Image > Save All (As Displayed)**. Select or create a folder in the same directory as the original image cube. Images are saved as TIFF images that can be opened in a variety of image display programs.
   b. You can save all images as unscaled data by selecting **File > Save Image > Save All Images (As Unscaled Data)**. See the "Maestro User’s Manual" for more about saving cubes and images.
   c. You can also save the entire workspace by selecting **File > Save Result Set**. Enter a file name to save all images and results in a single file.

15. Save the Protocol and/or Spectral Library for use throughout your experiment:
   a. You can save the complete Maestro protocol, which includes the current Spectral Library, by selecting **File > Save Protocol**.
   b. If you want to save the Spectral Library as a separate file, select **File > Save Spectral Library**.

 Occasionally, for weak signals, there may be too much baseline offset in the data. If you did not get the desired results (i.e., a clear unmixed image), repeat the RCA process and select the **Fit Offset** option. Unmix again and see if the results improve.
Acquire Low-Light Images

Maestro Flex imaging systems can capture and create low-light composite images that you can view and analyze in much the same way you would a fluorescent image cube. This is done by first taking an image under white lights and then taking an image in complete darkness. The system then combines these two images into a composite. For this example of low-light acquisition, a watch with phosphorescent material on its dials and at each hour position was used.

1. Place your specimen on the stage and close the chamber door.
2. Switch to the Acquire > Low Light panel. The system automatically turns off the excitation light, closes the shutter, and switches to the Low Light filter set. (The Low Light filter set blocks the excitation light, uses a clear emission filter, and has the LCTF out of the light path.)
3. The system then autoexposes the Live image with the interior illumination (white) lights on.
4. Click the Live button if you don't already see the Live window. Maximize this window, if desired, to make it easier to reposition the specimen. Fine-tune the focus using the Focus slider or a USB-attached focus knob.
5. Set the Binning, Max Sample Size (zoom), and ROI for this acquisition. In the figure below, the image is zoomed to a max sample size of 1.5"x2.0".
6. Make sure the chamber door is closed and click the Acquire Image button. The system will acquire a Posing Image that will act as a background for the composite image. The system then acquires a Low Light image. Three images will display, as shown below (you might need to press Ctrl+L to view all three images.)
   - Low Light Image (lower left)
   - Low Light Pose (second from left)
   - Low Light Composite (upper right)
7. If the acquired images are too dark or too bright, adjust the low-light Exposure value accordingly, and then acquire the images again.
8. Use the measurement tools on the Measure panel (described on the back of this page) to draw and compare measurement regions.
Quantifying Low Light Images
1. Switch to the Measure panel and maximize the Low Light Image window.
2. You can use the Auto Calculate Threshold feature or manually draw regions around regions of interest. For this example, Auto Calculate Threshold was used and then the Threshold Level was decreased until regions were drawn around all of the luminescent areas, as shown in this example.
3. By clicking the Grow button at the far right of the Measurements data tab, you can easily compare the Average Signal, Total Signal, and other measurement data for all of the regions.

Enhancing Low-Light Images
1. Enhance the display of your low-light images by using the Display Control tool.
2. Maximize the Low Light Composite image first, then click the Display Control button on the toolbar.
3. Adjust the Contrast, Gamma, and Brightness sliders to achieve the desired display of your image. You can also use the other display control features to enhance the composite display. (Refer also to the Maestro User’s Manual for more about the Display Control tool.)

Saving Low-Light Images
To Save the Composite:
If you want to save images in a single composite.imx file (includes the low-light pose, low-light image, and low-light composite), select the composite image and select File > Save Composite from the menu. Enter a Composite Image File name and click Save.

To save Images as Unscaled Data:
If you want to save each image as a separate file and preserve its data for later quantitative analysis, select File > Save All Images (As Unscaled Data). You will be prompted to name and save each file separately.
Dynamic Contrast Enhancement

Dynamic Contrast Enhancement (DyCE) is a plugin application that can be purchased as an add-on to your Maestro system. DyCE is a simple, inexpensive and versatile new approach that can provide coregistered anatomical information by exploiting in vivo pharmacokinetics of dyes in small animals. (A detailed explanation of DyCE technology is available in the Maestro 2 User’s Manual.)

Preparing for DyCE Imaging

System Setup:
1. Make sure the Maestro system is turned on and the Hardware Status indicator in the software displays “Ready.”
2. Make sure the multiview platform (if purchased) is installed and connected to the interface and anesthesia ports inside the chamber.
3. Make sure the Live Stream window is displayed (click the Live button if it is not).
4. On the Acquire > Fluorescence tab, select camera settings, a filter set, and any other acquisition parameters. Or if a protocol has been saved for this application, then load the saved protocol.
5. Make sure the appropriate lights within the chamber are turned on and the platform is heated to the proper temperature. Ideal lighting conditions depend on the dye or agent that will be used during the current application.
6. In the Maestro software, click the Acquire DyCE button or select Tools > Acquire DyCE from the main menu. If you have not yet activated the DyCE plugin, select DyCE Limited Time Trial from the Tools menu. Enter your activation code if you purchased a license to use DyCE. If you have not yet purchased a license, you may evaluate DyCE for up to 30 days.
7. The Acquire Dyce window (see Figure at right) will open with its Acquire tab displayed.

Selecting Binning and ROI:
1. Select the desired Binning and ROI for this acquisition. The Total Time displays the current estimate of the time required to acquire the dataset using the currently selected Time Series.
2. Check the estimated data size of the dataset when acquired. It is important to keep this value below 150 megabytes due to memory limitations; datasets that are larger than 150 MB may be too large to analyze. The value displays in green to indicate an acceptable file size. Red indicates that the file may be too large at the current settings. (Increasing the binning or choosing a smaller ROI will decrease the estimated size of the dataset.)

Selecting a Collection Type:
The Collection Type determines the type of dataset that will be collected. There are three options:
- Mono (broadband emission) acquires a monochrome image at the selected time intervals with the tunable filter out of the light path.
- Mono (using current Acquire wavelength) acquires a monochrome image at the selected time intervals with the tunable filter in the light path.
- Cub (using current Acquire settings) collects a series of complete multispectral cubes for the duration of the selected time interval.

Selecting Save Options:
Select a directory/folder where you would like to save the acquired dataset(s). Enter a base cube name in the Cube Name field.

Acquiring a Monochrome DyCE Dataset
1. Select Mono (broadband emission) or Mono (using current Acquire wavelength) as the collection type. Both of these options let you configure up to three collection intervals, which gives you the ability to set a different frame rate for each interval. This is important because in most cases you want to capture more frames (i.e., more data) during the first few seconds immediately following the bolus injection.
2. Configure the Time Series: For example, as shown in the example above, you might want to capture 5 frames per second for the first 25 seconds, with an exposure time of 221 ms per frame. The next 10 seconds will capture 2 frames per second. During the final 5 seconds, the system will capture just 1 frame per second.
Acquiring a Multispectral DyCE Dataset

1. Select Cube (using current Acquire settings) as the collection type. This option lets you acquire a time series of complete multispectral cubes following a bolus injection. Up to three intervals may be collected. These intervals let you control the sample rate (frame rate) and exposure time. The system will use the cube acquisition settings currently selected on the Acquire panel.

2. For example, for the first 20 seconds immediately following injection, you might want to collect a multispectral cube every 5 seconds. Then for the next 2 minutes, collect one cube every 30 seconds. During a third interval, you might collect one cube every minute for 5 minutes. The example here demonstrates these time series settings.

Note: When collecting cubes, the values in the Frame Rate selectors are timers that control the number of seconds that are allowed to lapse between the start of each cube during that interval. Always set the Frame Rate Unit to “Sec./Frame” (think of it as “Seconds per Cube”) for cube collection.

3. Select an exposure setting for each time interval. This value overrides any cube autoexposures done via the Acquire panel.

4. In the Save Options box, click the Browse button to navigate to the directory where you want to save the acquired sequence of cubes. Select a location, then enter a base name for the cubes in the Cube Name box.

5. Place the mouse on the platform and acquire the DyCE images as described on the previous page. If you selected the Launch Viewer After Acquire check box in the Acquire window, the first cube in the sequence displays in the DyCE Explorer and in Maestro.

Reviewing DyCE Datasets

If the dataset is not open in Maestro already, load it now by clicking the Load Cube button. Then select Tools > DyCE Explorer from the Maestro menu. Click the Play button.

The Play bar indicates the current frame and the total number of frames. You can drag this bar or use the scroll box to freeze any individual frame. The frame number and wavelength display in the bottom-right corner. The vertical blue line on the Plot graph indicates the time of the current frame. Also, you can move the mouse pointer over the displayed image to plot the spectral curve of the pixels at the cursor location (shown by the dotted grey line).

Changing the Display Mapping

Two sliders let you adjust the brightness and contrast of the display image. All display changes effect the entire dataset, not just the current frame (middle-right image).

Min. Max. maps the minimum value in the entire sequence to 0, the maximum value to 255, and linearly interpolates in between those values. This stretches dark signals so they become visible.

Clip/Stretch maps the lowest 0.01% of the pixels in the entire sequence to 0, the highest 0.01% to 255, and linearly interpolates in between those values. This prevents a few bright or saturated pixels from skewing the display.

Histogram Eq. maps the pixels in the entire sequence so the histogram of the pixels have approximately the same number of pixels in each bin. This gives the best display of the whole dynamic range of dim and bright signals.

You can assign specific minimum and maximum clip values to the display of the image. Increase the Min Clip value to exclude more of the lowest value pixels from the display. Decrease the Max Clip value to exclude more of the highest value pixels.

You can also select a Color Map depending on the brightness and contrast of the image and the type of dye or agent you are trying to visualize in the movie.

Displaying Dimension-Reduced Data

You don’t have to view the individual planes in a dataset one frame at a time. The DyCE Explorer can identify the strongest signals in the sequence and combine them in a transparent “flattened” image. Check the Display Dimension-Reduced Data box to reveal a new multicolor representation of the data (bottom-right image).

Initially, all of the planes in the DyCE sequence will be reduced to just three planes. These planes will be different linear combinations of all the planes in the sequence. Change the number of dimensions (i.e., anatomical signatures) by scrolling the Dimensions box.

To create a new DyCE time series from a sequence of cubes:

1. When a Cube time series acquisition is complete, the Create from Cube Sequence functions become enabled.

2. Select any cube from the Cubes drop down box. The cube will open in the DyCE Explorer and in the Maestro software. Try to find the cube that best displays the spectral component you want to use to create the DyCE time series.

3. In Maestro, switch to the Spectra panel. Use the Library color palette to sample the spectral component you want to obtain from each cube in the dataset. The ID of the spectra will be added to the Component To Keep drop down box.

4. Select the component to keep from the drop down box.

5. Click the Create DyCE Time Series button. The Maestro software will open each cube in the sequence and obtain the selected component from each of them. The software will then compile all of these signals into a new cube file.

Saving Images and Movies

If you want to save the current frame as it is currently displayed, right-click over the image and select an option from the pop-up menu. You can save the image (i.e., frame) as displayed as a TIF or JPG image, or copy the current frame to the clipboard.

Clicking the Save button saves the dataset as an AVI movie file. AVI movie players can now play your DyCE movie.
Index

A
absorption spectrum 4
abundance display 98
abundance scaling 98
acquire cube 32, 59
acquire mono 59
acquire time sequence 64
acquisition time (typical), specification 129
acquisition wavelength 52
altitude, operating specification 132
anesthesia manifold, orientation 130
anesthesia ports, specification 131
anesthesia system (specifications) 130
area (µm^2) 95
area (pixels) 95
auto exposure 28
auto exposure live 28
autoexpose at current wavelength (mono) 53
autoexpose cube 53
autoexpose target % of dynamic range 28
autofluorescence 5
automated hardware features 29
automatic save options 66
average signal 95
average signal, display box 25

B
bandwidth, specification 129
baseline subtract 78
batch processing 85
binning 51, 93
bit depth 27
brightness level 97

C
camera settings 27
CCD sensor active area 127
chamber environment 13
chamber temperature control (specification) 130
Cleaning
  filters 22
  system 22
cube ID 95
cube time stamp 95
current wavelength, specifying 52
cursor x/y coordinates 25
custom display values 98

dark current, check 28
denominator(counterstain) 110
dimension-reduced data 126
Disclaimers
design change 11
reproduction 11
Display 97
  brightness and contrast 97
  component selection 100
  wavelength to RGB map 99
display, co-localization composite 114
DyCE 117

E
effective pixels (specification) 129
emission filter slider, inserting 18
emission filters (specifications) 131
emission spectra 4, 6
enhance contrast 98
enhanced contrast 29
environment, operating specification 132
environmental specifications 132
error scaling 75
excitation filter slider, inserting 19
excitation filters (specifications) 131
excitation lamp
  lamp cartridge replacement 20
Exposure Time
  adjusting 53
  custom settings 54
exposure time (max), specification 129
exposure time ratios 58
extract image plane 67

F
f/stop 28
field of view (specifications) 130
filter selection guide 135
filter setting names 56
filter settings, customizing 56
Filters
  choosing 5, 55
  cleaning 22
  excitation and emission 5
  selection guide 135
fit offset 72, 75
flat fielding 59
fluorescence, defined 3
frames to average 28
frequently asked questions 127
Fuses, replacing
  imaging module 21

G
gain 28
gallery, introduction to 25

H
hardware, status 25
heated stage (specifications) 130
heaters, stage & chamber 14
histogram equalization 98, 125
human perception of light 2
Humidity
  operating, specification 132
  storage, specification 132

I
illumination, eye’s response to 3
image cube, defined 7
image data pages, introduction to 25
image plane, extract 67
image sensor format 129
image sensor pixel count 129
imaging theory 1
import image 102
Installation
  Maestro 2 system 141

L
Lamp Cartridge
  lifetime, specification 20, 131
Lamp Cartridge, replacing 20
LCTF specifications 129
light delivery system, specification 131
light source, illuminator (specification) 131
light, discussion of 1
lights, interior on/off switch 16
Line Profiles 79
  clone 81
  copy 81
  delete 81
  move 81
live image 51
low-light acquisition 60
low-light composite images 60
luminescence, defined 3

M
macros 103
Maestro in-vivo imaging system, introduction to 9
Maestro Work Area
   how to launch 23
   understanding 23
major axis 95
markers for co-localization 110
max signal 95
maximum exposure 28
measurement pixel unit 25, 29
Measurements 89
   appending to a text file 96
   copy to clipboard 96
   definitions 95
   measuring regions 89
   save as text 96
min. max. 98
minor axis 95
multi filter protocols 58
multi filter support 57
multispectral analysis, introduction to 7

N
narrow bandwidth acquisition 56
nosecone/heated stage system 12
notes, save with cube 64

P
Panning Images
   individual 27
   together 27
phosphorescence, defined 3
photons (measurement pixel unit) 29
pixel unit 25
pollution degree, specification 132
Power Supply
   on/off switch 21
protocol, status 25
Protocols 43
   open 50
   save 43
pure spectra, calculating 35

R
ratio of exposure times 58
raw display 98
real component analysis (RCA) 71
Region
   clear all 91
   region of interest (ROI) 52
   region of interest shapes 74
Regions
   clone 92
   copy all 92
   copy measurements 96
   delete 91
   drag a copy 92
   erase part of 91
   find automatically 89
   ignoring small 94
   labels 94
   load to an image 93
   manual draw 91
   measurements 95
   measuring 89
   modify 91
   move 91
   save 93
   saving measurements 96
   threshold segmentation 89
   transparency and color 94
regions of interest, co-localization 113
reinitialize hardware 30
resolution, low 30
result set, saving 76

S
Safety
   cautionary statements 10
   operator and equipment contact 10
   technical assistance contact 10
sample ID, save with cube 64
saturation mask 99
Save
   cube 65
   image 66
   region 93
   unmix results 76
scaled counts (measurement pixel unit) 29
scaling 29
snapshot 59
software license agreement 137
Specimen Stage
  height setting 93
specimen stage dimensions 130
Spectra
  computing manually 74
  import from component image 45
  import from composite image 45
  import from library 44
  sampling manually 73
  subtracting from cube 78
Spectral Graph Scale
  normalized 76
  scale to max 76
  un-normalized 76
Spectral Library
  adding notes to 74
  clearing 73
  open 70
  save 43
spectrum ID 95
stage translation/orientation range 130
standard deviation 95
status bar, introduction to 25
Stoke’s Shift 4
system aperture 129
system dimensions, specification 131
system weight, specification 131
T
Temperature
  operating, specification 132
  storage, specification 132
temperature, chamber and stage 13
third-party computers, using 133
threshold segmentation 89
threshold values 108
thumbnails, introduction to 25
timed acquisition 64
timed sequences 64
toolbar, introduction to 24
total signal 95
U
unmix cube 34
user defined exposure 28
user’s manual, about 11
utility ports, specification 131
utility specifications 132
V
visible wavelength, discussion of 1
W
wavelength and exposure 52
wavelength range, specification 129
Wavelength Selection
  manual adjustment 55
  presets, using 55
  wavelength slider, using 52
  wavelength to RGB map 99
  window layout, description 26
  windows, resizing 26
Workstation Computer
  overview of 22
  specifications 132
X
  x location 95
Y
  y location 95
Z
  zooming images 26
Warranty

CRi warrants its Maestro 2 systems for a period of one (1) year from date of shipment against defects in material and/or workmanship, provided its installation, application, and maintenance are within specifications. Normal wearing parts are excluded. This warranty covers only items manufactured by CRi. CRi will correct, by repair or replacement-at its option and its expense-any proved defects in items of its manufacture, subject to above, provided immediate written notice of such defects is given.

A valid Return Materials Authorization (RMA) must be obtained by contacting CRi before items may be returned to the factory. Repair or replacement will be provided F.O.B. (Freight On Board) at CRi’s factory. The total financial obligation of CRi, under this warranty, does not exceed the purchase price of the items of its manufacture as set forth on normal pricing schedules. We will not assume any expense or liability for repairs made by others without our prior written consent.

This warranty is void and CRi will be free from all obligations hereunder if the items of its manufacture have been misused, reprocessed or reused, repaired or modified without our written consent. CRi assumes no liability for damages or injuries resulting from the misuse, misapplication, or unauthorized repair or modification of its equipment.

We assume no liability to users of our equipment or to any other person or persons for special or consequential damages of any kind and from any cause arising out of or in any way connected with the use of the equipment. All warranty and post-warranty service is nontransferable from the original shipping address to another without the prior written consent of CRi.

The CRi Maestro 2 system may be used for research purposes. It is not intended for clinical or diagnostic use at this time.